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Welcome!

Welcome!
Welcome to the online Help for CAST SQL-Builder. This help system provides instant support for
and knowledge about SQL-Builder, CAST's SQL development environment.
Getting Help
To access CAST online Help directly from the application:
●

Click Help > Index

You can also access specific topic pages by clicking the Help button in dialog boxes or by using
the F1 key. For more information on using the online Help system, click here.
Getting Started
To get started with the CAST online Help, take a look at the How To... section, which describes
how to carry out basic functions in SQL-Builder, or navigate to the Features section, which
provides detailed information about the various SQL-Builder features.
Current Help Version
See here for more information.
Contacting CAST - Office Locations | Related Help and documentation | Release Notes | About |
Copyright Notice
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Using Help

Using Help
This help system, based on Microsoft HTML Help, makes use of the latest technology to provide
you with in-depth and easily accessible information. It provides both general and more detailed
descriptions about all the available features of the application.
Key features of CAST's online Help system:
●

●

●

●

●

●

●

The Contents tab shows you the exact location of the current topic. Use the auto-sync
feature (Locate button) to identify your position within the Help system.
The interactive Index and full-text Search capabilities allow you to quickly reach the
information you need.
A Favorites tab enables you to store pages that you use regularly and even allows you to
rename pages for easy identification.
If you find reading from paper more comfortable, you can print the current topic
icon) or an entire section ( ), by using the Print command
(represented by the
located on the toolbar.
The button hides more detailed information. Click the button or the associated link to
reveal the required information.
The

button can be clicked to hide a topic.

Clicking the
again to hide them.

button will display all hidden topics in the current page. Click

To start your exploration, please choose a topic to view from the table of contents (Contents
tab).
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Related Help and documentation

Related Help and documentation
●

PDF format > this Help system can be made available in Adobe Acrobat PDF format.
Please contact CAST if you require it.
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Contacting CAST - Office Locations

Contacting CAST - Office Locations
For Sales, Product Support or General Inquiries, please contact our headquarters or your regional
office directly by calling us or filling in the quick email form.
Because CAST is continually growing and expanding, please also consult the CAST Web Site for
an up-to-date list of our office locations.
Headquarters
CAST Corporate and Europe Headquarters
Address: 3, rue Marcel Allégot
92190 Meudon
France
CAST North America Headquarters
Address: 373 Park Ave So.,
5th Floor
New-York, NY 10016

Access Map
Phone: +33 1 46 90 21 00
Fax: +33 1 46 90 21 01

Access Map
Phone: Phone: +1 212 871
Fax: 8330
Support: Fax: +1 212 759 3772
Support: +1 877 852
2278 ext. 135

Sales Offices
Belgium - Brussels
Address: Rue de Henninstraat
67/8
1050 Brussels

Phone: +32 2 646 65 11
Fax: +32 2 646 51 41

France - Paris
Address: 3, rue Marcel Allégot
92190 Meudon

Phone: +33 1 46 90 21 00
Fax: +33 1 46 90 21 01

Germany - Munich
Address: Herzog-Wilhelm-Str.
26
80331 München

Phone: +49 89 215 894 00
Fax: +49 89 215 894 99

Italy - Milan
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Contacting CAST - Office Locations

Address: Via Giovanni da Udine
n° 34
20156 Milano

Phone: +39 02 380 937 80
Fax: +39 02 380 937 81

Spain - Madrid
Address: Paseo de la
Castellana, 141
Edificio Cuzco IV
28046 Madrid

Phone: +34 917 893 484
Fax: +34 915 707 199

Address: Aston Court
Kingsmead Business
Park
Frederick Place
High Wycombe
HP11 1LA

Phone: +44 (0) 1494 616 088
Fax: +44 (0) 1494 616 188

UK - London

Freephone Support
Help Desk:
0800 043 5002

US - Washington DC
Address: 1555 Wilson Blvd.
Suite 602
Arlington, VA 22209

Phone: +1 703-894-1350
Fax: +1 703-894-1356

US - New York
Address: 373 Park Ave So.,
5th Floor
New-York, NY 10016

Phone: +1 212 871 8330
Fax: +1 212 759 3772

US - Chicago
Address: 300 South Wacker
Drive,
Suite 1310
Chicago, Illinois 60606

Phone: +1 312 922 9477
Fax: +1 312 922 9476

Other countries - CAST Channel Partners
Scandinavia
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Contacting CAST - Office Locations

Address: Encora AB
Travslingan 4
SE - 187 54 TABY
Sweden

Phone: +46 (0)708 19 40 76
Email: info@encora.se

All other countries
Address: Software
Distribution and
Services
56 bd Sébastopol
75003 Paris, France

Contact: Eric Maréchal
+33 6 87 82 04 04
(Paris)
+55 11 811 51 395 (Sao
Paulo)
e.marechal@castsds.com
José De Araujo
+33 6 10 34 18 19
(Paris)
+55 11 811 51 367 (Sao
Paulo)
j.dearaujo@castsds.com
André Tzincoca
+33 6 14 46 25 08
(Paris)
+27 72 493 36 35
(Johannesburg)
a.tzincoca@castsds.com
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Copyright Notice

Copyright Notice
This publication pertains to release 6.2 of CAST PRODUCTS and to any subsequent release until
otherwise indicated in new editions or technical notes. Information in this document is subject to
change without notice. The software described herein is furnished under a license agreement,
and it may be used or copied only in accordance with the terms of the agreement. No part of this
publication may be reproduced, transmitted, or translated in any form or by any means,
electronic, mechanical, manual, optical or otherwise, without the prior written permission of
CAST.
Please note that portions of the CAST Reference Finder are based in part on TCL. For TCL
copyright information, see: http://www.scriptics.com/man/tcl7.5/copyright.html
CAST welcomes corrections and comments on its documents.
Please send your suggestions to one of the CAST offices:

European Operations

US Operations

3, rue Marcel Allégot
92190 Meudon
France

641 Lexington Avenue,
32nd Floor
New-York, NY 10022

Paris, France

New York

Phone: +33 (0)1 46 90 21 00
Fax: +33 (0)1 46 90 21 01

Phone: +1 212 871 8330
Fax: +1 212 759 3772

Visit our website: www.castsoftware.com

Copyright © CAST. All rights reserved.
All brand and product names are registered
trademarks or trademarks of their respective
holders.
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Release Notes

Release Notes
CAST provides a set of Release Notes for each version of products it ships.
Please make sure you read these as they contain important late-breaking information, known
issues and other technical information not available prior to shipping.
Notes
●

If you cannot find or access the Release Notes, please contact CAST who will supply them
for you.
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About

About
CAST provides an About dialog box that displays technical information about:
●

the application module name, together with its current version and build number

●

the addresses and contact details of the main CAST Offices

●

the connectivity layer in use

●

the machine identification number

●

the host name

Report button
Clicking the Report button will display a further dialog box providing much more detailed
technical information (known as the CAST Diagnostic Report). This can be particularly useful if
you need to troubleshoot or debug with CAST.
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About

●

●

Connectivity Layer Information > This will launch the Info dialog box
Save file... > Allows you to save the contents of the CAST Diagnostic Report in HTML
format

If you do not want this connection report to be displayed in an HTML format, please add this
script to your GloballySharedSettings.ini file:

[Report]
Report in Dialog Format = 1
Notes
●

Please note that in CAST Server Manager only, this report can also be displayed using the
Database/Schema Installation > Troubleshooting > Diagnostic Report option

See Also
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About

GloballySharedSettings.ini File
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How To...

How To...
●

Launch SQL-Builder

●

Open objects

●

Open object files

●

Open selected objects

●

Load SQL-scripts

●

Create new objects

●

Drop objects

●

Use the Custom Drop option

●

Save objects (sending objects to the server)

●

Save objects and SQL scripts as files

●

Printing with SQL-Builder

●

Inserting code into editors

●

Changing the working database

●

Dependencies (calling and called)

●

Capture parameters

●

Generate Script - how to use the Release Builder integration

●

Open a concurrent connection

●

Use the Comment/Uncomment commands

●

Use the Help on Syntax dialog box

●

Hiding a schema/database
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Launching SQL-Builder

Launching SQL-Builder
Client Identification dialog box
The very first time you launch SQL-Builder, the application may ask you for an Identifier. This is
simply a hostname that identifies your client machine to the server.
All you need to do is to enter an Identifier in the appropriate field which can be up to 10
characters long. You can use your existing client name if you want, or the last 10 digits of
your IP address if this is more convenient.
When you run the SQL command sp_who in the SQL-Session, you will then see this identifier
under the hostname column in the returned results as displayed below:

" spid
...
6

status

loginame

running sa

WESLEY

hostname

blk

0

SELECT "

master

dbname

cmd

What next?
When you are satisfied with the identifier you have entered, click the OK button.
The dialog box will then close and the normal connection procedure will continue. If you want to
abort the process, click the Cancel button.
Notes
●

The Client Identification dialog box is only displayed when you FIRST launch the
application - subsequent launches will go straight to the Object Manager.

Connecting to a server
Once you have confirmed your Identifier in the Client Identification dialog box the Object
Manager will open.
1. You now need to create a Profile that contains your required connection parameters.
2. When this is complete, the Profile will be displayed in the Object Manager.
3. Double-click the Profile to connect to the server defined in the Profile.
4. If the parameters you defined are accepted, a connection to the server will be opened
and the Object Manager will automatically display the contents of the server.
Troubleshooting
If for some reason no connection with the server can be established, a warning message will
appear. In addition a message will appear in the Messages and Errors List of the Tools Window to
explain the likely cause of the failure and to help you rectify the problem.
You may also need to define a Knowledge Base for licensing requirements. Check with your CAST
contact.
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Launching SQL-Builder

See Also
Connection | Profiles | Creating Profiles
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Open objects

Open objects
Object > Open object
Opening an object stored on a server enables you to edit and make changes to that object.
Objects can be opened directly from the Object Manager in a variety of ways:
●

●

●

●

●

Double click an object displayed in the Object Manager.
Highlight an object in the Object Manager, click the Object menu located on the toolbar
and then select the Open object option listed in the drop down menu (only when working
in One/Two Pane mode).
Highlight an object in the Object Manager, right click on the Object to launch the shortcut
menu and then select the Open option from the menu.
Click the

button located on the toolbar.

You can also click the Open button in the bottom left hand corner of the Object Manager
when an object is highlighted (only when working in Two Pane mode).

All options will launch a dedicated editor enabling you to edit the object. Click here for more
information about the dedicated object editors.
See Also
Object Manager | Object Editors
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Open object files

Open object files
File > Open Object File
This command can be used to open a new object document based on a script file. For
instance if you have a Stored Procedure or a Trigger saved as an object file, then you can use
this command to open it and then edit it. To use the command, you can:
●

Click the File menu located on the toolbar and then select the Open Object File option

●

Click the

●

Or you can use the shortcut key: CTRL+O

button located on the toolbar

This will launch a standard windows Open dialog box, from which you can select the type of
object you want to open.
Notes
●

Object files differ from SQL-scripts in that they are displayed in SQL-Builder in the
dedicated editor. SQL-scripts are pure script and are opened only in the SQL-Session (they
also have .SQL file extensions).

See Also
Object Editors | Save objects and SQL scripts as files
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Open Selected Object command

Open Selected Object command
This command enables you to open an object directly from the code of another object or SQLSession.
SQL-Server/Sybase users
1. Highlight an object's name or place the cursor next to an object name in an Object Editor
(Stored Procedure for example), the SQL-Session or the Debugger.
2. Click the Navigation menu located on the toolbar and then select Open Selected Object
3. Or use the shortcut key: CTRL+B
4. Or right click in the Object Editor/SQL-Session/Debugger to launch the shortcut menu
and select Open Selected Object
5. Or use the

icon located on the toolbar

Oracle users
1. Highlight an object's name or place the cursor next to an object name in an Object Editor
(Stored Procedure for example), the SQL-Session or the Debugger.
2. Click the Navigation menu located on the toolbar and then select Open
'[object_name]'
3. Or right click in the Object Editor/SQL-Session/Debugger to launch the shortcut menu
and select Open '[object_name]'
Note
●

●

●

You may be prompted to choose a connection in the Existing Connections dialog box
before you can open the selected object.
This command will only function when you highlight a non-keyword without a full-stop (.).
For SQL-Server/Sybase users, SQL-Builder will try to open the object firstly as a
Stored Procedure, then as a Trigger, a Table, a UDT, a Rule, and lastly as a
Default).
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Load SQL-scripts

Load SQL-scripts
File > Load SQL-Scripts
Loading SQL script files entails opening files that have been saved to the hard disk from a
previous SQL-Session or from an object To use the command, you can:
1. Click the File menu located on the toolbar and then select Load SQL-Scripts
2. This will launch a standard windows Open dialog box, from which you can select files
that have the .SQL extension.
When you select a file and click the OK button, SQL-Builder will automatically launch an SQLSession.
Notes
●

SQL-scripts differ from object files in that they are displayed in the SQL-Session and are
pure script (they also have .SQL file extensions). Object files are opened in SQL-Builder in
the dedicated editor. Both types of files can be opened with a text editor.

See Also
SQL-Session | Edit SQL-Script
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Create new objects

Create new objects
Object > New object
Creating new objects refers to building a new object from scratch and then saving it in the
database/schema of your choice on your server.
If you prefer using the graphical interface, you can create new objects via the Object Manager.
However, you may prefer to enter the required coding by hand, in which case you can use the
SQL-Session. This section refers to creating new objects using the Object Manager.
1. First decide what type of object you want to create and in what database/schema. Then
click an object type in the Object Manager to highlight it as shown below:

You can also click one of the toolbar icons (SQL-Server/Sybase users only) that
correspond to the object type you want to create (click here for more details about the
toolbar icons).
2. When working in One/Two Pane mode, click the Object menu located on the toolbar and
then select the New object option listed in the drop down menu.
3. When working in any display mode, right click the selected object type in the Object
Manager to launch the shortcut menu and then select New.
4. Or, click the

button located on the toolbar.

An editor that corresponds to the object type you want to create will then open, enabling you to
define the new object and enter the relevant information. Click here for more information on
the object editors.
Once you are happy with the new object, you can then save it on the server.
Notes
●

You can modify the default code that is contained in a new object by modifying the SQLObject templates.

See Also
SQL-Session | Object Manager | Object Editors
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Drop objects

Drop objects
Object > Drop
Dropping an object refers to physically removing an object from the database/schema and
server. All information will be discarded and cannot be retrieved.
If you prefer using the graphical interface, you can drop objects via the Object Manager.
However, you may prefer to enter the required coding by hand, in which case you can use the
SQL-Session. This section refers to dropping objects using the Object Manager.
There are several ways to drop an object.
1. First, in the Object Manager, select the required objects by holding down the SHIFT or
CTRL keys and then selecting with the left mouse button.
2. When working in One/Two Pane mode, click the Object menu located on the toolbar and
then select the Drop object option listed in the drop down menu.
3. When working in any display mode, right click the selected object or objects to launch
the shortcut menu and then select the Drop option.
4. Or, click the

button located on the toolbar.

All of these options will then launch a prompt dialog box which will ask you whether you are sure
you want to drop the selected objects. This is a "safety-net" which will help eliminate accidental
drop procedures. This exists because dropping an object entails physically removing that
object from the server, and, as a result, other linked objects may be affected by the removal.
Dropping Tables
Please be aware that when you drop a table, ALL ITS DATA and some other OBJECTS will also be
removed. This includes:
●

Triggers defined on the table

●

Indexes defined on the table

●

Some referential integrity constraints: i.e.: the foreign keys defined on the
primary/unique keys existing on the current table.

You will also be asked if you want to preserve the data and/or script contained within your table
(within a specific dialog box) - if you decide to do so the data will be exported to Release
Builder and the script will be saved to file as an SQL-script file:
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Drop objects

Notes
●

You can also drop objects directly from the dedicated editor by opening the object
and selecting Drop [object type] from the object specific menu on the menu bar.

See Also
Object Manager | SQL-Session | Object Editors
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Custom drop statement

Custom drop statement
SQL-Builder enables you to insert a custom Drop Statement when you save an object as an
ASCII file. At present however, this option has no built-in interface in the application and must,
therefore, be used manually.
Normally, when you save an object as an ASCII file, SQL-Builder will automatically insert a
generic Drop Statement at the beginning of the script. See the example below for a Stored
Procedure:

If Exists(Select name
From sysobjects
Where name='sp_a_constraintinfo'
And type='P'
And uid = User_id('dbo'))
Drop Procedure dbo.sp_a_constraintinfo
go
However, when you save Stored Procedures, Functions, Views and Triggers, you can now modify
this Drop Statement. (This option does NOT exist for Rules, Defaults and Tables).
Enabling Custom Drop Statements
Before you modify your Drop Statements, you first need to enable the option by altering your
SQL-Builder .INI file so that when you save a server object as an ASCII file, your customized
Drop Statement will be included. To do this, you need to:
1. Open the .INI file (SQLBUILD.INI) and add the following script directly under the line
containing [OptionInAFile]:

[OptionInAFile]
UseCustomDropOrder=1
CustomDropOrder_PROCEDURE=Drive name:\PATH\scriptdropprocedure.txt
CustomDropOrder_FUNCTION=Drive name:\PATH\scriptdropfunction.txt
CustomDropOrder_VIEW=Drive name:\PATH\scriptdropview.txt
CustomDropOrder_TRIGGER=Drive name:\PATH\scriptdroptrigger.txt
2. Alter the Drive name:\PATH\ to reflect the location of the .TXT files (the .TXT files are
stored alongside your other CAST files and are named as above), then save the .INI file.
Next time you save an object as an ASCII file, your custom Drop Statement will appear at the
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Custom drop statement

start of the script when you open it using the Open Object File command.
If you want to de-activate this option temporarily, you can alter the line:

UseCustomDropOrder=1
to:

UseCustomDropOrder=0
Modifying your Drop statement
Once you have enabled the custom Drop Statement in your .INI file, you can then modify the
statements to suit your own requirements. To do this:
1. Manually open the .TXT files that contain the Drop Statements
2. Modify them as you require
3. Re-save them
The .TXT files are stored alongside your other CAST files and are named as follows:
●

ScriptDropFunction.txt

●

ScriptDropProcedure.txt

●

ScriptDropView.txt

●

ScriptDropTrigger.txt

Double-click them to open them in Notepad (for example) and modify them as you require.
Tags
Because the Drop Statement saved in the .TXT files is generic, it will include sections that will
vary according to each object you save (for example the UserId may be different, the object
name will alter etc...).
To overcome this, the Drop Statement in each .TXT file includes various tags that SQL-Builder
will modify automatically when you save the object to reflect the sections that vary. These tags
are as follows:
●

%sqldatabase - database name

●

%sqlowner - database owner (UserId)

●

%sqlname - used in SQL orders and manages quoted and bracketed identifiers

●

●

%sqlqualifiedname (if the owner of the object is defined then it will appear in the form
owner.object, if undefined, it will appear as object)
%sqldatabasestring, %sqlownerstring, %sqlnamestring,
%sqlqualifiednamestring - all used in WHERE clauses and for strings containing
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Custom drop statement

apostrophes
When you modify your Drop Statement, you must, therefore, include these Tags so that
variables in the statement are automatically changed by SQL-Builder when you save the object.
For example:

drop proc %sqlname
select name from sysobjects where name = '%sqlnamestring'
See Also
Object Editors | .INI File Options
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Saving objects (sending objects to the server)

Saving objects (sending objects to the server)
There are several ways to save objects (in essence this means sending the object to the
server for verification and update) that you have modified or newly created.
To save an object on the server:
1. Click the Object Specific menu located on the menu bar (e.g.: Function for the
Function Editor) and then select the Save [Object Type] option from the drop down
menu.
2. Alternatively you can click the

button located on the toolbar

3. Or you can use the shortcut key: CTRL+G
Notes
●

●

The save option also exists in the right-click shortcut menu for each editor (except the
Table Editor and the UDT Editor).
The ability to synchronize objects with the CAST Knowledge Base has been withdrawn
from CAST SQL-Builder. It is now no longer possible to use the Save option that included a
synchronization with the Knowledge Base. CAST recommends using CAST Analysis
Manager in batch form to fulfil your synchronization requirements. For more information
about this, see the on-line Help for CAST Analysis Manager (Root > How To >
Generating a batch file or Root > Command Line).

Circumstances depending on Object Type
●

Table Editor
When you modify a Table and then want to save it again, the Table will first need to be
dropped and then recreated necessitating a Drop Procedure and then a Create Procedure
(depending on the modification you make).
To ensure that no data is lost when the Table is dropped, SQL-Builder will launch the Data
Preservation Assistant which will automatically carry out the the Drop and Create
procedures for you to reflect your modifications.

●

Rule Editor and Default Editor
When you save a Rule or Default object, a small dialog box will be displayed enabling you
to specify the name of the object when you save it:

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/HowTo/save.htm (1 of 2) [10/07/2008 10:35:35]

Saving objects (sending objects to the server)

See Also
Object Manager | Object Editors
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Save objects and SQL scripts as files

Save objects and SQL scripts as files
File > Save (As)
This command can be used to Save an active object or SQL-script (in an SQL-Session) as a file.
When you save a document for the first time, SQL-Builder will display the standard Windows
Save As dialog box so that you can enter a name for the document.
You can change an existing document's name and/or directory before saving by selecting the
Save As command (see below).
Save
1. Click the File menu located on the toolbar and then select Save or Save File
2. Use the shortcut key: CTRL+S
3. Click the

button (not for Oracle users)

Save As
You can use this command to Save and then Rename the active object file. SQL-Builder will
display the standard Windows Save As dialog box so that the document can be renamed:
1. Click the File menu located on the toolbar and then select Save As or Save File As
2. Use the shortcut key: CTRL+S
3. Click the

button (not for Oracle users)

Notes
●

●

When saving a Stored Procedure or a View to a file, permissions may be saved at the
end of the file after a special marker. The permissions can then be read when the file is
opened.
To save a document with its existing name and directory, use the Save command,
described above.

See Also
Open object files | Load SQL-scripts | Save Script in File
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Printing with SQL-Builder

Printing with SQL-Builder
File > Print
SQL-Builder offers a variety of print options enabling you to print the contents of the following
windows when active:
●

Object Editors

●

SQL-Session

●

Debugger

To print one of these active windows:
1. Select File > Print from the menu
2. Or use the shortcut key: CTRL+P
3. Or use the toolbar icon

(not for Oracle users)

Notes
●

When printing an Object Editor using the menu or shortcut options, SQL-Builder will
prompt you to select a specific feature to print:
❍

Print All tabs (HTML)

❍

Print All tabs (fixed font)

❍

Print Flow Chart and All tabs

❍

Print Script tab only

Using the toolbar icon (not available for Oracle users) will print the active document.
●

When printing either the SQL-Session or the Debugger, SQL-Builder will prompt you to
select a specific area to print.

See Also
Printing from the SQL-Session window
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Inserting code into editors

Inserting code into editors
SQL-Builder provides an SQL editor integrated into various features within the development
environment. Notably:
●

Object Editors

●

SQL-Session

●

Debugger

There are also various ways to insert code into the editor in the different options:
●

●

●

Manually - using the keyboard.
Via the Query Assistant - this can be used to create queries automatically using a drag and
drop environment.
Via a Code Template - templates are pieces of SQL code that can be dragged and dropped
into the editor when required.

See Also
Query Assistant | Templates | Code Templates tab
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Change the working database/schema

Change the working database/schema
When working with SQL-Builder to create objects either in the SQL-Session or via an editor,
please make sure you check you are working in the correct current database/schema.
To change the current database/schema:
1. Look at the drop down list in the Standard toolbar. This will tell you what the current
database/schema is:

2. If this is not correct, click the drop down list and select the one you require.
Notes
●

Creating an object or executing a script in the incorrect database/schema can have
potentially damaging effects. Always check which database/schema you are working in
before you begin.

See Also
Standard toolbar
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Dependencies (Calling and Called)

Dependencies (Calling and Called)
Object > Dependencies
When the Object Manager is the active window you can use the Dependencies option to view, at
a glance, the objects that are calling or being called by a specific object selected in the Object
Manager. Thus you can quickly identify which objects would be impacted by a modification to
another object.
For SQL-Server/Sybase users only
1. Select an object in the Object Manager (when working in Two Pane mode) by left clicking
it once to highlight it.
2. Click the Object menu located on the toolbar (shown above), click the Dependencies
option from the drop down menu (which will then launch a sub-menu) and then select
either the Calling Objects or Called Objects options.
For all users
1. Select an object in the Object Manager by left clicking it once to highlight it.
2. Right click an object in the Object Manager to launch the shortcut menu, click the
Dependencies option from the drop down menu (which will then launch a sub-menu) and
then select either the Calling Objects or Called Objects options.
In each case a small display window will be launched to indicate which objects are either Calling
or are being Called by the object you selected in the Object Manager:

If you want to see the code in any of these dependent objects or edit them, you can do so by
double-clicking them (or by right clicking on them to launch the contextual menu and
selecting the Open option). This will then launch the appropriate Object Editor.
If you use the shortcut menu option, you will also be able to see a list of the objects that are
either Calling or are being Called by the object you first selected. They are displayed with their
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Dependencies (Calling and Called)

full name and their type (i.e.: TABLE, PROCEDURE etc.).

Notes
●

●

Computing the dependencies of an object can be a time-consuming operation, particularly
if your database/schema contains a large number of objects.
You can force SQL-Builder to stop automatically computing the dependencies when you
select the shortcut menu option. See the Dependencies in popup menu option in the
OM Options tab for more information.

See Also
Object Manager | Object Editors | OM Options tab
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Capturing parameters

Capturing parameters
Object > Capture parameters, Object > Stop capturing parameters (when Object
Manager is active)
When you capture the parameters of a Stored Procedure, SQL-Builder will modify the
Procedure's source code to add statements which save input parameters in a special table. Thus,
every time this Procedure is called, the parameter values sent to the Procedure are saved inside
a table. Then, when you need to debug the Procedure, the debugger lets you select a set of
parameter values with which you can debug the procedure. This is particularly useful when a
procedure fails when called by a client application. When the application calls the procedure, the
parameter values sent are saved, so you can consult and try them in the debugger to find out
which call the procedure is failing on.
When you have set SQL-Builder to capture at least one Procedure's parameters in a database, it
will create a table, named CW_DBG _PARAM_INSTR in the Knowledge Base. This table contains a
list of the procedures whose parameters are being captured and also displays parameter values
saved when executing such procedures. When your tables' parameters are being captured in the
database, this table (CW_DBG _PARAM_INSTR) is automatically dropped.
When you view the procedure's code in the Procedure Editor, code pertaining to the Capture
Parameter command is never visible. In addition, the source code displayed is exactly as the
original code, and when you save the procedure on the server, a new instrumentation code is
automatically added to keep the Capture Parameter set on a particular Procedure.
How to capture parameters
There are several ways to set the Capture Parameters command:
1. Select an object in the Object Manager by clicking it once to highlight it.
2. Click the Object menu located on the toolbar and select Capture parameters from the
drop down menu.
3. Or, right click the object in the right hand section of the Object Manager to launch the
shortcut menu and select Capture Parameters.
When you have used either option, the color of the object's name in the Object Manager will
change to dark red (as shown below) only when you are using Two Pane Mode.

How to stop capturing parameters
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Capturing parameters

1. Select the object in the Object Manager
2. Click the Object menu located on the toolbar and selecting Stop capturing parameters
from the drop down menu.
3. Or, right click the object to launch the shortcut menu and select Stop capturing
parameters
When you use either of the above, the color of the object's name will revert to black.
Notes
●

You can also Stop Capturing Parameters on several objects by selecting the object
folder in the left hand section of the Object Manager, and then following the above two
instructions. This will remove the Capture Parameters command from ALL the objects in
the object folder. You cannot, however, set the Capture Parameters option for more than
one object.

See Also
Object Editors | Object Manager
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Generate Creation Script

Generate Creation Script
SQL-Builder enables you to select various objects listed in the Object Manager and then
automatically create a Script Extraction using Release Builder (another CAST application).
How to...
1. Select the objects you want to include in the Creation Script by clicking with the mouse
and holding down either the SHIFT or CTRL keys.
2. Right click the selected objects to launch the shortcut menu.
3. Select Advanced, then Generate Creation Script from the sub menu.
Release Builder will then be launched automatically. You will be prompted for connection
parameters (see here for more information) and the Script Extraction dialog box will then be
launched (see the Release Builder on-line Help).
Results
Once the Creation Script has been generated and saved with Release Builder, you can then run it
in SQL-Builder:
1. Click File, then select Load SQL-Scripts from the drop down menu
The generated script will then be opened automatically in the SQL-Session, enabling you to rerun it.
See Also
Object Manager | SQL-Session
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Opening a concurrent connection

Opening a concurrent connection
To open a concurrent connection to a server:
1. Create a new Profile (if one is not already available) that specifies the server you want to
access.
2. Right click the Profile once displayed in the Object Manager.
3. Select Open Profile from the shortcut menu.
4. The connection will be established and the contents of the server will be displayed in
Object Manager at the same time as other servers.
See Also
Connection | Profiles
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Using the Comment/Uncomment Commands

Using the Comment/Uncomment Commands
Template > Comment
SQL-Builder enables you to create comments in your SQL code if you should require it.
Comments are normally used to accompany code in order to explain in simple terms what the
piece of code actually does. In the following example, the comment in the code is in green and
begins with /* and ends with */.

/* remove all values being deleted or updated */
UPDATE titles
SET total_sales = ISNULL(total_sales, 0) - (SELECT SUM(qty)
FROM deleted
WHERE titles.title_id = deleted.title_id)
END
This comment explains in basic terms, what the code that follows actually does. Thus the
comment function enables you to avoid having to search, read and understand code to find
out exactly what it does, saving you time. When the query is sent to the server, the commented
phrases are ignored and only the actual code is executed.
How to add comments to an editor
For this example, we are using the SQL-Session to illustrate comments:
1. Enter the information in the Query Editor of the SQL-Session window, above the code that
you want to explain.
2. Next highlight the information.
3. Click the Templates menu located on the toolbar, and then select the Comment command
from the drop down menu.
4. Or click the

button located on the toolbar.

5. Or right click in the editor to launch the shortcut menu, and then choose the Comment
command.
These three options will then comment your highlighted text in the Query Editor as displayed
below:
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Using the Comment/Uncomment Commands

How to remove comments from an editor
Removing comments from the code is as easy as adding them:
1. First highlight the comment you want to remove, then use one of the following commands
to remove the comment markers.
2. Click the Templates menu located on the toolbar, and then select the Uncomment
command from the drop down menu.
3. Or click the

button located on the vertical toolbar on the right hand side of the screen.

4. Or you can right click in the editor to launch the shortcut menu and then choose the
Uncomment command
These three options will then Uncomment your highlighted text in the editor.
Notes
●

These commands are unavailable when no text is selected in the editor

●

Comments can be used in all Object Editors, the SQL-Session and in the Debugger.

●

SQL-Builder supports nested comments.
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Using the Comment/Uncomment Commands
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Using the Help on Syntax dialog box

Using the Help on Syntax dialog box
Template > Syntax
The Help on Syntax dialog box provides rapid help on SQL language. For example, you can
find out the definition of any SQL instruction, simply by typing in its name (or even some of the
first few letters).
This can be extremely useful when examining code that may have been written by another
person and thus may contain language with which you are unfamiliar. You can also paste SQL
commands to the editor.
Notes
●

The Help on Syntax dialog box can be used in the Object Editors and the SQL-Session.

Accessing the dialog box
To open the Help on Syntax dialog box:
1. Click the Template menu located on the toolbar and then select the Syntax option from
the drop down menu
2. You can right click in the editor to launch the shortcut menu and then select the Syntax
option
3. You can use the shortcut key: CTRL+K
4. Or you can click the

button located on the toolbar

All these options will launch the dialog box displayed below.
Notes
●

You can also highlight SQL syntax in the editor, right click on the highlighted syntax to
launch the shortcut menu, then select the Syntax option. This will automatically open the
dialog box on the syntax you want to find out more about.

Using the dialog box
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Using the Help on Syntax dialog box

When the dialog box has been launched, enter the SQL instruction you want to know more
about in the entry field at the top of the dialog box. This will automatically highlight the
instruction in the list field immediately below. You can also enter the first few letters of an
instruction which will then display the nearest equivalent in the list field.
The parameters for the instruction you enter are then also displayed in the area immediately
below the list field. This will explain how to use the command in more detail.
Copy To
You can click the Copy To button in the bottom left of the dialog box to paste the instruction in
the editor. You can then fill in the parameters as you require in the Query Editor.
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Hiding a schema/database

Hiding a schema/database
It is possible to set a "hide" marker against a schema or a database in the Object Manager - then
when activating the Object Manager filter, the database/schema with the "hide" marker will no
longer be visible in the Object Manager. This is to facilitate the visual display of items in the
Object Manager.
To set a "hide" marker against a schema/database:
1. In the Object Manager, right click the schema/database that you want to hide.
2. Select Advanced > Hide this database or Hide this schema depending on your server
version.
3. The selected schema/database will then be "hidden". A (h) next to the schema/database
name will indicate that the schema/database is hidden:

To hide the database/schema:
1. When the (h) marker has been set on the databases/schemas you want to hide, click the
button located on the toolbar (you must be working in Two Pane mode and have the
Object Manager toolbar activated - View > Toolbars).
2. The databases/schemas with "hide" markers will no longer be displayed in the Object
Manager and the character combination (f) will appear next to the server name on which
the Filter is defined, to indicate that a Filter is in use.
See Also
Object Manager Interface | Object Manager Filter tab
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Features

Features
The Features section provides in-depth knowledge and information about SQL-Builder's key
features. Select an item listed below to find out more.
●

About Dialog Boxes

●

Code Checker

●

General Configuration

●

Connection

●

Data-Session

●

Debugger

●

Flow Chart

●

Object Generators

●

Graphical Object Manager

●

Object Editors

●

Object Manager

●

Output Window

●

Query Assistant

●

Search in SQL-Objects

●

SQL-Session

●

Template Management

●

Tools Window

●

Source Manager Interface
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About Dialog Boxes

About dialog boxes
SQL-Builder is equipped with several 'About' dialog boxes which provide various information.
For example, if you want to find out about the server an object is stored on, then you can do so
here by opening the object and then launching the About Server dialog box which will provide
you with various information.
●

About Server dialog box

●

About Connection dialog box

●

About Database dialog box

●

About Object dialog box

●

About Table dialog box

●

About SQL-Builder dialog box
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About Server

About Server
This dialog box provides information about the server you are connected to, and more particularly
about the connections opened on it. You can also change the size of this dialog box if you require.

Launching the dialog box
This dialog box can be launched ONLY when an object is open (click here to find out more about
how to open objects from the Object Manager) or when the SQL-Session is open.
To view the dialog box:
1. Click the Help menu located on the toolbar, then select the About Server option from the
drop down menu
2. Or you can use the shortcut key: CTRL+I
Dialog box options
SQL Server Name

This field displays the name of the local SQL server (using the
"@@servername" system variable).

Current users

Lists the open connections on the server (displayed in the field
underneath) and displays various information about them. For each
opened connection you will be able to see the following:

Update

Refreshes the information displayed
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About Server

For each opened connection you will be able to see the following:
SpId

Process Identifier

User

Name of the user who issued command

DBName

Displays the name of the database under which the process is
being run

Locks

Displays the number of locks held on each process

Cmd

Command currently being executed

Status

Displays the process status, which will be one of: infected,
background, receive sleep, send sleep, alarm sleep, lock sleep,
sleeping, run able, running, stopped, bad status or log suspend.

Locking

Process Identifier of blocking process, if any.

Host-name

Name of the host computer.

Program-name

Name of the front-end module using this process.
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About Connection

About Connection
This dialog box provides information about the current connection (the connection used by
the document/object from where this dialog box was called).

This dialog box can be launched ONLY when an object is open (click here to find out more about
how to open objects from the Object Manager) or when the SQL-Session is open.
To view the dialog box:
1. Click the Help menu located on the toolbar, then select the About Connection option
from the drop down menu
Dialog box options
The first section of the dialog box provides some general information about the current
connection:
Login

Displays your login name for this connection.

Client Identification

This is the client identification of your PC. It is the name you
provide in the Client Identification dialog box. You can view this
parameter in the About Server dialog box dialog box: see the
Host value in the Current Users section for the opened
connection.

SQL Server Name

Displays the name of the local SQL Server ("@@servername"
system variable).
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About Connection

User Name

Your User Name in the current database.

Current database

Displays the database selected in the document/object from
where this dialog box was launched.

SpId

Identifier of the current process on the server.

The second section of the dialog box provides some information about the CAST Knowledge
Base. This second section is not available when a CAST Knowledge Base is not defined on the
current server.
These check boxes cannot be selected or cleared, they merely provide information relative to
the active parameters for the document or object that this dialog box was launched from.
Current user defined in
the CAST Knowledge
Base

If this option is checked, you are connected as a user defined in
the CAST Knowledge Base. In this case, your trigram in the
CAST Knowledge Base is given in the User trigram editor and
the full name in the User Fullname editor.
The name of the group below may also be displayed in the Group
Name field (if this group is specified, i.e. if its ID is not 0)

Database defined in the
CAST Knowledge Base

If this option is checked, the current database is defined in the
CAST Knowledge Base. In other words, all the objects you
create will be defined in the CAST Knowledge Base.
You cannot modify an object that is already being used nor if you
do not have access permissions.

Database locked by
CAST Analysis Manager

If this option is checked, you cannot modify an object in the
current database because it is being used by CAST Analysis
Manager.

See Also
Connection | Knowledge Base connection
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About Database

About Database
The dialog box displays information relevant to the current database. The current database is
the selected database in the document/object from where this dialog box was launched. You can
select another database in the Database combo-box described below.
The number of opened transactions is only shown for the current database. When you select a
device in the Devices list box, the amount of free space on this device is shown in the
Percentage Free bar.
Launching the dialog box
This dialog box can be launched ONLY when an object is open (click here to find out more about
how to open objects from the Object Manager) or when the SQL-Session is open. You can then
you can do the following:
1. Click the Help menu located on the toolbar, then select the About Database option from
the drop down.
Notes
●

This option is only available when using SQL-Builder with certain older SQL-Server
versions.

Dialog box options
DataBase > This combo-box lists all the databases defined on the server you are connected to.
To view information about a database, select it in this combo-box.
Owner

This section displays the SQL Server name of the owner of the
database.

Size

Displays the size of the database in Mega Bytes.

DbId

Displays the SQL Server Identifier of the database.

Creation date

Displays the database creation date.

Nb of Tran.

Shows the number of opened transactions in the current
database (only when the selected database is current).

Last Dump Tran

Displays the date of the last 'dump transaction' command.

CAST Knowledge Base Section > This section will ONLY contain information when the object
that it was called from is NOT a Rule or a Default Value (and when the selected database is
current).
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About Database

Database defined in the
CAST Knowledge Base

This option will be checked if the selected database is defined in
the CAST Knowledge Base. This option must be checked so that
you can update the CAST Knowledge Base with existing or
specified objects.

Database locked by
Analysis Manager

This option will be checked when the selected database is defined
in the CAST Knowledge Base and when the current database is
already used by the CAST Analysis Manager application. This
option will be blank if you launched the dialog box from the SQLSession.

Status section > This section provides some information about the status of the selected
database:
●

Select into/bulk copy allowed

●

Truncate log on checkpoint

●

No checkpoint on recovery

●

Suspect

●

For dbo use only

●

Name has been changed

●

Single User

●

Allow Nulls by Default

●

Read only

Devices > This section provides a list of the devices defined for the selected database and some
information about them:
●

Their Names

●

Their Functions

●

L: Database LOG may be placed on this device fragment

●

U: USER-defined segment on this device fragment

●

D: Database objects may be placed on this device fragment by DEFAULT

●

S: SYSTEM objects may be placed on this device fragment

●

Their Size in Mega Bytes

●

Their VDevno
When you select a device in the list, the rate of used space on this device is shown in the
"% Used" bar. "% Used" is not available with Microsoft SQL Server.
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About Object

About Object
This About dialog box displays information about the current object.

Launching the dialog box
This dialog box can be launched ONLY when an object is open (click here to find out more about
how to open objects from the Object Manager).
To view the dialog box:
1. Click the appropriate object specific menu located on the toolbar (whether Stored. Pr,
Table, Rule etc...) then select the About Object option from the drop down menu.
Dialog box options
Name

This section displays the name of the object.

Owner

Displays the SQL Server name of the owner of this object.

Open from/Created on
server in database...

If this option is checked, the current object has been opened or
has been created on the server in the given database.

Defined in the CAST
Knowledge Base

If this option is checked, the current object is defined in the CAST
Knowledge Base. This option is only defined for Stored
Procedures, Triggers and Tables.

Will be updated in the
CAST Knowledge Base

If it is checked, the current object will be updated in the CAST
Knowledge Base when creating it on the server. This option is
only defined for Stored Procedures, Triggers and Tables.
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About Object

Read Only

If this option is checked, the current object has been opened in
Read Only mode because it is defined in the CAST Knowledge
Base and:
●

●

you do not have the rights to modify it (or you are not
defined as a user in the CAST Knowledge Base)
or this object has already been opened by someone else
and is therefore locked.

If the object is in Read Only mode, you will not be able to modify
it. You can however change its name and create it using another
name. This option is only defined for Stored Procedures,
Triggers and Tables.
Locked by current SQLBuilder

If this option is checked, the current object is locked by SQLBuilder (i.e.: it exists in the CAST Knowledge Base and you have
opened it).
Nobody else can open and modify it with a CAST Product. This
option is only defined for Stored Procedures, Triggers and
Tables.

Flagged in CAST
Knowledge Base

If this option is checked, the object is Flagged in the CAST
Knowledge Base.

Locked by

If this option is checked, the current object is locked by another
user whose name is given (name defined in the CAST Knowledge
Base), thus you cannot modify it. This option is only defined for
Stored Procedures, Triggers and Tables.

Permanent Lock

This option is similar to the Locked by option described above.
Instead this object has a Permanent Lock placed on it in the
Knowledge Base. The name of the user who carried out this
procedure is displayed in the field immediately to the right.

Table button

You can click this button to access the About Table Dialog Box
(when the current object is a Table) which provides more indepth information about Tables.
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About Table

About Table

Launching the dialog box
This dialog box can ONLY be launched from the About Object dialog box when a Table is open
(click here to find out more about how to open objects from the Object Manager).
To view the dialog box:
1. Click the Table menu located on the toolbar, then select the About Object option from
the drop down menu, to launch the About Object dialog box
2. Then click the

button located at the bottom of the About Object dialog box.

Dialog box options
No. Lines (as found in
sysindexes)

This section indicates the number of lines defined in this Table.
The number of lines in the table is based on sysindexes. The
value shown might differ from the real value if your indexes are
not up to date.

Data Size

Indicates the size (in KB) of the data.

Reserved size

Displays the size (in KB) reserved for the table.

Index size

Indicates the size (in KB) of the index.

Percentage Free

Displays the amount of space reserved for this table, but not
used.
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About Table
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Code Checker

Code Checker
●

What is the Code Checker?

●

Launching the Code Checker

●

Code Checker Results

●

Error Code List - a list of the messages produced by the Code Checker after verification

●

SARG's Optimization - an explanation of SARGs and how to detect them

●

Performance Checker

●

How to Launch the Code Checker from the Command Line

●

Configuring the Code Checker
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What is the Code Checker?

What is the Code Checker?
SQL-Builder's Code Checker feature enables you to verify objects stored in your
database/schema for possible errors and problems - without creating them on the server.
If the Code Checker detects the risk of an error in the SQL code of an object in your
database/schema, it will notify you of this enabling you to take any necessary steps to rectify the
possible problem(s).
See Also
Launching the Code Checker
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Launching the Code Checker
Before the Code Checker is launched, you need to decide what sort of potential errors and
warnings you want to check for. This can be done via the General Configuration options, in the
Code Checker tab.
The Code Checker can then be launched when you have an object open (click here to find out
how to open objects from the Object Manager).
Once the object is open there are various ways to launch the Code Checker:
1. You can click the object specific menu located on the toolbar and then select the Code
Checker option from the drop down list.
2. Or you can use the shortcut key CTRL+M (SQL-Server/Sybase users), CTRL+ALT+V
(Oracle users).
3. Or you can click

located on the toolbar

4. Or you can right click in the Object Editor itself to launch the shortcut menu and then
select the Code Checker option (SQL-Server/Sybase users only)
5. Or from the Command Line using the -CODECHECKER option. See here for more
information.
You can also launch it direct from the Object Manager (without the need to open an object
beforehand):
●

For SQL-Server/Sybase users only, when working in Two Pane mode using the
button located on the toolbar associated with the Object Manager.

●

For all users, right click the selected object, then select Advanced > Code Checker from
the shortcut menu.

The Code Checker will then start. See Code Checker Results for more information.
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Code Checker Results
When the code checker has been started, the code in the selected object will be checked for possible
problems and then any possible errors and/or problems that may be detected will be displayed either in
the Local Messages tab or in the Code Checker tab, both part of the Tools Window.
The location of the results will depend on where you launch the Code Checker process from:
●

From the Object Manager using the

button located on the Object Manager toolbar when the

Object Manager is in two pane mode. Results displayed in the Code Checker tab:

●

From all other locations as described here, the results will be displayed in the Local Messages tab:

This is an example of the results that may be displayed in the Local Messages tab after using the Code
Checker to check for possible errors in an object.
The Code Checker displays the Line and Column number of the possible error in the code, as well as
providing a textual explanation of the possible error.
The letters and numbers within the brackets (such as (W11)) correspond to an error code.
You can move through the results using the Next Error command:
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Code Checker Results

1. Click Edit > Next Error on the toolbar
2. Or use the shortcut key: F4
To move back through the list of possible errors:
1. Click Edit > Previous Error on the toolbar
2. Or use the shortcut key: SHIFT+F4
Notes
●

See Code Checker tab for more information about how to manipulate results in that tab.

See Also
Error Code List | Code Checker tab | Local Messages tab
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Error Code List

Error List Code
The commands and messages that are produced by the Code Checker after code has been verified
are listed here according to the following model:

Command to verify (defined in the Code Checker configuration tab):
in bold Message received: in italic (W= warning, E=Error) Explanation (if appropriate)
CREATE PROCEDURE
With recompile in create
(W10) Line 1 'With Recompile' option in procedure creation.
Parameter default value
(W169) Parameter %s not used.
(W170) Input parameter %s assignment before using it.
(W171) Input parameter %s assigned but not used.
(W172) Input parameter %s assignment.
(W173) Output parameter %s not assigned.
TRIGGER
Update test in trigger
(W31) 'Update' test instruction in trigger only for delete.
Set instruction in trigger
(W33) 'set' instruction.
SELECT
Into clause in select
(W96) 'Select Into' clause can be dangerous.
Holdlock in select
(W97) 'Holdlock' clause generates multiple locks.
Holdlock keeps the shared lock until the end of the transaction. It can be the source of
multiple locks, it can possibly lower performance, and multiply deadlocks.
Select *
(W96) 'Select Into' clause can be dangerous.
(W101) 'Select *' strongly depends on column order.
If the table definition changes (column order, column type, number of columns):
- as long as you do not recompile the stored procedure, the modifications will not be

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/.../SQLBLD/Features/Code_Checker/CC_3Commands.htm (1 of 5) [10/07/2008 10:36:42]

Error Code List

taken into account by the stored procedure, but you cannot be sure that the stored
procedure will never be recompiled.
- as soon as you recompile the stored procedure, the values returned to the user will
change: the client application will have to be modified even if the modification has no
effect on it.
Select with having/group by
(W76) 'HAVING' clause without 'GROUP BY' clause.
The 'having' clause is generally used as a restriction of the 'group by' clause. Results from
'having' without 'group by' can be confusing. The 'group by' might have been forgotten,
or the request should be written in a different way.
Select: order by clause
(W80) 'Order By' command without 'ASC' or 'DESC' clause.
Aggregates in select
(W99) 'Aggregate' command without any 'ALL' or 'DISTINCT' specified.
READTEXT
Using clause in readtext
(W88) 'Readtext' instruction without using clause.
(W89) 'Using Characters' or 'Using Chars' clause.
Holdlock in readtext
(W90) 'Holdlock' clause generates multiple locks.
Holdlock keeps the shared lock until the end of the transaction. It can be the source of
multiple locks, it can possibly lower performance, and multiply deadlocks.
CURSOR
Cursor use
(W71) Fetch without Into clause.
A fetch command without into clause is useless: a cursor is useful to access individual
rows of data returned by SQL Server, and so each row should be placed into a variable.
This way of programming can mean an error in the fetch statement, or a misuse of a
cursor (instead of a simple select).
(E190) Undeclared cursor.
A cursor is fetched or deallocated but it is not declared. Check it is normal.
(W191) This cursor is not freed (""deallocated"").
(W192) This cursor is already declared. You'd better use another name for this cursor.
(W193) This cursor is already deallocated.
(E194) This cursor is declared after its deallocation (line %d column %d).
(W195) No fetch command on this cursor. Verify it is normal.
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(W196) Fetch command should be called between declare and deallocate commands.
Declare cursor
(W41) Declare cursor statement should contain 'for read only' or 'for update'.
When the cursor mode is not specified ('for update' or 'for read-only'), it will be
determined by SQL Server. By default, a cursor defined without distinct, group by, union
and aggregate functions will be considered as updateable. Perhaps this was not your
intention. Moreover, it lowers performance.
(W42) For Update option in Declare Cursor command without updatable columns
specified.
The updated columns of an updateable cursor are not specified: there is an error in the
definition of the cursor or it is not been correctly understood; the consequences can be
the same as when the cursor mode is not specified (previous message).
Fetch
(W71) Fetch without Into clause. (See above)
EXECUTE
Execute without tested result
(W65) 'Execute' stored procedure without testing returned value.
It is necessary to test the returned value of a stored procedure (or at least to transmit it
to a calling procedure) for correct error handling. This is the only way to verify that no
error has occurred during execution.
Execute with a version number
(W66) 'Execute' a stored procedure with a version number.
Using procedures with version numbers makes code difficult to understand. Also, 'drop
procedure' will drop all versions at once.
Execute with a recompile
(W67) 'With recompile' option in 'Execute' command.
This option means that SQL Server never saves a plan for this procedure; a new plan is
created each time it is executed, and so one of the advantages of stored procedures is
lost. It is necessary to verify you really need this instruction.
(E178) 'Execute' command with option different from 'with recompile'.
The only option allowed in the EXECUTE command is WITH RECOMPILE.
Execute without parameter name
(W68) 'Execute' stored procedure with parameter supplied by position.
If the definition of the stored procedure is modified (parameter list or order of these
parameters), this execute command can become wrong.
VARIABLES / PARAMS
Variable declaration
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(W40) Local variable with global variable naming convention.
Users can sometimes imagine declaring a global variable in this way (which is
impossible). Moreover, it can make some T-SQL code much less clear.
(E179) Variable name too long.
A variable name is up to 30 or 128 characters (see identifier).
(E180) Variable already declared as a parameter.
(E181) Variable already declared line xxx.
(E184) Undeclared variable.
(W187) Re-declaration of a global variable.
You can declare a local variable with the same name as a global variable but this
definition is only valid for the current stored procedure, and you cannot assign a value to
such a variable: it has no interest and it can make some T-SQL code much less clear.
(E188) This global variable has already been used. You cannot re-declare it.
Parameter use
(W11) %s %s without default value.
(W170) Input parameter %s assignment before using it.
Meaningless parameter: it is used like a variable. Either you have to re-define it as a
variable, or this assignment was used during test and must be deleted for a normal use.
(W171) Input parameter %s assigned but not used.
The only use of the input parameter is an assignment: this parameter is useless or must
be output.
Variable use
(E179) Variable name too long.
A variable name is up to 30 or 128 characters (see identifier).
(E182) Variable used before its declaration line xxx.
(W185) Unused variable.
Unused variable: some code might have been forgotten.
(E186) Global variable cannot be updated (even if you re-define it).
Variable initialization
(E179) Variable name too long. (See above)
(W183) Variable not initialized before use.
Un-assigned variable.
OTHERS
Raiserror
(E84) 'Raiserror' with Microsoft SQL Server reserved error number (<50000).
The returned message will not be a user message, but instead will come from the SQL
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Server.
(E84) 'Raiserror' with Sybase reserved error number (<20000).
The returned message will not be a user message, but instead will come from the SQL
Server.
Truncate table
(W103) 'Truncate Table' is a dangerous instruction.
(W104) 'Truncate Table' is an unlogged action. Possible problems during next server
startup.
(W105) 'Truncate Table' cannot 'fire' a trigger. May corrupt referencial integrity.
Rollback trigger
(E95) Rollback Trigger outside of trigger.
A rollback trigger statement outside of a trigger is ignored by SQL Server and no error is
generated if it is used outside of a transaction. On the other hand (if it is used inside a
transaction) a SQL Server error is generated and the server rollbacks the transaction. It
should probably be replaced with Rollback Tran.
Return without value
(W92) 'Return' command without returned value.
A returned error code is necessary for correct error handling.
SARGS: Please click here for more information on SARGS
(W174) '%s' is NOT a SARG BUT its opposite (NOT ...) is a SARG.
(W175) '%s' is NOT a SARG.
(W176) this clause cannot be qualified: it contains either a SUB-QUERY involving nonconstant expressions, or a LIKE-term with an ESCAPE clause.
(W177) '%s' is NOT a SARG because it is only composed with constants (SQL Server will
make a table scan).
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SARG's Optimization
Search Arguments or SARGs are expressions in the WHERE and HAVING... clauses that can
potentially be resolved using an index.
SARG Format: <column> <operator> <constant>
where operator is one of =,>,<,>=,<=
An example of a SARG:

name ='Smith'
3000> salary
a = 1 AND c = 7
An example which is not a SARG:

salary = commission
delpt != 10
salary * 12 >= 30000
a = 1 or c = 7
A SARG can be part of a conjunction in which terms are linked with an AND clause.
SARG Equivalents: Certain SQL constructions are turned into SARGs by the optimizer:

BETWEEN is evaluated as >= and <=:
salary between 1000 and 1500
becomes
salary >= 1000 and salary <= 1500
LIKE is evaluated as > and <:
name like 'Sm%'
becomes
name >= 'Sm' and name <'Sn'
but like "%xxx" is not a SARG

salary > 3000*12
becomes
salary > 36000
As a result, it can be very useful to find "non-SARGs" so that you can try to turn them into
SARGs (some of them can easily be turned into SARGs: for example "col*2=12" is NOT a SARG
but it IS equivalent to col=6 that is a SARG).
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SARG's Optimization

Moreover, some "non-SARGs" have a negation form that is a SARG, thus it can also be useful
to detect them. When verifying your T-SQL code, you can ask for the detection of "non-SARGs"
by using the Code Checker. You can also ask directly for their detection with the Performance
Checker command.
See Also
Performance Checker
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Performance Checker
This command allows you to analyze a Stored Procedure, Function or Trigger without creating it
on server, so that you can detect "non-SARGs" (with the aim of optimizing your code).
Launching the Performance Checker
To access this command:
1. Open a Stored Procedure, Function or Trigger (click here for more information on how
to do this)
2. Click the appropriate object specific menu (either Stored Pr., Function or Trigger) and
from either menu select the Performance Checker command.
If any errors or warnings are detected, they are displayed in the Local Messages tab in the
Tools window.
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General Configuration
●

What are the General Configuration tabs?

●

Code Checker

●

Compiled Objects

●

Data-Session

●

Editor Font

●

Editor Options

●

Editor Shortcuts

●

File Extensions

●

General

●

Keys Mapping

●

Messages & Errors

●

OM (Object Manager) Options

●

OM (Object Manager) Colors

●

OM (Object Manager) Filter

●

SQL-Session

●

SQL-Session Display

●

Table Editor

●

Global Command tab
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What are the General Configuration tabs?

What are the General Configuration tabs?
The General Configuration tabs provide a wide range of options for configuring all aspects of the
application.
To access the General Configuration dialog box:
1. Click Options > General Configuration...
2. Select the appropriate tab
Notes
●

You can also access specific tabs directly. For example, when using the Table Editor, click
Options > Current Table Configuration to access the Table Editor tab. This item in the
Options menu will no longer be available when you close the Table Editor.
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Code Checker tab

Code Checker tab
Options > General Configuration > Code Checker

Code checking of SQL code
This tab contains a list of instruction check boxes - the use of which is commonly considered as
dangerous or critical in a particular context. This list enables you to freely set up and customize
the check process by checking the check box corresponding to an instruction you want the Code
Checker to check for. Every type of instruction is taken into account by SQL-Builder (Create
Procedure, Trigger, etc...) by default.
Click the '+' button next to an item to expand it, or click the '-' button to collapse it. If you only
want to check some of the instructions, do so manually, (checking the parent instruction will
check all the 'child instructions'), but if you want to check all the instructions, simply check the
All item at the top of the list.
SARGs optimization
You can also detect Non-SARGs when verifying the object. You can then modify your code (if
possible) so that these Non-SARGs no longer exist.
To enable the Code Checker to verify for Non-SARGs, check the SARG's instruction.
Instructions
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Create Procedure

Adds to the checked instruction list those instructions concerning
the creation of procedures (with recompile & default value
options).

Trigger

Adds to the checked instruction list those instructions concerning
the triggers (set & update instructions).

Select

Adds to the checked instruction list those instructions concerning
the SELECT instruction (such as: select *, holdlock, having/group
by, order by & into clause and aggregates).

ReadText

Adds to the checked instruction list those instructions concerning
the READTEXT instructions (Using & Holdlock).

Cursor

Adds to the checked instruction list those instructions concerning
the CURSOR instructions (declare, deallocate & fetch).

Execute

Adds to the checked instruction list those instructions concerning
the execute instruction (execute without tested result, without
parameter names, with a version number or a with recompile
option).

Variables/Params

Adds to the checked instruction list those instructions concerning
the variables and parameters (declaration, initialization & use).

Others

Adds to the checked instruction list other miscellaneous
instructions, such as raise error, return, truncate table, etc...

SARGs

If checked, detects the non-SARGs defined in your code. You
can find out more information about SARGs here.

See Also
Code Checker
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Compiled Objects tab

Compiled Objects tab
Options > General Configuration > Compiled Objects

Creation

Save File On Create

When you create a Stored Procedure or a Trigger and when
this option is checked, the current object is saved in a file after its
creation (when you ask for the current object creation and when
this creation is successful). When no file is associated with this
document, you will be asked for a filename. SQL-Builder will then
display the Save As dialog box.
Please note that if you are using this option when you are also
using SQL-Builder's integrated Source Manager (see here) you
may receive a message in the Messages and Errors List as
follows:
"The file E:\TEMP\PROCEDURE_NAME.PRO is not a valid source
object file"
This occurs when you open the object file after the object has
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Compiled Objects tab

been checked out with the Source Manager. It is caused by a loss
of VSS header file information for the object that has been saved
to file.
Code checking on create

When you create a Stored Procedure or a Trigger and when
this option is checked, the current object is verified first of all. If
no syntax error is detected, SQL-Builder analyzes your
procedure/trigger. You can configure this verification in the Code
Checker tab, which is explained here.

Saving

Header used on Unix

If you select this option, SQL-Builder will add characters in front
of some fields so that the WHAT command under UNIX recognizes
them:

For example:

CREATE PROC dbo.procname(
@col1 int
)
AS
Begin
/**********************************************************
*@(#)Procedure Name: procname
*@(#)Database: pubs2
*@(#)Server: SOL_SYB102
*CAST SQL-Builder R3.8
*
*@(#)Business Function : BF
*Author BF: SVA
Date BF: 30/03/95
*@(#)
*Author: SVA
Date: 10/01/95
* Comment: creation
*File Path:
*
f:/filen.pro
*********************************************************/
....
"what filen.pro": (under UNIX environment)
Procedure Name: procname
Database: pubs2
Server: SOL_SYB102
Business Function : BF
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Save database in file

When this option is checked, the database is saved in the file
(use DB) when saving the current object into a file (Save File
command or Object Creation and Save file on create option is
checked).

For example:

Use pubs2
Go
If Exists(Select name
From sysobjects
Where name='procname'
And type='P')
Drop Procedure procname
Go
CREATE PROC procname
AS
.....

Save owner in file

Unix style line endings

When this option is selected, the owner name will be saved in
the file when saving the current object into a file (Save File
command). Valid for Stored Procedures, Triggers, Views and
Functions. This option can also be turned off permanently via the
SQLBUILD.INI file.
When this option is selected, all scripts of saved objects (when
you use the Save or Save As options in an Object Editor or when
you check-in an object using the Source Manager Interface) are
saved in Unix format.
This option is only available for objects that can be saved in a
source manager, i.e.: Functions, Stored Procedures, Triggers and
Views.

Comments
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BF is required

If you check this option, SQL-Builder will prompt you with a small
warning dialog box that no Business Function has been defined
for the current object when you try to save the object on the
server.
You will NOT be able to send the object to the server until you
define a Business Function in the Comments tab of the
corresponding Object Editor.
Notes
●

Maintenance is required

SQL-Builder will automatically display the relevant
Comments tab when you click the OK button in the
warning dialog box.

If you check this option, SQL-Builder will prompt you with a small
warning dialog box that no Maintenance Comment has been
defined for the current object when you try to save the object on
the server.
You will NOT be able to send the object to the server until you
define a Maintenance Comment in the Comments tab of the
corresponding Object Editor.
Notes
●

SQL-Builder will automatically display the relevant
Comments tab when you click the OK button in the
warning dialog box.

Opening
Header detection

When this option is checked, SQL-Builder sends a message
when a Stored Procedure or Trigger is being opened and the
header comment is not found or the header is being modified (for
example, the database or the name of the server are not the
same...). This option is saved in the configuration file
SQLBUILD.INI when exiting SQL-Builder.

Show BF on Open

When this option is checked, the possible Business Function is
shown in a message box when opening the current object (from a
file or from Object Manager).

See Also
Stored Procedure Editor | Trigger Editor | Function Editor
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Data-Session tab

Data-Session tab
Options > General Configuration > Data-Session

General
Total lines collected

This number represents the maximum number of total rows
collected from the server in the Data-Session. By default, this
value is 1,000. The maximum that can be collected and
displayed is 999,999.
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Show types in headers

Select this option if you want to view the column type as well as
its name in the Data-Session. If selected, the Data-Session will
display a column heading as follows:
Phone, char(12)
if not selected:
Phone
Notes
●

Safe Mode

You can also select this option from the View menu when
the Data-Session is active. Click here for more information.

The Safe Mode option forces SQL-Builder to display a warning
message before any changes are made to data in the DataSession.
The message that is displayed is:
"Are you sure you want to modify this table on the server?"
Then click OK or Cancel as necessary.
Notes
●

●

If you continue to edit data in the same table (i.e. you
don't close the Data-Session) then the message will not be
displayed again.
If you close the Data-Session or SQL-Builder, then the
message is re-displayed for all tables.

Tags
FUNCTION tag

By default, SQL-Builder considers all information added to a cell
in a Data-Session as SQL text. Thus if you input "getdate" for
example in a cell, this will be interpreted by the Data-Session as
a piece of text and NOT as the SQL function "getdate" that
returns a date.
So, in order to allow the use of SQL functions within the DataSession, you can use the #Fct: tag before the name of the
function.
Use this option in this configuration tab to personalize the
information. Thus entering #Fct:getdate into the text box will
print #Fct:getdate in an empty Data-Session cell when you use
the F6 shortcut.
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NULL tag

This tag is a text item that represents special SQL values that can
sometimes be confused with various text values. In order to limit
this confusion, tags enable you to use special (i.e: not normally
used) text to represent these special values.
By default "# NULL #" represents a NULL value. You can change
this to meet your requirements if you want.

EMPTY STRING tag

This option functions in the same way as the above NULL Tag.
By default "# EMPTY STRING #" represents an empty string.

See Also
Table Editor tab | Data-Session | Table Editor | View Editor
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Editor Font tab

Editor Font tab
Options > General Configuration > Editor Font

The Editor Font Tab governs how text is displayed in the Object Editors and the SQL-Session.
Main
Font

Select the font type you require for the Editor from the Font List.
You can preview what the font looks like in the Sample section at
the bottom of the tab.

Font Style

Select the font style you require for the Editor from the Font Style
List. You can preview what the font style looks like in the Sample
section at the bottom of the tab.

Size

Select the font size you require for the Editor from the Size List.
You can preview what the font size looks like in the Sample
section at the bottom of the tab.

Only Fixed Pitch Fonts

Select this check box if you only want to choose from Fixed Pitch
Fonts. The Font List will reflect this selection.
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Editor Font tab

Only True Type Fonts

Select this check box if you only want to choose from True Type
Fonts. The Font List will reflect this selection.

Effect
Underline

Select this option if you want to display underlined text in the
Editor.

Strike Out

Select this option if you want to display text that is stuck out in
the Editor.

Normal Text Color
Foreground

Select the normal text color from the Foreground List. This color
can then be previewed in the uppermost Sample section.

Background

Select the normal text color from the Background List. This color
can then be previewed in the uppermost Sample section.

Selected Text Color
Foreground

Select the selected text color from the Foreground List. This color
can then be previewed in the lower Sample section.

Background

Select the selected text color from the Background List. This color
can then be previewed in the lower Sample section.

See Also
Editor Options tab | Editor Shortcut tab | Object Editors | SQL-Session
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Editor Options tab

Editor Options tab
Options > General Configuration > Editor Options

The Editor Options Tab governs how the information is displayed in the Object Editors and the
SQL-Session.
Keyword preprocessor
No Conversion

All keywords are left 'as is'.

Change to Uppercase

All keywords are converted into uppercase as soon as they are
recognized.

Change to Lowercase

All keywords are converted into lowercase as soon as they are
recognized.

Change to Lowercase
with first letter
Uppercase

All keywords are converted into lowercase with the initial letter in
uppercase.
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Editor Options tab

Word Completion

When checked, the Word Completion feature will become active.
Click here for more details.

Block collapsing mode

This option (when selected) activates the block collapsing mode
in the Object Editors (not available for the SQL-Session).
Activating the Block collapsing mode adds + and - icons to the
margin of the script editor for each block. These can be expanded
and collapsed as required.
An example of this can be seen below:

Notes
●

●

●

This option is linked to the Flow Chart - this means that
the Flow Chart must be functioning correctly in order for
the Block Collapsing mode to also function correctly
(syntax errors in the script can sometimes cause the Flow
Chart not to function).
You can also use the CTRL+"+" and CTRL+"-" shortcut
keys to expand and/or collapse a block. The cursor MUST
be located on the same line as the + or - icon.
You can also expand and collapse code blocks using the
right click shortcut menu and selecting Expand bloc and/or
Collapse block. In this case, you can right click anywhere
in the editor.

Miscellaneous
Margin mode

Check this box to activate the Margin mode. A margin will then
appear in all Editor windows and in the Messages and Errors List.

Margin background
color

You can select a color for the margin from the drop down options
box. Many colors are available, enabling you to customize your
editors.
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Editor Options tab

Bookmark color

This option enables you to select a color for the bookmark which
will appear in the margin.

Drag and drop editing

You can check this option to allow drag and drop editing in your
Editor windows.

Tab settings
Tab Size

Indicates the width, in terms of the number of spaces, of tab
stops.

Convert Tabs to Spaces

When checked, all Tab characters are immediately converted into
spaces.

Convert Leading Spaces
into Tabs

When retrieving Editor text, this option will change leading space
into tabs and then (if necessary) into spaces to reduce text size
and avoid indent problems when mixing tabs and spaces with
different tab stop values.

Remove Trailing Spaces
when saving

When retrieving editor text, this option will optimize the text size
by removing unnecessary spaces at the end of lines.

Syntax coloring
This section enables you to choose the colors used to highlight keywords for each category of
SQL. Select an SQL keyword from the list, and then select a color in the combo box. The Sample
section will then display what this will look like in the editor.
See Also
Editor Font tab | Editor Shortcut tab | Object Editors | SQL-Session
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Editor Shortcut tab

Editor Shortcut tab
Options > General Configuration > Editor Shortcuts

The Editor Shortcut feature enables you to define various keyword shortcuts for your editors.
How does it work?
If you often enter a particular word when editing your SQL objects or scripts, you can define a
shortcut for it in this configuration tab.
For example, if you often use the word select, to save time when editing you can create a
shortcut (e.g.: se) for it. When you next use your editor (either the Object Editors or the SQLSession) typing se, then pressing the spacebar will cause the defined alias to replace these two
letters.
If you find that you need to actually include the shortcut as a word, then type it, press the
spacebar (which will cause the alias to be included), then use the Undo function (CTRL+Z) to
replace the alias.
Creating shortcuts
1. In the uppermost section, type the shortcut, then in the adjacent text box, type the alias
you want to replace it with.
2. Click Set to add the new shortcut to the list below.
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Editor Shortcut tab

3. When you are satisfied with your selections, click OK to apply the shortcut to all editors.
A .TXT (ed_short.txt) file will also be created in the same directory as your main product files,
which will store the relevant shortcuts (one line per shortcut).
Removing shortcuts
1. If you decide you no longer want to use a certain shortcut, re-open this tab and select the
shortcut from the list.
2. Click Delete to remove it and OK to reapply the settings.
Enable shortcuts
By default this checkbox will be selected. It enables you to disable/enable all shortcuts if you
require.
See Also
Editor Options tab | Editor Font tab | Object Editors | SQL-Session
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File Extension tab

File Extension tab
Options > General Configuration > File Extensions

* This is an example of a configuration tab from an Oracle version of SQL-Builder
File Extensions

This configuration tab contains a list of all the file extensions used
by SQL-Builder and enables you to customize them. For
instance, should you want to change the default extension name
for .LOG files, then left click once in the right hand column that
contains the *.LOG entry, and type in the new extension.
Click the OK button once you are satisfied with any changes you
have made. Cancel will close the configuration tab and leave the
list of file extensions unchanged.
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General tab

General tab
Options > General Configuration > General

General
External Editor

This option enables you to specify the path and the name of the external
editor used by SQL-Builder. By default, it is set to "notepad.exe".
This editor is used to edit an SQL-Script, to edit a generic script for a
Stored Procedure or a Trigger, or to edit a User Template.
Use the Browse button to browse the executable files if you want to
change the External Editor.
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General tab

Default T-SQL
Release

This combo box allows you to select the type of T-SQL grammar that will
be used in SQL-Builder.
Click the down arrow and select the Microsoft SQL-Server/Sybase release
which conforms to the type you are using. This option is used when there
is no connection to a server (i.e. if you are opening an object from file).

Default 'QUOTED
IDENTIFIER'
value is 'ON'

This option defines the value for Quoted Identifier support. If selected, the
default value is ON, if unselected it is OFF.
A third state exists (check mark with grayed out background) and this
value depends on the server version selected in the Default T-SQL
Release option (ON for Microsoft SQL-Server 2000 and above, OFF in all
other cases).
This option is used when there is no connection to a server (i.e. if you are
opening an object from file).

Add Privileges in
Script
Get Privileges
into a separate
file

When this option is selected, scripts can have privileges.
This option is to be used in conjunction with the Source Manager
Interface. When this option is selected:
●

●

Persistent
panels

when an object is read, SQL-Builder will get the latest version of
the file "privilege.prv" if this file has not already been checked-out
by a user. Privileges are thus read from this file.
when an object is saved, SQL-Builder will check out the file
"privilege.prv" if this file has already not been checked-out by a
user. Privileges are then written to this file and then the file is
checked in.

Selecting this option will cause panels to be persistent between sessions.
For example, items added to the User List will be present in your next
SQL-Builder session.

Always use
'Drop' and
'Create'
statement

Select this option to force SQL-Builder to always use a DROP and CREATE
statement (instead of an ALTER statement) when sending objects to the
server.

Generate Ansi
mode auto-joins
in Query
Assistant

When this option is checked, the Query Assistant generates its auto-joins
(joins using foreign keys defined on used tables ) in Ansi Mode. These
auto-joins are then defined as "Inner Joins" (when used SQL-server
allowed such joins).

This will modify the object's creation date, which is NOT changed when
an ALTER statement is used.
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General tab

Ask parameter
value when
executing
procedures

When this option is activated a Parameter Input dialog box will be
displayed when you:
●

●

Drag and drop a Stored Procedure from the Object Manager to the
SQL-Session or a Stored Procedure Editor
Use the Execute Current Procedure option in a Stored Procedure
Editor

●

Use the Execute Command option in a Stored Procedure Editor

●

Use the Execute Command option in an SQL-Session

This dialog box enables you to enter any required parameters in the code
of your Stored Procedure. Enter the parameters in the Value column and
click OK to continue. Your values will be transferred into the code. See
also Parameter Input dialog box.
When not activated, this dialog box will NOT be displayed and you will
need to enter your parameters manually in the code.
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General tab

Line counter in
code editor start
from 1

When activated, line one of code displayed in the Editor tab of any Object
Editor will be considered as line one and displayed as so in the bottom
right hand corner of the SQL-Builder window. In other words, header code
lines are not included in the count.
When deactivated, line one of code displayed in the Editor tab of any
Object Editor will be considered as line X+1, where X = the number of
lines in the header. In other words, header code lines are included in the
count.
For example, this code is displayed in the Editor tab of an Object Editor:

When activated and cursor is placed before "AS", SQL Builder displays:

When deactivated and cursor is placed before "AS", SQL Builder
displays:

...because the header contains five lines of code.
Source Manager options
(See here for more information about the Source Manager)

Create Object On
Database when
checking-in

When this option is selected, the current object will be created (if
it has been modified) on the server before a check-in of this
object into an archive is carried out.
Moreover, this check-in will only be carried out if the creation of
the object on the server is successful.
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General tab

Double-click on a
Source Manager Object

Use this option to determine what will happen when you double
click a Source Manager object in the Object Manager. Choose
from:
●

Check Out

●

Check Out and Open

●

Get

●

Get and Open

●

Open
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Keys mapping tab

Keys mapping tab
Options > General Configuration > Keys Mapping

Server Name

Use this field to define the name of the server on which the
character map will be used.

File Name

This combo-box displays the path and name of the binary file in
which the character map is saved. You can modify the file name if
you wish.
Once the file name has been chosen, the character map will be
saved into the file when you click OK. If you do not specify a
name, SQL-Builder will save the character map in a default file:
sqlmap.cw. SQL-Builder saves this file in the SQL-Builder
directory if possible. If not, it will be saved in a Windows
directory.

Server character map
area

In this section of the dialog box, you will see the character map
which is used by the selected server or the character map that
was defined previously.
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Keys mapping tab
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Messages & Errors tab

Messages & Errors tab
Options > General Configuration > Messages & Errors

This tab enables you to configure various options for the errors and messages that are saved to
an external file. These messages are also displayed in the Messages and Errors List.
Main Log File Name
Log root directory

This field displays the directory in which the application specific
log file will be stored - by default this is set to your TEMP or TMP
environment variable, with the addition of:
CAST\CAST\<version_number>
If you change this location, please make sure that the target
directory already exists. If it does not, the application will save a
temporary .TXT log file to:
%TEMP%\CAST\CAST\<version_number>\logs
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Messages & Errors tab

Log main file name

This field displays the name of the log file. By default, this will be
"<application_name>" with the .castlog extension.
You can choose a different file name should you require - click
the Browse button and a standard Windows Open dialog box will
be displayed enabling you to choose the new file.
This log file will contain information in the same formatted style
as displayed in the Messages and Errors List.

Log Options
Truncate file

When checked, this command empties the log file when the
product is executed.

Notes
●

This tab configures the settings for the .castlog file. Log information is also displayed in
the Log Window - see Messages and Errors List for more information.

See Also
Messages and Errors List

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Config/msgerr.htm (2 of 2) [10/07/2008 10:37:24]

Object Manager Options tab

Object Manager Options tab
Options > General Configuration > OM Options

Knowledge Base
Use Knowledge Base
info

When this option is checked, information displayed in the right
hand section of the Object Manager is taken from the CAST
Knowledge Base (objects must have already been synchronized in
the Knowledge Base).
The color of the associated icon explains the object's Knowledge
Base status:
●

Green = Validated

●

Orange = Developed

●

Gray = Read Only

The owner displayed here is also the owner defined in the CAST
Knowledge Base.
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Object Manager Options tab

GOM Option
Call Enlighten when
possible

Select this option if you want to launch CAST's viewer module
instead of the Graphical Object Manager for databases already
registered and synchronized in the Knowledge Base.
When you click the Graphical Object Manager button located in
the Object Manager, CAST's viewer module will be automatically
launched (when possible) and the selected object(s) added to the
Graphical View. You can then carry out any of the CAST viewer
features.
Notes
●

Add Linked Objects

Please note that you must have already used CAST's
viewer module at least once before selecting this option. If
you have not, SQL-Builder will not be able to open it.

When this option is selected, the Add Linked Objects option is
automatically activated when the Graphical Object Manager is
opened.
The Add Linked Objects option will automatically launch the
Add linked Objects dialog box and find all objects linked to the
selected objects on the server or instance. When unchecked, the
object is placed in the Graphical Object Manager on its own.

User preference
Manual list update

When you check this option, the Object Manager will load the
server objects at the beginning of the SQL-Builder session and
will not connect to the server again to load objects (this applies
to the current connection).

Minimal Preload

Select this option if you have a large number of databases on
your server. Checking the option will optimize the performance of
the Object Manager by forcing database information to be loaded
when the database is accessed and not when the connection to
the server is established.
If the option is not selected (default behavior), all information is
loaded when the connection to the server is established.

Options
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Object Manager Options tab

Hide tempdb database

If you check this option, the tempdb database (which is an MS
SQL-Server/Sybase system database) no longer be visible in the
Object Manager. This option allows DBAs for example to view
the tempdb database if necessary, but also helps free up the
Object Manager for ordinary users.

Hide system databases

If you check this option, any system databases will no longer be
visible in the Object Manager. This option allows DBAs for
example to view the system databases if necessary, but also
helps free up the Object Manager for ordinary users.

Hide system objects

By checking this option, any system objects will no longer be
visible in the Object Manager. This option allows DBAs for
example to view the system objects if necessary, but also helps
free up the Object Manager for ordinary users.

Table size calculation
Ignored

When this option is checked, the Object Manager does not
compute the number of table rows.

Fast (estimated from
indexes)

When you select this option, the number of table rows is
estimated from the SYSINDEXES system table. This renders the
calculation time much quicker.
In this mode, the number of view rows is not calculated.

Actual (Table Scan)

When this option is checked, the Object Manager computes the
number of table rows using the SQL order count(*).

Dependencies in popup menu
Select this option if you want to stop SQL-Builder automatically computing a selected object's
dependencies. You can view an object's dependencies from the Object Manager by right clicking
an object and then selecting Dependencies from the shortcut menu (see here for more
information).
If your server contains a large number of objects, the processing time needed to complete this
operation can be significant.
Columns
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Object Manager Options tab

The two sections entitled Displayed and Hidden enable you to select which columns will be
displayed in the correct sections of the Object Manager. In the left hand Displayed column, all
the headings present will be visible in the right hand section of the Object Manager and all those
in the right hand Hidden column will be removed from the right hand section of the Object
Manager.
button, the
To hide a column select it in the left hand Displayed column and click the
selected heading will now appear in the Hidden column on the right hand side. In addition, the
Object Manager will automatically update itself when you click the OK button at the bottom of
the General Configuration dialog box.
Similarly, to display a column, select it in the right hand Hidden column and click the
button, the selected heading will now appear in the Displayed column on the left hand side. As
above, the Object Manager will automatically update itself when you click the OK button at the
bottom of the General Configuration dialog box.
You can also use the Drag and Drop function to move headings from the Displayed column to
the Hidden column and vice-versa. To do this left click on a heading you want to move, hold
down the mouse button and then drag it to the other column. Simply release the mouse button
to drop the heading where you require.
You can also use the Drag and Drop function to re-order the headings in the Displayed
column. This is because the order in which the headings appear in the Displayed column is the
order in which they appear in the right hand section of the Object Manager.
See Also
Object Manager Filter tab | Object Manager Colors tab
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Object Manager Colors tab

Object Manager Colors tab
Options > General Configuration > OM Colors

The OM Colors tab enables you to change the color of items in the right-hand list of the Object
Manager so that you can differentiate between Non-Captured and Captured procedures. Click an
arrow in the appropriate combo-box and select a color from the drop down list.
The different colors will appear in the Captured column in the right hand section of the Object
Manager when you are using the Two Pane display mode. You can determine whether you want
the Captured column to be displayed by using the Displayed and Hidden columns option at
the bottom of the OM Options tab.
See Also
Object Manager Options tab | Object Manager Filter tab | Capturing parameters

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Config/omcol.htm [10/07/2008 10:37:28]

Object Manager Filter tab

Object Manager Filter tab
Options > General Configuration > OM Filter

The OM Filter Tab enables you to create a filter for the type of objects you want to display in
the Object Manager.
Using the OM Filter tab
At the top of the tab you will see the heading Server Name together with a combo-box. This is
the server on which you will create your filter, thus select the server you want to filter by clicking
on the arrow and selecting from the list. Then check the box Use Filter. This will then "activate"
the Filter section immediately below.
You now need to move on and define the filter parameters in the Filter section. On the left hand
side you will see the heading Object type and underneath a list of the various SQL object
types. First left click on the object type on which you want to perform a filter, the object type
will then be highlighted as shown in the above image.
Filter options
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Object Manager Filter tab

Created between

This option will display in the Object Manager all objects that
were created between two defined dates (and will include any
objects created on the dates entered).
Select the corresponding check box to activate the option, then
either manually enter the dates by clicking in the date combo
boxes and entering the dates from the keyboard, or left click on
the arrow in the combo box to open the calendar shown on the
right. You can then navigate around the calendar using the arrow
buttons and click on a date to enter it in the combo box.

Modified between

This option, similar to the above Created between option, will
display in the Object Manager all objects that were modified
between two defined dates (and will include any objects modified
on the dates entered). The option works in exactly the same way
as the above Created between option.

Name starts with

This option enables you to enter a string of characters and only
objects corresponding to the string will be displayed in the Object
Manager. Select the corresponding check box to activate the
option, then manually enter the character string that you require.

Owner name starts with

This option enables you to enter a string of characters and only
objects whose owner name corresponds to the string will be
displayed in the Object Manager. Select the corresponding check
box to activate the option, then manually enter the character
string that you require.

Knowledge Base section
Permanent Lock by

This option forces SQL-Builder to only display those options that
have been locked by a certain user.
Select the option then enter a user name in the text box.

Flagged

Selecting this option will display only those objects that have
been flagged.

More information
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Object Manager Filter tab

The above filter criteria are all linked by the keyword AND. Thus, for example, you can display all
the objects created between two dates AND modified between two dates AND beginning with a
certain character string AND Owner starts with AND locked by AND flagged by.
When you click the OK button at the bottom of the tab, the Object Manager will be
automatically updated to reflect the filter parameters that you entered.
You can define a filter for each object type, or if you want to define the same filter options on
all the object types, select ALL the objects in the Object Type box. To do this, left click on
the uppermost object type to highlight it, then hold down the SHIFT key and then click the
lower object type. They will all be highlighted as shown on the left and the filter parameters you
then define will apply to all the object types.
You can also select some (not all) of the object types by selecting an object type, holding down
the CTRL key and then clicking the object types you require. Those you click will be highlighted
and the filter parameters you define will apply to the selected Object Types.
You can easily turn off a filter if you want to display all the objects in the Object Manager, by
clearing the Use Filter option at the top of the dialog box. The Object Manager will
automatically reflect this by restoring all the objects.
Alternatively you can use the

button located on the Toolbar. This acts as an on/off toggle,

activating or deactivating the filters defined in this dialog box.
Notes
●

Filters are always automatically saved when you exit the Object Manager by clicking the
OK button. The Cancel button will close the dialog box and abort any changes you may
have made.
When the configuration tab closes (after you click the OK button), the character
combination (f) will appear next to the server name on which the Filter is defined, to
indicate that a Filter is in use.

See Also
Object Manager Options tab | Object Manager Colors tab
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SQL-Session tab

SQL-Session tab
Options > General Configuration > SQL-Session

Notes
●

This tab differs depending on where it is launched from. If you are configuring the SQLSession and you clicked the Options > Current SQL-Session Configuration option,
then the this tab will differ slightly. The Debugger section will be replaced by the Server
section, which is described below.

Debugger
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SQL-Session tab

Full @@nestlevel
handling

The debugger is designed so that instructions are sent to the SQL
Server using a single connection. Contrary to the context of a
true stored procedure execution, their nesting level is such that
@@nestlevel always equals 0. Consequently, when executing an
EXECUTE instruction with the Debug/Step command, the called
procedure's @@nestlevel value will be 1 when it should really be
2.
The debugging of certain Stored Procedures may require that
@@nestlevel keeps its true value during the execution of a
Stored Procedure on the SQL Server. Therefore the SQL-Builder
Debugger has a complete @@nestlevel on-request management
function.
Enabling Full @@nestlevel handling guarantees this management
for the execution of Stored Procedures. Each EXECUTE instruction
will be transmitted to the SQL Server and included in the T-SQL
code so that @@nestlevel will have its true value in the executed
Stored Procedure.

Step Into MS Shipped
Products

This option (when selected), enables you to authorise the
debugger to Step Into a System or Master (or any other system
database) Stored Procedure.
If you leave the option blank, the debugger will carry out a Step
rather than a Step Into.

Procedure
Interpretation

Determines whether the debugger automatically steps into each
called procedure rather than sending EXECUTE instructions to the
SQL Server.
Three different options exist:
1. Never: The debugger always sends EXECUTE instructions
to the SQL Server (unless the procedure call involves at
least 1 cursor variable or parameter, in which case
procedure interpretation is mandatory),
2. When Necessary: Sometimes the debugger sends
EXECUTE instructions to the SQL Server. Interpretation is
transparent and is performed when either
❍

❍

❍

at least 1 cursor is to be dynamically renamed by
the debugger
when a trigger is opened (to handle "ROLLBACK
TRIGGER" T-SQL instruction and allow correct
management of triggers' self recursion)
when T-SQL code being debugged involves cursor
variables or parameters (available on MS SQL
Server 2000 and above)

3. Always: The debugger always steps into called procedures
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and never sends EXECUTE instructions to the SQL Server.
When breakpoints are set inside called procedures, interpretation
is mandatory to detect those breakpoints. To allow this detection,
the default value for procedure interpretation is Always. The
When necessary option does not take into account the
existence of breakpoints inside nested procedures. However,
procedure interpretation is slower than normal execution, so
depending on your needs, you may have to change this option to
obtain the best execution time during debugging if you do not use
breakpoints inside nested procedures.
This option does not concern triggers, which are never
interpreted, except if you manually use the Step Into command
to debug them.
If an error occurs during the interpretation of a procedure, the
debugger goes to the location of the error. In this case, the error
is loaded in the debugging window and the location is highlighted.
The Call Stack and Variables windows are also updated. In the
same way, if a Breakpoint is found during a nested procedure
interpretation, a message box will indicate this and the debugger
goes directly to the Breakpoint location inside the called
procedure.
Misc
SQL-Session Light

Selecting this option can make the SQL-Session quicker to open
and more responsive (uses less resources).
Please be aware however, that certain options may not be
available. In addition, when working with a Knowledge Base, no
check is made to ensure that the locks placed on objects are upto-date.
You can open as many light SQL-Sessions as you want, and at
the same time as you open default SQL-Sessions.

Check Syntax

This parameter corresponds to the Check Syntax command
located in the TSql menu.

Stat/Plan messages in
file

The results of a Show Plan or Show Statistics will be sent
directly to a file if you check this option.

Full Results History (and
Results History Length)

When selected (default mode), all results of each query sent to
the server during the current session are logged. If not selected,
you can specify the number of queries and have only their results
stored in the history file (as defined in the Results History
Length option immediately below). Queries themselves are
always stored in the history file.
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Scripts and Test files
Confirm before run SQLScript

This parameter, if checked, forces the commands Run SQL-Script
or Run T-SQL Meta Batch to ask for confirmation before loading
the given batch.

Confirm before run
Tests

This parameter, if checked, forces the command Open SQLSession to ask for confirmation before starting the given SQLSession.

Step by Step

This parameter, if checked, forces SQL-Builder to pause
between each SQL-Script or test command, allowing you to
abort the SQL-Session or the SQL-Script at any time.

Abort SQL-Scripts on
error

This parameter, if checked, forces SQL-Builder to abort any SQLScript that produces an error.

Play SQL-Script without
any result and historical
record - FAST MODE.

When this parameter is checked, future SQL-Script files loaded
(Run SQL-Script command) will be run automatically in FAST
MODE: no historical record is carried out and no result will be
displayed. Moreover, no update is carried out in the CAST
Knowledge Base. This presumes that the possible updates have
already been carried out in the SQL-Script file or that no object
is created or modified in this SQL-Script file.

Server
No exec.

This parameter, if checked, sends the command "set noexec on"
to the current DbProcess. Please refer to your SQL Server
documentation for more details.
You can also click the Options menu and then select the
NoExec/ShowPlan option from the drop down menu which will
check this option in the above dialog box.
In addition, you can click the

button located on the toolbar

which will check this option in the above dialog box.
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Show Plan

If you are using Microsoft SQL-Server 2000 or above, the
command sent will be "set showplan_text on". Please refer to
your SQL-Server documentation for more details.
If the option Stat/Plan messages in file in the unnamed
section of this dialog box is checked, the messages of the Show
Plan will be directly sent to a file.
You can also click the Options menu and then select the
NoExec/ShowPlan option from the drop down menu which will
check this option in the above dialog box.
In addition, you can click the

button located on the toolbar

which will check this option in the above dialog box.
Show Statistics

This parameter, if checked, sends the command "set statistics
io, time on" to the current DbProcess. Please refer to your SQL
Server documentation for more details. If the option Stat/Plan
messages in file in the unnamed section of this dialog box is
checked, the results of the Show Plan will be directly sent to a
file.

Notes
●

You can manually set the above three Server options by entering the corresponding
command in the SQL-Session and then sending it to the server.
Please note however, that if you do this, SQL-Builder cannot take these options into
account if you change the database on which you are working. For this reason, it is
recommended to set these options using this configuration tab or the toolbar icon,
explained here.

See Also
SQL-Session | SQL-Session Display tab
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SQL-Session Display tab
Options > General Configuration > SQL-Session Display

Editor
Scroll Bar in input part

When this option is selected, a scroll bar is displayed in the Input
Section (also known as the Query Editor).

Scroll Bar in results part

When this option is checked, a scroll bar is displayed in the Result
Section.

Scroll Bar in Test Session
part

When this option is checked, a scroll bar is displayed in the Test Section.

Display after query
Beginning of Query

This option places the cursor at the beginning of the query in the Result
Section when using the Text Format tab after the query has been sent to
the server.
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Beginning of Results

Check this option to place the cursor at the beginning of the results in
the Result Section when using the Text Format tab after the query has
been sent to the server.

End of Results

Check this option to place the cursor at the end of the results in the
Result Section when using the Text Format tab after the query has been
sent to the server.

Text Output
Detailed
Output

Please click here for more information about and examples of the Detailed Output mode.

Show only
last result

When this option is checked, the results displayed in the Result Section of the SQLSession correspond to the last query sent to the server only. When unchecked, ALL
results are displayed. Please note that editors have a limited capacity.

Output to
File

This command enables you to redirect output from the SQL-Session to a given file
instead of to the Result Section.
You will be prompted for a file name each time you send a command to the server.
These output files can be read with an ordinary text editor or a spreadsheet.

Include
Messages

When this option is selected, the results displayed in the Result Section (Text Format)
will include the following style of messages underneath the main code.

print 1
go
--------------------------------------------------[Microsoft][ODBC SQL Server Driver][SQL Server]1

Unformatted When this option is selected, the output of the DBMS_OUTPUT.PUT_LINE command
output
displayed in the Result Section (Text Format) will not include any separators nor
(Oracle
headings. When this option is not selected (default mode), the result of the command :
version
only)
DBMS_OUTPUT.PUT_LINE('REM Sample Script');
DBMS_OUTPUT.PUT_LINE('SELECT TO_CHAR(sysdate,''DD-MON-YYYY'') FROM DUAL;');
will be displayed formatted as follows:

Info Lines : REM Sample Script
--------------------------------------------------Info Lines : SELECT TO_CHAR(sysdate,'DD-MON-YYYY') FROM DUAL;
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Header
Occurrence

This integer value represents the number of rows that will be displayed without header
repetition when the results are displayed. If you enter 0 the column header will be
displayed only once at the beginning. If you enter 10 for example, the column header
will be displayed every 10 rows.
You can set up values from 0 to 2000. The default value is 0.

General Output
Preferred display

This option enables you to select the type of output display (Text Format
or Grid Format) that you want to be effective when you launch a new
SQL-Session.

Show types in headers

Select this option if you want to see types in the headers of the columns
displayed in the SQL-Session.

Display dates in local
format (input date still in
database format)

This option governs the display format for dates in the SQL-Session (and
all features that inherit directly from the current SQL-Session such as
the Debugger, Test Session and other SQL-Sessions):
●

●

Max rows

When this option is unselected, date input is made in the default
format of the database you are working on and dates are
displayed in the SQL-Session using CAST's own format
(month/day/year)
When this option is selected, date input is made in the default
format of the database you are working on and dates are
displayed in the SQL-Session using the format configured in
Windows (Regional Settings) on the client workstation.

This integer is the number of displayed SQL lines in the Result Section of
the SQL-Session window. By default, this value is 100, the maximum
is 999,999. A SQL line is a line returned by the server and differs slightly
to an editor line because a line returned by the server can include
carriage returns (and so will be displayed in multiple lines in the Query
Editor).

See Also
SQL-Session | SQL-Session tab
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Table Editor tab
Options > General Configuration > Table Editor

This tab enables you to set various options to govern the behavior of the Table Editor.
General Options
Generate table script
after each alter table
order

This option lets you automatically regenerate the script after each
Alter table order carried out on a table. This option is checked
by default in order to minimize the execution time and the time
taken to retrieve the data from the Table Editor.

Always added null
columns

When this option is selected, the NULL option of columns that are
added to a Table with the

button will automatically be

selected.
When this option is left blank, the NULL option of columns added
to Tables will also be left blank.
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Manage named default
constraints

When the option is activated , it is possible to read, modify and
create named default value constraints. External defaults
(sp_bindefault) are, however, excluded. This feature is
implemented only on SQL Server, version 7 and above.
●

●

●

When activated: the default column in the column editor
grid can no longer be modified.
The constraint editor offers a new tab called "Col default".
The default constraints appear in the Keys\Constraints
page.

Constraints are now inputted in the new tab and no longer in the
column editor grid. This tab automatically displays a list of the
candidate columns. This list only displays:
●

●

during creation, the columns with no default value
during modification, the column referenced by the
constraint

Execution Statement

This section governs the behavior of SQL-Builder when you send
a modified table to the server (save).

Use 'Alter' statement
when possible

If you select this option, SQL-Builder will always use an ALTER
statement when sending a modified table to the server for
execution.

Always ask execution
statement

Always ask execution statement
If you select this option, you will be prompted by SQL-Builder to
choose the type of execution statement that will be used when
sending a modified table to the server. Choose either Alter or
Drop and Create.
Cancel will abort the execution process.

Use General Option
statement

Selecting this option will force SQL-Builder to comply with the
option Always use 'Drop' and 'Create' statement set in the
General tab.
If this option in the General tab is selected, a DROP and CREATE
statement will always be used for Tables. If this option is left
blank, but the option in the Table Editor tab IS selected, SQLBuilder will use an ALTER statement for tables, where possible.

Default value(s) used
during insertion of
column(s) in a table
with data

This option enables you to define an integer or a character string
used by the Table Editor for Data Preservation.
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Tags
NULL tag

The option NULL tag allows you to define the NULL value in
order to be able to differentiate the “NULL” character string from
the NULL notion.

EMPTY String tag

The option EMPTY String tag enables you to define the
character string representing a value of empty character strings –
particularly useful for example when inserting a column with a
char type into a table containing data.

See Also
Table Editor
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Global Command tab
Notes
●

This tab can only be accessed via the feature specific Options menu option, when either
the SQL-Session or the Debugger is active.
Options > Current SQL-Session Configuration
Options > Current Debugger Configuration

This dialog box enables you to specify a Global Command that will be run before each
command is executed. This applies to commands run by:
1. Clicking the TSql menu and selecting the Go command
2. Clicking the

located on the toolbar

3. Or run using the SQL-Script File option.
Using the Global Command dialog box
You can enter the Global Command you want to precede your queries, in the main area.
●

This command must not contain any Go keywords
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●

●

●

Must be less than 2K in size.
It can also only contain a comment beginning with -- (if you are using a Sybase System
10.x servers or a Microsoft SQL Server 6.x or later).
You cannot add any commands to physically update objects, such as: drop, create,
alter, etc.

When you have entered your Global Command in the dialog box, click the OK button. The
command will then be analyzed to check for any errors - if any occur, a warning will be displayed
and you can then return to the dialog box to rectify the problem. In addition, if a selection exists
in the SQL-Session Query Editor, this selection will be used to initialize the global command in
the dialog box.
The Restore Defaults button in the bottom left hand corner of the dialog box will reset the
parameters to the default settings. You can also click the Cancel button to close the dialog box
and return to your active window - any changes made will be aborted.
See Also
SQL-Session | Debugger
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Connection Information
●

Connecting with SQL-Builder

●

Knowledge Base connection

●

Connection dialog box

●

Info dialog box

●

Existing Connections dialog box

●

Profiles

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Connection/index.htm [10/07/2008 10:37:50]

Connection

Connection
●

●

●

●

●

●

SQL-Builder is an SQL development environment, so you can use it to connect to any
supported Microsoft, Sybase ASE or Oracle server on which you have sufficient
permissions (please refer to the "Release Notes" supplied with the CAST Products' CD-ROM
for more information on supported versions).
Connections are defined in Profiles, enabling you to create any number of different
connection configurations (specifying servers, usernames and passwords) to a variety of
different servers. Connection is simply a matter of selecting and opening a valid Profile (all
valid Profiles will be displayed in the Object Manager). Usernames must be defined in your
server prior to connection with SQL-Builder.
The username you use to connect and its associated permissions will determine the level
of access you have on the server.
Concurrent connections are possible with SQL-Builder - create a new Profile and open it
from the Object Manager.
When a connection to a server has been established, information about the objects stored
on that server are displayed in the Object Manager. Concurrent server connections will
also be displayed in the Object Manager, listed in alphabetical order by server name.
During the connection procedure, SQL-Builder will check for the presence of a Knowledge
Base for licensing requirements. If no details of a Knowledge Base have been entered in
the Create Profile dialog box, then you will be prompted to enter a Local Key in the
following dialog box:
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●

This key can be obtained by contacting CAST and quoting the machine ID displayed in the
above dialog box. See Knowledge Base connection for more information.
Please note that the machine ID required to create a CAST Local Key is generated
automatically by the application - however the generation process relies on the existence
of a C: drive on your workstation. If a C: drive does not exist on your workstation, the
application will be unable to generate the machine ID.

●

Special considerations for Oracle users
When you are connecting to an Oracle server for whatever reason (connecting to the
server for installation purposes or for analysis requirements etc), various messages will be
displayed in the Messages and Errors list regarding the connection profile you are using for
the given operation.
These messages refer to the mechanisms CAST uses for accessing the PL/SQL objects
required for the operation you are carrying out.
Depending on the credentials granted to the user name you are using to connect with
(defined in your Connection Profile) and whether the CAST PL/SQL component (see the
online Help for Server Manager for more information) has been installed and defined in
the Connection Profile, one of the messages below will be displayed:
❍

❍

❍

Using schema 'y' for connection profile 'x' > The connection profile you are
using to connect with specifies that the CAST PL/SQL component is installed in
schema 'y'. As a result, you can access all objects you require (via the required
views in the System Catalogue) regardless of the credentials that have been
granted to the user name you are using to connect with.
Using DBA views for connection profile 'x' > The user name defined in the
connection profile you are are using to connect with has credentials enabling the
required DBA views to be "seen" and the CAST PL/SQL component is not installed
or defined. In this case, CAST uses the DBA_ views (see the online Help for Server
Manager for more information) to display information about the PL/SQL objects
that are required.
Using ALL views for connection profile 'x' > The user name defined in the
connection profile you are are using to connect with has credentials that do not
enable the required DBA views to be "seen" and the CAST PL/SQL component is
not installed or defined. In this case, CAST uses the ALL_ views (see the online
Help for Server Manager for more information) to display information about the
PL/SQL objects you require - if this is the case, you may not be able to access all
the objects that are required. As a result analysis results may be incomplete.

In addition, two further messages may also be displayed:
❍

❍

Using optimized queries for connection profile 'x' > The credentials of your
analysis connection profile (i.e.: the user name defined in the profile) allow the use
of optimized queries for accessing some parts of the Oracle system catalogue for
the purpose of running your analysis.
Using unoptimized queries for connection profile 'x' > The credentials of your
analysis connection profile (i.e.: the user name defined in the profile) disallow use
of optimized queries for accessing some parts of the Oracle system catalogue for
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the purpose of running your analysis.
Please note also that the SELECT_ANY_DICTIONARY permission that is available in Oracle
version 9.0 and later provides access to all the DBA_ views required by CAST. As a result,
if you have not installed or defined the CAST PL/SQL component, CAST recommends that
you grant this permission to the user name specified in the connection profile as it will
enable those using the connection profile to "see" all the PL/SQL objects they require. As a
direct result, analysis results will be correct.
See Also
Knowledge Base connection | Profiles | Launching SQL-Builder
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Knowledge Base connection
When you install SQL-Builder as part of a suite of products, part of the installation process will be
to install a CAST Knowledge Base:
●

●

You can use the CAST Knowledge Base for SQL-Builder licensing requirements - i.e.
you will not need to enter a Local Key, instead the Knowledge Base key is used to
authenticate SQL-Builder.
Wherever you choose to install the Knowledge Base in relation to the schemas/database
you want to work with using SQL-Builder, you will need to provide some connection
information so that SQL-Builder can "find" the Knowledge Base:
❍

❍

●

If the Knowledge Base is installed on the SAME server as the schemas/databases
you are working on (LOCAL), then you only need to specify the name of the
Knowledge Base (the database/schema name) in the Edit Server Connection Profile
dialog box in the Knowledge Base name, Profile name and Job name sections.
If the Knowledge Base is installed on a DEDICATED server (REMOTE):
- create a Profile that specifies the Knowledge Base name (the database/schema
name) and the server on which it is installed.
- create a second Profile that specifies the server on which the schemas/database
you want to work with are installed.
- in this second Profile, specify the name of the first Profile (the Profile that contains
the Knowledge Base connection parameters) in the Knowledge Base Profile name
section.

Knowledge Base information is also used for some other SQL-Builder features, for
example objects that have been synchronized with the Knowledge Base via CAST Analysis
Manager are displayed as such in the Object Manager.

Notes
●

●

The ability to synchronize objects with the CAST Knowledge Base has been withdrawn
from CAST SQL-Builder. It is now no longer possible to use the Save option that includes a
synchronization with the Knowledge Base. CAST recommends using CAST Analysis
Manager in batch form to fulfil your synchronization requirements. For more information
about this, see the on-line Help for CAST Analysis Manager (Root > How To >
Generating a batch file or Root > Command Line).
If you are using SQL-Builder in standalone mode, i.e. with no Knowledge Base, then you
will need to enter a Local Key - this is detailed in the Connection page.
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Connection dialog box
The Connection dialog box enables you to establish a connection to your chosen SQL-Server.
Please note that this method of connecting to a server is ONLY available when using the SQLSession or the Debugger. In all other circumstances where a server connection is required, SQLBuilder uses connection profiles.

Server

This drop down list box contains the list of all the servers
available to your application. This list depends on the connectivity
layers available on your computer and the resources defined in
your ODBC configuration.
Choose the server you want to be connected to here.

User

Enter a user name that corresponds to an existing login on the
server with appropriate permissions for the data you want to
exploit.

Password

Type the password that corresponds to the above login user
name.

OK

This button will open a new connection with the server, user, and
password that you have specified.

Cancel

Aborts the connection process and closes the dialog box.

Info

This button displays the Info dialog box which provides more
information about the available connectivity layers and servers.

Login Time-Out

In this combo box, you can alter the time (in seconds) that this
application will wait for a server response to a connection.

Notes
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●

Saving the Connection Parameters
You can save the user name and password used to connect to your RDBMS so that you do
not have to re-type your parameters each time you connect using the SQL-Session.
To do this, simply add the key "SaveAllPasswords=1" to the [Global] section of your
GloballySharedSettings.ini File file.
This feature saves all user names and passwords used for a particular server in an
encrypted format and will automatically display the correct password for the user name
and the selected server when re-connecting.
If you want to disable this feature, simply remove the "SaveAllPasswords=1" key from
your GloballySharedSettings.ini File file.

See Also
Connection | Knowledge Base connection | Profiles
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Info dialog box
This dialog box displays various information regarding the different Connectivity Layers on
your workstation. It can be launched from:
●

By clicking Help > Connection Layer Information

These layers are used by CAST Products to connect to the various servers accessible from your
workstation.

Connectivity Layers found on your Local Machine

This section displays the Connectivity Layers found on your workstation as well as their
status:
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Name

Displays the name of the connectivity layer. Layers that are
recognized at present are:
●

Sybase Db-Library

●

Sybase CT-Library

●

ODBC

●

Microsoft Db-Library

●

OK indicates that this layer has been successfully loaded

Status
●

Failed indicates that the layer has been found but is
unusable

Version

If possible indicates the Connectivity Layer version.

DLL

Displays the name and location of the connection layer's DLL.

Date

Displays the creation date of the connectivity layer's DLL.

Size

Displays the size of the connectivity layer's DLL.

Server

Connectivity layers
available for each
server

For each server found in the configuration files, this area lists the
different connectivity layers with which each server can be
accessed.

Details section

This area gives you some details about the server selected in the
Connectivity Layers list and it's available connectivity layers.
In addition to the version, the CAST Connectivity Layer
preference indicates the optimal connectivity layers according to
the version of a given server. You must, however, check that
your server is accessible through the first layer listed. It is with
that specific layer that you will get the best performance from
CAST Products.
Notes
●

If the server version is unknown, the layer precedence is
as follows: Microsoft Db-Lib, Sybase Db-Lib, ODBC and
Sybase CT-LIB.
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Reset default
connectivity layer

Use this button to reset the selected connectivity layer as the
default.

Force the use of this
connectivity layer

If there are several connectivity layers available for the server
you are connected to then you can override the default automatic
selection and choose the one you require: first select it in the list
and then click the button to confirm.

See Also
Connection

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Connection/info.htm (3 of 3) [10/07/2008 10:37:57]

Existing Connections dialog box

Existing Connections dialog box
The Existing Connections dialog box displays details of any connections that are already open
to a server and enables you to use an existing connection or to open a new connection.

OK

Enables you to choose a connection (if more than one is
available).

New

Clicking New will launch the Connection dialog box. Use this to
select the server you want to establish a concurrent connection
with.
The server must be defined in your ODBC settings before it will
appear in the Connection dialog box.

Del

Del enables you to close a connection to a server that you no
longer require. Select the server from the list and click Del.

Close

This button closes the dialog box.

All the open connections are displayed in the list box as follows :

"LoginName@ServerName

SchemaName(Nb)"

Where Nb corresponds to the number of times this connection is being used (1 when the
connection is opened, 2 when it is being used by an object).
See Also
Connection dialog box | Connection
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Profiles
●

What are Profiles?

●

Creating Profiles

●

Editing Profiles

●

Using Profiles

●

Removing Profiles
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What are Profiles?
Profiles are used in SQL-Builder to store server connection parameters. You can define any
number of Profiles allowing you the flexibility to work with a wide range of servers.
Within a Profile you can define a server, a username and a password along with a number of
other connection specific parameters. You can also give each Profile a unique name enabling you
to easily identify the server you want to connect to.
To find out more about working with Profiles, see:
●

Creating Profiles

●

Editing Profiles

●

Using Profiles

●

Removing Profiles
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Creating Profiles

Creating Profiles
In order to establish a connection with your chosen SQL server, you need to create a profile. This
can be done with the Edit Connection Profile dialog box.
To open this dialog box:
1. Right click anywhere in the Object Manager.
2. Select New Connection Profile from the shortcut menu.
3. The Edit Server Connection dialog box will be displayed.

Creating a Profile
To create a profile:
1. Enter the required information in the appropriate fields
2. Click the Test button to verify that the connection to the server can be established
3. Click OK to save the Profile.
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When you have entered all the required information, tested the connection and clicked OK, the
Profile will be stored in memory by SQL-Builder. In addition, the Profile will be automatically
displayed in the Object Manager ready for use.
Field information
The majority of fields can be altered - some are read only however (gray text).
Standard

This section governs the parameters used to connect to the server of your choice.
Profile name

The name of your profile can be entered here. CAST recommends
entering the name of the server as a profile name, to enable easy
recognition.
A profile name must not contain characters such as commas ',' or
parentheses '(' or ')'.

Server name

Enter the name of the server that you want to connect to. This
server name must be defined in the connection layer you are
using (ODBC for example).
For DB2 servers, this field is used to define the name of the
database you want to connect to.

Trusted connection

Select True or False:
●

●

True > This flags the connection as trusted - there is then
no need to enter a user name or password.
False > The connection is flagged as non-trusted - you
must specify a user name and corresponding password to
establish a connection.

User name

Enter a user name that corresponds to an existing login on the
server with appropriate permissions for the data you want to
exploit.

User password

Type the password that corresponds to the above login user
name.

Save User password

Select either True or False as required. If you select False, you
will be prompted to supply a password every time you attempt to
establish a connection with the server.

Server version

For information only. Displays the type and version of server you
are connecting to.
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Server Connection
mode

Select the connection type you want to use:
●

●

Server Connection
string

Usual > Uses the standard connection method defined in
the options above
Connection string > Uses a connection string specified in
the option below

Only available if you select the Connection string method in the
Server connection mode option.
Enter a connection string to the server you want to establish a
connection with, for example (Oracle):
OCI8:WESLEY,(DESCRIPTION = (ADDRESS_LIST = (ADDRESS =
(PROTOCOL = TCP)(HOST = wesley)(PORT = 1521)) )
(CONNECT_DATA = (SERVICE_NAME = WESLEY) ) )

Server
This section governs more advanced parameters.
Knowledge Base mode

This option enables you to define where your Knowledge
Base is stored for licensing purposes. Select from:
●

●

●

No Knowledge Base > You are using SQL-Builder
in standalone mode and you will not interact with a
Knowledge Base for licensing purposes. If this is the
case, you will be prompted to enter a local SQLBuilder license key - see Connection for more
information.
Local Knowledge Base > Your Knowledge Base is
located on the same server you are currently
attempting to connect to - in this case, please make
sure you define the Knowledge Base name option
below.
Remote Knowledge Base > Your Knowledge Base
is located on a remote server - in this case, please
make sure you specify connection profile details in
the Knowledge Base profile name section below.

See Knowledge Base connection for more information.
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Knowledge This option ONLY
Base name needs to be
defined if your
Knowledge Base is
stored on the same
server as the
schemas/databases Specify the name of the Knowledge Base
you are working on (schema/database name). Use the Browse button to list
with SQL-Builder all available schemas/databases on the server you defined
i.e. you selected
in the Server name section above. Select the
the Local
schema/database that corresponds to your Knowledge
Knowledge Base
Base.
option above.
See Knowledge
Base connection
for more
information
Knowledge
Base
profile
name

This option ONLY
needs to be
defined if your
Knowledge Base is
stored on a
remoter server i.e. you selected
the Remote
Knowledge Base
option above.

Specify the Connection Profile that contains the
connection parameters for your Knowledge Base.

See Knowledge
Base connection
for more
information
SQL start path

This option enables you to select the location of an .SQL
file that contains an SQL script. The script will be run on
completion of the connection process.
This option is aimed at those user who want to customize
there connection to a particular configuration, for example,
working in Quoted Mode in Microsoft SQL-Server or other
environment specific variables.
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CAST PL/SQL Component
Schema Name (Oracle version
only)

Select the schema on the server you want to connect to
that contains the CAST PL/SQL server-side component.
See the Server Manager help for more information about
this.
If you have not installed the CAST PL/SQL component, you
can leave this option blank.

See Also
Using Profiles | Removing Profiles
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Editing Profiles
When a Profile has been created, you may want to modify some of the connection parameters at
a later date. To do so you need to view the Profile's properties and then make any required
alterations:
1. Right click the profile in the Object Manager and select Connection Profile Properties
from the shortcut menu.
2. The Edit Server Connection dialog box will be displayed containing the parameters for the
chosen Profile.
3. Make the changes as required.
4. Click Test to verify that the application can establish a connection.
5. Click OK to save the parameters and close the dialog box.
The Profile will now be updated with the changes you made.
Notes
●

If you are attempting to modify a Connection Profile that is currently open in the Object
Manager, the Edit Server Connection dialog box will display the profile properties but you
will NOT be able to modify them.
In order to do so, please close the connection established by the Connection Profile you
want to modify (right click the Profile in the Object Manager and select Close
Connection).

See Also
Creating Profiles | Removing Profiles
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Using Profiles
Opening a connection
When the Profile is displayed in the Object Manager:
1. Double click the Profile to connect to the server defined in the Profile.
2. Or right click the profile, and select Open Connection from the shortcut menu.
If the parameters you defined are accepted, a connection to the server will be opened and the
Object Manager will automatically display the contents of the server.
Closing a profile
Closing a Profile enables you to close the connection to the server defined in the Profile:
1. Right click the profile, and select Close Connection from the shortcut menu.
The connection to the server will be closed.
Viewing a Profile's properties
When the Profile has been created and is in use, you may want to view the connection
parameters you defined when you created it:
1. Right click the profile, and select Profile Properties from the shortcut menu.
2. Please note that you will NOT be able to modify the properties of the Profile if it is being
used for the current connection.
The Edit Server Connection dialog box will be displayed containing the parameters for the chosen
Profile.
See Also
Creating Profiles | Removing Profiles
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Removing Profiles
To remove a Profile from memory:
1. Right click the profile, and select Delete Connection Profile from the shortcut menu.
The Profile will be deleted from the Object Manager.
Notes
●

●

Please note that if you remove a Profile, it will no longer be available for connection
and cannot be retrieved.
You cannot delete a Profile if its being used to establish the current connection. You must
first close the connection.

See Also
Creating Profiles
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●
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What is the Data-Session?

What is the Data-Session?
The Data-Session enables you to edit data in any Table, View or Snapshot (Oracle users
only). Using this tool, you can:
●

Specify and populate all rows (or a subset of rows)

●

Return the data to a data grid

●

Make changes (inserts, deletes and updates) of data held on the server

●

Export data

The Data-Session then constructs the correct DML statement to make the necessary changes.
Notes
●

One advantage of the Data-Session, is that you do not need to know how to program SQL
to change data.

See Also
Launching the Data-Session
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Launching the Data-Session
To access the Data-Session:
1. Open a Table, View or Snapshot from the Object Manager. Click here for more
information on how to do this.
2. Click Navigation located on the toolbar and select Data-Session.
3. You can also click

located in the top right hand corner of the Object Editor.

Notes
●

●

You can also launch the Data-Session directly from the Object Manager (an object does
not need to be open). To do so, right-click the object in the Object Manager and select
Data-Session from the shortcut menu.
When using a MS SQL-Server or a Sybase server you can also select a table or a view in
the Object Manager (right click it once) then click the

button located on the toolbar.

The Object Manager must be working in non-docking mode for this toolbar button to be
available.
See Also
Using the Data-Session
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Using the Data-Session

Interface
There are two tabs in the Data-Session window:
This tab displays the data stored in the table. You can modify,
delete or update data here as required.
Editor tab

The active line is highlighted as above. When editing is in
progress, the highlight color will change.
This tab displays any instructions or requests that have been sent
to the server following a modification to the data in the Editor
tab.

Sent Orders tab

You can use the information displayed here to keep track of any
modifications that you make. You can also save the information
to file by right clicking and selecting Save.
Similarly, you can copy the data (right click and select Copy) or
clear all information (right click and select Clear).
In other words, you can use the script in the Sent Orders tab to
update a clone table with the modifications (insert, update, delete
etc) made to the current table during the current session.
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Collection of data from the server
All columns in the current table or view of a text-displayable type are collected from the server,
up to a user defined maximum (see the Data-Session configuration tab for more information. You
can also select the number of columns to be displayed by using the
located on the toolbar).

button

While downloading, a percentage is displayed in the status bar, showing the collection progress.
If you later suspect data to have changed without SQL-Builder being informed, you can refresh
all the data in the Data-Session by using the Refresh option from the Data-Session menu or
from the right click shortcut menu.
Data Display

Data is displayed in text format, in a grid. All lines collected from the server are displayed and if
they have been truncated (i.e.: the maximum defined in the Data-Session configuration tab has
been reached), the last displayed line is filled with "..." indicating that the display has been
truncated.
Column width

The width of all columns is automatically adjusted to fit the text,
but you can resize them to your own needs. You can do this
either by clicking on the column divider and moving it manually
or by right clicking in the Data-Session to launch the shortcut
menu and selecting the Adjust Column Width. This second
option will launch a small dialog box in which you can enter the
preferred column width size in pixels.

Column type in header

The right click shortcut menu allows you to choose if you want to
display the column type in each column header (Show Types in
Headers option - also available in the Data-Session menu
located on the toolbar), helping to display more columns where
many small columns have to be displayed. A check mark will
appear next to the option in the drop down menu when the
column types are displayed.

Order by

You can sort the data in the Data-Session by column should you
require. To do this, select Order by from the Data-Session
menu located on the toolbar, or from the right click shortcut
menu - a sub menu will then be launched allowing you to select
the column by which the data will be sorted. A check mark will
appear next to the column that is being used to sort the data.
You can also sort each column by ascending and descending
order if necessary. Click the column's header and an up or down
arrow will indicate the sort direction.
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Truncation

Large column data is truncated at a maximum of 4 Kb and cells
containing this data are read-only (preventing corruption during
the update process). In addition, they cannot be cut and pasted
(using the drag & drop function).

Line Sorting

Line-sorting is also supported to help you quickly find data you
need. The search is carried out on a line-by-line basis, however,
only data that is text based can currently be searched.

Find Text

The Find Text option located in the shortcut menu launches the
standard Find dialog box to enable you to search for and find
specific data. This tool will locate any desired text either in a
column or in the whole grid.
You can also swap the position of columns using the CTRL+Cursor
keys to position columns next to each other.

Data Update
The Data-Session supports delete of unique rows, update of unique rows, and append of
unique rows held on the server.
In order to delete or update rows, the Data-Session must identify each line of the table, thus the
table must possess either a Primary Key, a Unique Key, or a Unique Index. If these do not exist,
only new lines can be appended.
Server updates are carried out line by line: when you update or append a line, the server
updates the whole line.
When appending a new line, use the last line of the grid, marked by a + in its header. When you
delete a row, simply use the DEL key, and the line where the cursor is located will be deleted.
To enter special data, use tags defined in the Data-Session configuration tab. By default, "#
NULL #' represents a NULL value. A key-shortcut is also available: F7 for NULL.
When starting to modify a line, SQL-Builder automatically switches to edit mode, and the entire
row's modifications will be sent to the server when the cursor is moved to a new line position or
when you press ENTER. An update procedure on the line currently being edited can be cancelled
by pressing the ESCAPE key.
Currently, validation is only carried out by the server, in other words, whole lines are only
validated when the server is being updated, not each cell. The line is then re-read entirely from
the server and re-displayed in the grid so that special values such as default or system values
are also shown. The display, therefore, always represents what is stored on the server. The only
exception is when a table can only be appended (because it does not possess keys that can
identify its lines), therefore appended lines cannot be re-read from the server.
To duplicate row selection, use the drag & drop function. Note that drag & drop will not work with
selections made on multiple lines, or on selections that contain truncated data (see above).
Notes
●

The current Data-Session release does not support update and delete statements for
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Views. You can only append new rows if you have sufficient permissions.
Data Export
There are two methods of exporting data from the Data-Session:
●

You can either save it in .CSV format (essentially an Excel format, but system-dependent)
or in text format (the column's delimiter is a tabulation). Click the

button located on

the toolbar, or select either the Save File or Save File As options from the File menu.
●

Copy to the clipboard using the

button.

Drag and Drop
The Data-Session supports Drag and Drop of whole lines into new lines and multi-line drag and
drop so you can move all the data in a table to another table.
1. select the line(s) you want to move
2. left click on the border of the selected line(s) (the mouse pointer will change to indicate
you have "hold" of the line)
3. keep left mouse button pressed down and drag line(s) to new destination
Limitations

●

1024 is the maximum number of permitted columns

●

4096 is the maximum number of characters that can be displayed in each cell

●

Only columns that can be displayed in text format are collected from the server. Internal
type columns are not displayed.

Notes
●

You can define a Filter on your Data-Session should you require. You can find out more
information about this here.

See Also
Data-Session tab
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Data-Session options
As with the majority of windows in SQL-Builder, when the Data-Session is the active window,
the menu headings on the Toolbar will change accordingly. The menu that is specific to the DataSession is the Data-Session menu, although the View menu and the Navigation menu also
contain options relevant to the Data-Session:
Data-Session menu
Generate Script
This option enables you to create a .TXT or .SQL file that contains the script used to update your
table. This script contains all INSERT statements that are used to fill your table. It does NOT
contain any other type of statement (UPDATE, DELETE etc) as displayed in the Sent Orders tab.
In other words, the Script Generation feature enables you to add all the information contained
in the current table to a clone table.
Once you have updated the table with the required information, select this option to open a dialog
box that enables you to define the name and location of the script file:

The Whole table name in script refers to the table you are updating. Make sure you enter a
valid name as this will be used in the script.
If you want to commit the script every "n" lines, select the Commit transaction option and
define the line interval.
Empty whole table
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This option enables you to erase all data stored in the table. The Data-Session uses a "truncate
table" to remove the data.
Please make certain this is what you want to do before you use this option (a warning dialog
box will be displayed before the data is removed).
Not available for Views or Snapshots.
Commit (only available to Oracle users)
This option will only be available if you clear the Auto Commit option (only for Oracle users)
located in the Data-Session tab. It enables you to manually commit your modifications to the
server.
Also available from the Data-Session toolbar.
Rollback (only available to Oracle users)
This option will only be available if you clear the Auto Commit option located in the Data-Session
tab. It enables you to manually rollback any modifications you have made to the current DataSession. Once the Commit option is selected, Rollback will no longer be available.
Also available from the Data-Session toolbar.
View menu
Order By
Selecting Order By will launch a sub-menu
containing a list of the columns stored in the
object from which you launched the DataSession.
Selecting a column name here will automatically
sort the Data-Session according to that column.
A check mark will indicate which column is the
sort column.
You can also sort the columns in ascending or
descending order. This is done in the DataSession itself:
●

Click the relevant column name and the
data will be sorted in ascending or
descending order accordingly. A small
arrow will be displayed in the column
heading indicating the sort direction.

Show Types in headers
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Select this command if you want to view the column type as well as its name. If selected, the
Data-Session will display a column heading as follows:
●

Phone, char(12)

if not selected:
●

Phone

A check mark in the Data-Session menu will indicate whether the option is activated or not.
Selecting this option will provide more space in the Data-Session, enabling you to view more
columns.
Notes
●

You can also select this option from the Data-Session tab when the Data-Session is active.

Activate / Deactivate Filter
This command will activate a user-defined Filter on the Data-Session, enabling you to view only
the data you require. Once the filter is activated, a check mark will be placed next to the menu
heading. This option will only be activated once a Filter has been defined on an object (see below
for more information on how to define a Filter).
The

button, located on the toolbar, functions in exactly the same way.

To find out more about how to use Filters, click here.
Define Filter
This command enables you to define a Filter for the data in your Data-Session (and thus on the
original object). By doing this, you can define what data appears in the Data-Session.
Once selected, the Define Filter dialog box will be launched. This is explained in more detail,
here.
Refresh
This command forces the Data-Session to re-read structure and lines included in the original
object, from the server
Navigation menu
Open Table/View/Snapshot
This command will open the Table/View/Snapshot (whose data is displayed in the Data-Session),
enabling you to edit its structure.
See Also
Defining a Filter on a Data-Session | Data-Session tab
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Defining a Filter on a Data-Session
Launching the Define Filter dialog box
In order to define a Filter for the data in a Data-Session:
1. Open a Data-Session for the required object. Click here for more information about how
to do this.
2. Once the Data-Session is open and the active window, select Define Filter from the drop
down View menu.
This will then launch the Define Filter dialog box.
Define Filter dialog box

The dialog box contains two sections:
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●

●

Upper Section > this contains a list of the table or view column names as displayed in
the Data-Session, together with the column type.
Lower Section > this section is where the filter is defined in the form of a WHERE clause.

Creating a filter
First you need to decide what sort of filter you want to apply to the selected Data-Session.
In the example above, only data in which the name of the state matches CA (California) will be
displayed. In other words data in which the state equals anything else will NOT be displayed.
1. Select the column you want to use as the filter with the mouse.
2. Click the Add button. The column name will then be added to the lower section.
3. Complete the WHERE clause manually.
4. If you make a mistake, click Clear All. This will erase the entire contents of the lower
section.
5. Once satisfied, click OK to apply the filter. If your WHERE clause in the lower section is
incorrect, a warning will be displayed.
When the filter is applied
When the filter is applied, the data in the Data-Session will be automatically updated and only
display what you requested.
In addition, the

button will be activated and will be in the active position (i.e.: depressed)

and the Activate Filter option in the View menu will also become activated and a check mark
will be displayed next to it.
Notes
●

Please note that Filters are persistent. In other words, when you exit SQL-Builder and then
re-launch it at a later date, the Filter data will still be present.

Activating/Deactivating a Filter
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When you complete the filter in the Define Filter dialog box, the filter will be automatically
activated. However, you may want to deactivate it.
To do this, you can either:
1. Click View > Activate Filter. The check mark will the be removed and the Data-Session
will be automatically refreshed.
2. Or click the

button on the toolbar. This will move to the normal position (when a filter

is activated, this button is in the "depressed" position) and the Data-Session will be
automatically refreshed.
To re-activate a deactivated Filter, follow the instructions above.
Removing a filter
If you don't want to use a filter on a Data-Session, you can always deactivate it as described
above. However, if you want to completely remove the Filter so that it can never be reactivated, you need to:
1. Open the Define Filter dialog box and select Clear All.
2. Click OK to apply
3. The

button will then be disabled, as will the Activate Filter option in the View menu.

See Also
Data-Session options
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Debugger
●

What is the Debugger?

●

Launching the Debugger

●

Debugger Interface

●

Starting the Debugger - Using the Run, Animate, Step, Step Into and Step to Cursor
commands

●

Stopping, Resetting and Skipping in the Debugger

●

Other Commands - Goto cursor position, Force test result to TRUE/FALSE

●

SQL-Session as part of the Debugger

●

Variables Window

●

Call Stack Window

●

Saving, Loading and Restoring Parameters

●

Bookmarks

●

Breakpoints

●

Configuring your Debugger

●

Support for Table Variables

●

Support for Bracketed and Quoted Identifiers

●

Printing from the Debugger window

●

Debugger Toolbars
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What is the Debugger?

What is the Debugger?
Debugging is the process of correcting or modifying the code in your project so that it can
develop, run smoothly, behave as you expected, and be easy to maintain at a later date.
In other words, you can step through the program, examine the code within and monitor other
conditions such as the values of variables - all without having to execute it.. To this end, SQLBuilder provides a variety of tools integrated into the Debugger to help track down errors in the
code and program components.
See Also
Launching the Debugger | The Debugger Interface
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Launching the Debugger
The Debugger can only be launched when you have a Stored Procedure open (click here to find
out how to open a Stored Procedure from the Object Manager). Once the Stored Procedure is
open there are various ways to launch the Debugger:
1. You can click the Stored Pr. menu located on the toolbar and then select the Debug
current procedure option from the drop down list.
2. You can click the

button located on the toolbar.

3. You can use the shortcut key CTRL+D
4. Or you can right click in the Stored Procedure to launch the shortcut menu and then select
the Debug current procedure option.
All of these options will then launch the Connection dialog box. You need to specify the server
on which you want to work, together with a username and the corresponding password.
Click OK once you have entered the appropriate information and the Debugger will then be
displayed.
Notes
●

Although you can only launch the Debugger from a Stored Procedure, you can also debug
Triggers if they are incorporated into the code of the Stored Procedure.
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Debugger Interface
Once you have launched the Debugger from the Stored Procedure you want to debug, the main
window will be displayed.
This page will give a description of the various sections of the Debugger main window, and point
you to related pages describing how to use it.

The Debugger window is divided into two main sections:
●

●

The left hand side contains the code from the Stored Procedure that you used to launch
the Debugger and is a read only section.
The right hand side of the Debugger consists of an interactive section, identical to the
SQL-Session. This section contains two sub-sections:
❍

❍

the bottom half (known as the Query Editor) - used to input SQL commands.
top half (known as the Results Section) displays any results of the queries you
enter in the Query Editor (bottom section) and any results resulting from the
Stored Procedure when it is being debugged.

Two other windows are displayed during the debugging process. They display information relative
to the active debugging document:
●

●

Variables window displays the names and values of parameters, and local and global
variables that are used in the Stored Procedure. This window is explained in detail, here.
The Call Stack Window displays the name(s) of the Stored Procedures or Triggers
currently being executed. When Nested Procedures or Triggers are Stepped Into
(using the Step Into option from the Debug menu which is located on the toolbar, this
window will show you the hierarchy of nesting levels starting with the topmost procedure.
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To find out how to start the Debugging process, click here.
See Also
Starting the Debugger | Variables Window | Call Stack Window
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Starting the Debugger
Once the Debugger Window is launched, there are several ways in which you can begin the
debugging process. This depends entirely on the type of process you want to run, for example,
you could run the debugger to completion, run and animate it to view each instruction result or
you could Step Into each instruction in turn.
Notes
●

Please be aware that GLOB_VAR_xxx.LST files that contain global variables from the
target server are no longer used. These variables are now handled automatically and as a
result CAST recommends that you remove these files from your working directory.

Run command
This command executes code from the current statement until a debugger event occurs.
A debugger event can occur in the following circumstances:
●

When a Breakpoint is reached in the code, when a SQL exception is raised or handled, or
when the end of the statement is reached.

To use this command, you can:
1. Click the Debug menu located on the toolbar and then select the Run command from the
drop down menu as shown in the image on the right
2. Click the

button located on the toolbar

3. Or you can use the shortcut key, SHIFT+F5
Once you have selected one of the above options, a warning dialog box will launch indicating
that the system tables will be locked for the duration of the debugging procedure. This acts only
as information and means that other users will not be able to access the system tables during
the debugging process.
Click the OK button to start the Debugger.
Notes
●

Please make sure that the BEFORE and AFTER code of the object you want to debug
does NOT contain any GO commands. The debugger is likely to fail if this command is
present

Animate command
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The Animate command is similar to the Run command described above, however, instead of
executing the code rapidly, it automatically Steps Into every instruction one after the other
(approximately once every second) until the end of the program is reached.
To use this command, you can:
1. Click the Debug menu located on the toolbar and then select the Animate command from
the drop down menu
2. Click the

button located on the toolbar

3. Or you can use the shortcut key, F5
Step command
This command enables you to single-step through the instructions in the program. In other
words, an instruction will be stepped into and executed and the results displayed in the Results
Section on the right hand side of the Debugger - you will then need to use the command again
in order to step into the next instruction in the statement. When an object (Function, Stored
Procedure or Trigger) call is reached, the object will be executed without stepping through
the object's instructions.
To use this command, you can:
1. Click the Debug menu located on the toolbar and then select the Step command from the
drop down menu
2. Click the

button located on the toolbar

3. Or you can use the shortcut key, F10
The Skip command may be useful when using this command. Click here for more information on
this.
Notes
●

Results obtained when using the STEP command can vary depending on whether the
option SET QUOTED_IDENTIFIER is set to on or off. Modifying this option between two
STEP procedures is your responsibility.
For example, the execution of the command below will give varying results:

select "name" as NAME from sysobjects
If the option is set to ON, a column consisting of object names available in the current
catalogue will be returned:
NAME
sysobjects
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sysindexes
syscolumns
systypes
syscomments
...
If the option is set to OFF a column consisting only of <<name>> will be returned
NAME
name
name
name
name
name
...
To set the option, use the SQL-Session: enter SET QUOTED_IDENTIFIER ON or SET
QUOTED_IDENTIFIER OFF.
See here for more information about the support for Quoted and Bracketed identifiers in
the T-SQL Debugger.
Step Into command
This command is similar to the Step command in that it enables you to single-step through the
instructions in the program. In other words, an instruction will be stepped into and executed and
the results displayed in the Results Section in the right hand side of the Debugger - you will
then need to use the command again in order to step into the next instruction in the statement.
However, the Step Into command will actually enter each instruction in the statement and
execute it.
To use this command, you can:
1. Click the Debug menu located on the toolbar and then select the Step Into command
from the drop down menu
2. Click the

button located on the toolbar

3. Or you can use the shortcut key, F8
The Skip command may be useful when using this command. Click here for more information on
this.
Step To Cursor command
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This command executes the program up to the line that contains the insertion point. This is
equivalent to setting a temporary Breakpoint at the insertion point location.
To use this command, you can:
1. Click the Debug menu located on the toolbar and then select the Step to Cursor
command from the drop down menu
2. Click the

button located on the toolbar

3. Or you can use the shortcut key, F7
See Also
Stopping, Resetting and Skipping in the Debugger | Other Commands
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Stopping, Resetting and Skipping in the Debug
Stopping the Debugger
If you want to stop the Debugger when it is in the middle of a Debugging operation, you can
do so by:
1. Clicking the Debug menu located on the toolbar and then selecting the Stop debugging
command from the drop down menu
2. Clicking the

button located on the toolbar

3. Or you can use the shortcut key, PAUSE
Notes
●

Stopping a debugging session can cause problems on the server or with the Debugger.
Some active sessions could remain on the server and thus, locks may be retained on
T/SQL objects. As a result, the debugger could hang in future sessions while trying to
recompile or access objects locked by 'Stopped' Debugger sessions. Use this command
with care.

Resetting the Debugger
Once you have completed the Debugging process using for example the Run command (click
here for more details on the Run command), you may wish to reset the Debugger and then use
an alternative command such as Step Into. To do this you can:
1. Click the Debug menu located on the toolbar and then select the Reset debugging
command from the drop down menu
2. Or you can click the button located on the toolbar
Once you have done so, the Debugger will reset the session and you will then be able to carry
out another Debugging process if you require.
Skipping Blocks
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If you are using the Step and Step Into commands, which enable you to move through the
instructions in the statement one-by-one, then the Skip command may prove particularly useful
if you want to skip one block of instructions and move on to the next. To use this command,
you can:
1. Click the Debug menu located on the toolbar and then select the Skip Current Block
command from the drop down menu
2. Click the

button located on the toolbar

3. Or you can use the shortcut key, SHIFT+F10
See Also
Other Commands
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Other Commands
Goto cursor position
The Goto Cursor Position command highlights the SQL instruction where the cursor (insertion
point) is currently positioned as the next instruction to be executed. If, however, there is no instruction
at the indicated location (for example the cursor maybe located inside a comment) then the Debugger
will issue an error message.
This command can be particularly useful if you want to start the Debugging process from an
instruction located in the middle of the statement. Click here to find out more about how to start the
Debugging process.
To access this option, you can:
1. Click the Debug menu located on the toolbar and then select the Goto Cursor Position
command from the drop down menu as shown in the image on the right
2. Or you can use the shortcut key, SHIFT+F7
Force test result to TRUE
When the next instruction to be executed is the test of an IF or WHILE statement, the Force Test
Result to TRUE option causes the test result returned by the SQL Server to be ignored. Instead,
the requested "forced" test result is used ("TRUE").
To access this option you will first need to:
1. Place the cursor at the IF or WHILE statement you want to test in the left hand section of the
Debugger.
2. Use the Goto Cursor Position option described above to highlight the command.
3. Click the Debug menu located on the toolbar
4. Select the Force test result to TRUE option from the drop down menu
The example below displays how this works:
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In the above image, the Goto Cursor Position has been used to highlight the IF statement that is to
be tested. The Force test result to TRUE option is then used, and gives the following results

In other words "if the fetch status = 1 and this is TRUE, then begin". You can also consult the examples
given below in the description of the Force test result to FALSE option.
Force test result to FALSE
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When the next instruction to be executed is the test of an IF or WHILE statement the Force Test Result
to FALSE menu option causes the test result returned by SQL Server to be ignored. Instead the
requested "forced" test result is used ("FALSE").
1. Place the cursor at the IF or WHILE statement you want to test in the left hand section of the
Debugger.
2. Use the Goto Cursor Position option described above to highlight the command.
3. Click the Debug menu located on the toolbar
4. Select the Force test result to FALSE option from the drop down menu
The example below displays how this works:

In the above image, the Goto Cursor Position has been used to highlight the IF statement that is to
be tested. The Force test result to TRUE option is then used, and gives the following results:

In other words "if the fetch status = 1 and this is FALSE, then close c". You can also consult the
examples given above in the description of the Force test result to TRUE option.
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SQL-Session as part of the Debugger
To help the debugging process, T-SQL commands may be sent to the SQL Server at any time,
from the right-hand section of the Debugger which consists of an SQL-Session.
There is no need to declare or initialize the variables in the queries which correspond to
local variables or the parameters of the object associated with the debugging document. These
variables are automatically declared and initialized with their current value, as displayed in the
Variables Window.
The SQL-Session allows the user to query the contents of the inserted/deleted logical tables
when debugging a Trigger.
For example to view the whole contents of the "inserted" logical table in question enter:

SELECT*FROM inserted
Notes
●

●

The value of global variables used in a query sent from the SQL-Session is the true
SQL Server value. Therefore, it may have no relation with the value displayed in the
variables window. This choice offers the advantage of consulting values that are
guaranteed to be accurate in critical or difficult debugging situations.
Any modifications of local variables or procedure parameter values through the SQLSession are ignored by the debugger and in no circumstance can it modify the value of the
corresponding symbol in the object being debugged. Use the New value field and Update
button in the Variable Window to modify these values. This does not, however, apply to
Microsoft cursor variables (available from SQL Server v. 7.0), for which the debugger
takes into account any modification occurring through the SQL-Session (such cursor
variables cannot be modified using the Variable Window).
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Variables Window
The Variables Window (displayed as a contextual dock bar) displays all the Variables included
in the current statement you are debugging. It also enables you to modify the value of the
variables contained in the statement.
Launching the Variables window
The Variables Window is automatically opened when you launch the Debugger (click here for
more information on how to do this), but if you want to re-launch it at any other time during the
Debugging process, you can:
1. Click the View menu located on the toolbar and the select the Variables option from the
drop down menu.
A small check mark will appear next to Variables when the window is displayed.
Window interface

The Variables Window contains three columns:
●

Name > name of the variable in the Stored Procedure you are debugging

●

Type > displays the type of Variable

●

Value > displays the Value of the Variable

Entries are also grouped into three categories:
●

Parameters > procedure parameters

●

Global > global or system variables

●

Local > local variables

The Variables window incorporates an Auto Hide feature and can be resized manually. The size
and position of the window are saved for reuse.
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Changing the value of a variable
You can modify the value of any of the variables in the Variables Window (and thus also in the
Object you are debugging). To do this, follow these instructions:
1. Select a Variable that you want to modify
2. Click the entry in the Value column
3. Enter the new value in the field and press ENTER to confirm the entry. You can use any
valid T-SQL expression as a value.
The new value is now stored and will be taken into account when the next instruction is
executed.
Notes
●

●

●

If you enter an alphanumeric value, it will automatically be placed between quotation
marks, and if necessary, binary and varbinary values are automatically prefixed with
"0x".
If you want to save these changes, please click here for more information.
The value of a Cursor Variable (or Parameter) cannot be modified through the Variables
Window; please use the SQL-Session instead.

Table type variables
For table type variables, the Variables window displays the structure of the table. It is possible to
display their values in the Data-Session by double clicking an entry of this type in the Variable
window.
See Table Variables for more information.
Further information
You can modify the value of any symbol (including that of global variables) at any time during
the course of the Debugger execution. The values that are updated by the system are refreshed
according to the following rules:
●

●

the new values of all Global (system) Variables referenced within a Stored Procedure or
Trigger are retrieved from the SQL-Server after execution of EACH instruction.
the new value of a Parameter or Local Variable is retrieved from the SQL-Server only
AFTER execution of the instruction in which it is referenced.

In addition, in compliance with SQL-Server operation, as soon as the @@error variable takes a
non zero value during procedure execution (even if this value is entered manually), the return
code of the current procedure execution is set to -6 ("miscellaneous user error" according to SQLServer Reference Manual).
When execution in debug mode is started, each Parameter is initialized with its default value (if
one exists). Before debugging a procedure:
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●

Modify the default values, if needed

●

Enter a value for parameters which are not "output"

●

Optionally enter a value for "output" parameters

●

If necessary assign values to Local and Global Variables

The Value field of a parameter which has not been assigned a value is left empty. The Value
field of a local variable displays "<undeclared>" until a DECLARE instruction for this variable is
executed. In compliance with SQL Server, a local variable is assigned a value of NULL at
declaration time. If the value of a variable has been specified prior to execution of the DECLARE
instruction (step #4 in the list above), the specified value is preserved.
The Value field of a Cursor Variable (or Parameter), (when the symbol has been declared),
indicates:
●

how many cursor variables (or parameters) share the same result-set (this references
counter is surrounded with [ and ])

●

whether the result-set is "open" or "closed"

●

what the result-set's definition is

In compliance with SQL Server, if the DECLARE instruction of the Local Variable is executed
several times, only its first execution will assign a NULL value to the variable (subsequent
executions of the DECLARE instruction will leave the variable value unchanged).
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Call Stack Window
The Call Stack Window (displayed as a contextual dock bar) displays a list, in calling order, of
the Stored Procedures and/or Triggers that are called in the Stored Procedure you are
debugging.
This is particularly useful for viewing the call order without having to search through the lines of
code.
Launching the Call Stack window
The Call Stack Window is NOT automatically launched when starting the Debugger, but can be
consulted at any time during a debug session when the Debugger window is active. You can:
1. Click the View menu located on the toolbar and the select the Call Stack option from the
drop down menu as shown on the right
A check mark will appear next to Call Stack in the View menu when the window is launched.
Window interface

Each entry in the Call Stack window displays the name of a Stored Procedure or Trigger.
The first entry (at the top of the list) contains the name of the object currently being
debugged (i.e., the object whose text is displayed in the active debugging document).
The following entries in the list are the Calling objects, i.e., those that are called in the object
being debugged, and are displayed in the order that they are called in this object.
Each list element is composed of five fields:
1. Type: "P" for a procedure, "TR" for a trigger
2. Name of the host database (in the example above: Northwinds)
3. Name of the procedure or trigger owner (if assigned - in the example above: dbo)
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4. Name of the procedure or trigger (in the example above: CustOrdersOrders)
5. Name of the host SQL Server (in the example above: WESLEY)
The Call Stack window incorporates an Auto Hide feature and can be resized manually. The size
and position of the window are saved for reuse.
See Also
Variables Window
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Saving, Loading and Restoring
Parameters
SQL-Builder's built-in Debugger also allows you to Save, Load and Restore Parameter
Variables should you require.
Saving parameters
If you update a Parameter Variable in the Variables Window (click here for more information
on how to do this), you can then Save this information in a special file on your PC's hard disk. To
do this you can:
1. Click the Debug menu located on the toolbar (when the Debugger is the active window)
2. Select the Save Parameters option from the drop down menu.
This will launch a standard windows Save dialog box in which you can specify a file name and
location for the .PAR file in which the Parameters will be saved.
By default, however, SQL-Builder will select the destination folder and a name
(DBGPARMS.PAR) which you can use if you wish.
Loading parameters
If you have saved some Parameter Variables in a Stored Procedure during a previous debug
session, when you come to debug that stored procedure again, you can load these Parameter
Variables. To do so you can:
1. Click the Debug menu located on the toolbar (when the Debugger is the active window)
and then select the Load Parameters option from the drop down menu.
This will launch a standard windows Open dialog box in which you can specify the file name and
location for the .PAR file in which the Parameters are saved.
Once you have completed this action, if you have the Variables Window open the Parameter
Variables you loaded will automatically be displayed in the window. If not, then you need to
open the Variables Window.
Restoring parameters
This function enables you to restore the Parameter Variables if you modify them during a
debug session and then later change your mind. However, this function is unavailable unless
you have loaded a set of Parameter Variables and then change them (it is unavailable if you
simply update the Parameter Variables when the Variable Window is first launched).
To restore the Parameter Variables that you loaded and then modified, you can:
1. Click the Debug menu located on the toolbar (when the Debugger is the active window)
and then select the Restore Parameters option from the drop down menu.
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See Also
Variables Window
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Bookmarks
Bookmarks can be added to SQL code that you want to come back to at a later date. This can be particularly
useful if the object you are debugging is particularly long: when you want to come back to a piece of code you
can do so with the Next Bookmark command.
Toggle Bookmark
This command can be used to set and un-set a bookmark on a line of code.
1. To do so, click in the left hand section of the debugger (the section that contains the SQL code) on the
line of code which you want to bookmark.
2. Click the View menu located on the toolbar and then select the Toggle Bookmark command from the
drop down menu
3. Or you can use the shortcut key CTRL+F2
This will set a bookmark on the line of code as shown in the image below:

The blue color represents the bookmark and this will remain on the piece of code throughout the Debugging
session.
If you want to remove the bookmark, simply left click anywhere in the bookmark and then click View >
Toggle Bookmark again.
Next Bookmark
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The Next Bookmark command enables you to find a bookmark in the Debugger. For example, if you are
debugging a particularly long Stored Procedure and you have set several bookmarks, then you can return to
the start of the code and use the Next Bookmark command to find the next bookmark in the code.
You can also use this command from any position in the code. To do so:
1. Click the View menu located on the toolbar and select the Next Bookmark option from the drop down
menu
2. You can also use the shortcut key: F2
When you use this command, the cursor will move to the next bookmark in the Debugger. You can use the
command again to find other bookmarks you may have set in the code.
Notes
●

●

You can change the color of your bookmarks if you require. See the Editor Options tab for more
information.
These two commands are also available in the SQL-Session and in the Object Editors
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Breakpoints
Breakpoints are locations in Stored Procedures or Triggers at which execution is halted so that you can
examine the program's status or the contents of variables etc. When you start the debugger, execution will
stop when it reaches a breakpoint.
SQL-Builder's built-in debugger has several options that enable you to set and manipulate breakpoints and
this section will explain these options:
Breakpoints in-depth
When you define breakpoints in the Debugger (Breakpoints can also be set in Stored Procedures and
Triggers), SQL-Builder keeps those Breakpoints in memory and saves them when you exit the
application. The next time you debug the object (or open the Stored Procedure or Trigger), the
Breakpoints you previously defined will still be set.
Moreover, when a Stored Procedure is called by a Step command (click here for more information on Step
commands), and when this procedure is interpreted, all Breakpoints set inside the called procedure will be
examined to stop execution when necessary. This is particularly useful when a Stored Procedure is called
repeatedly inside a loop, and you want to stop the execution only under certain conditions.
Because Breakpoints can be set or removed from either the Debugger or the Stored Procedure and
Trigger editors, when both object editor and Debugger are opened, Breakpoints are transferred
between both editors as soon as the object is modified in either editor. In this case, breakpoints matching
the real object text saved on the server are known as Persistent. Breakpoints in a modified editor are only
local, and become global when the Stored Procedure or Trigger is saved. That is why after modifying an
object's source code, breakpoints are not transferred between object editor and Debugger window.
Persistent Breakpoints are saved inside a local file, and are not shared between all users.
Setting and removing Breakpoints
You can set Breakpoints anywhere in the code of the Stored Procedure or Trigger that you are debugging.
To do so:
1. Left click in the left hand section of the Debugger at the point at which you want to insert a
breakpoint
2. Click the Debug menu located on the toolbar and then select the Toggle Breakpoint option from
the dropdown menu
3. Or click the

button located on the toolbar

4. Or you can use the shortcut key: F9
Breakpoints can also be set or removed when editing a Stored Procedure or Trigger directly:
1. Open either object type from the Object Manager
2. Click on the corresponding object specific toolbar menu (either Stored Pr. or Trigger in this case)
3. Select the Toggle Breakpoint option from the drop down menus.
This will then set a Breakpoint at the line as shown in the image below:
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To remove the Breakpoint, simply use the exact same options as described above for setting the
Breakpoint. You can also remove Breakpoints from the Breakpoints dialog box explained below.
Breakpoints dialog box
This dialog box displays a list of all the Persistent Breakpoints (click here for more information about
Persistent Breakpoints) that you have set in any or all of the databases stored on your SQL-Server. You
can also remove Breakpoints and set conditions on Breakpoints from this dialog box.
To launch the dialog box:
●

●

●

Make sure that the Debugger is the active window
Click the Debug menu located on the toolbar and then select the Breakpoints... option from the
dropdown menu
Or you can use the shortcut key CTRL+B
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At the top of the dialog box, the Server field enables you to change the server on which you are working
and thus display Breakpoints stored on other servers.
Likewise, the Database field enables you to select the Database that you want to check for Breakpoints. In
addition, there is an All Databases option which allows you to view all the Breakpoints in all the
Databases on a particular server.
In the area immediately below, you will find the name of the Database, the name of the object in which
the Breakpoint is set, the type of object (Proc or Trig), the line at which the breakpoint is set, and finally
the type of Breakpoint condition that is set (if any).
Deleting a Breakpoint
To delete a Breakpoint(s):
1. Select it/them in the list by left clicking with the mouse and holding down the SHIFT or CTRL keys
2. Click the Delete button.
3. The breakpoints will be removed from the Debugger as well as the object syntax. You can also
remove Breakpoints individually in the Debugger itself, click here for more details.
Setting a Condition on a Breakpoint
To set or modify the condition on a Breakpoint:
1. Select it in the list and then click the Set Condition button.
2. This will then open the Breakpoint Condition Dialog Box.
Breakpoints Condition dialog box
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This dialog box lets you set or modify a condition defining a Breakpoint. To launch this dialog box, you
first need to click in the code of the object you are debugging (in the left hand side of the Debugger) to
select a position for the Breakpoint. Then you can:
1. Click the Debug menu located on the toolbar and select the Set Breakpoint Condition option from
the drop down menu
2. Or you can use the shortcut key SHIFT+F9
These two options will launch the dialog box:

The dialog box contains three combo boxes in which you cans select the various conditions for the
breakpoint:
●

●

●

In the left hand Variable box, click the down arrow to select the variable or parameter on which the
condition will be set
Select the Operation in the middle combo box, again click the down arrow and select from the drop
down list
Finally define a constant Value in the third box

When you are satisfied with your choices, click the OK button and the breakpoint will be set on the line you
chose in the Debugger, including the condition.
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Configuring your Debugger
SQL-Builder provides a specific configuration dialog box to help you optimize the performance of
your Debugger. This dialog box contains three tabs each providing different types of
configuration options. These tabs are identical to those for the SQL-Session, as the Debugger
and the SQL-Session share many similar characteristics.
For example, the SQL-Session Display tab will alter the display of the Debugger when the
Debugger is active.
Accessing the configuration dialog box
You can access the Debugger configuration dialog box when the Debugger window is active:
1. By clicking the Options menu located on the toolbar.
2. Then selecting the Current Debugger Configuration... option from the drop down
menu.
This will then launch the Debugger Configuration dialog box (which is in fact named the SQLSession configuration dialog box).
The Debugger Configuration dialog box contains three tabs, all providing various
configuration options. Click on the name of the tab below to find out more information:
●

SQL-Session Display tab

●

SQL-Session tab

●

Global Command tab

Notes
●

There is also a page describing and giving examples of the Detailed Output option included
in the SQL-Session Display tab.
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Support for Table Variables
CAST SQL-Builder's Debugger now fully supports Microsoft SQL Server 2000 table variables:
TABLE(@TABLE)
These variables can be referenced in exactly the same as way as normal tables with the following
restriction:
●

They are for local usage, even if they can be declared in a global cursor.

Management and Display
●

●

●

This type of variable exists only on MS SQL Server 2000
The columns of the table variable are NOT displayed. The Variables Window displays a description of
the definition of the columns and NOT the associated values. As a result, this "value" will never
change during the session
An @TABLE variable will have a TABLE datatype when displayed

Table variable references in a cursor
When a Stored Procedure P1 has a parameter @cursor of type CURSOR VARYING OUT, and @cursor is
declared with a reference to one or several table variables, one of the instuctions displayed below will cause
an SQL error:
●

●

Error CAS.1 is a standard SQL Server error because in reality it is impossible to reference a table
variable in a cursor via a parameter.
Error CAS.2 is a side effect that results in the display of the message ERRMSG 02 instead of and in
the place of the message ERRMSG 01.

Particular Cases
●

Option "Procedure Interpretation" to "When Necessary"
During a Step (F10), the error ERRMSG 01 is systematic when the cursor variable transferred via a
parameter of a procedure that has declared the argument CURSOR VARYING OUTPUT is used in the
body of the procedure or function on which the Step has been executed.
This error is entirely normal and is consistent with the behavior of Microsoft SQL Server.

●

Option "Procedure Interpretation" to "Always" (F8 automatic)
Because the procedure is always interpreted, the error ERRMSG 02 is systematic - due to the fact
that all the table aliases have a life expectancy of the scope of the procedure. All the aliases are thus
destroyed when exiting the procedure via a query of the type:
DROP TABLE #02$0003.

CAS.1
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In this example, remove the instruction OPEN@cursor. Execute the following script:

declare @curs_invk_vtable cursor
declare @tble nchar(5)
select @tble = 'TOTO' -- to check if debugger handle this as global or not
select @tble
execute p_varTable_in_glbCursor @cursor=@curs_invk_vtable output
OPEN @curs_invk_vtable – There is an error here (see ERRMSG 01).
FETCH FIRST FROM @curs_invk_vtable --INTO @ins, @y

CAS.2
Leave the contents of the example unchanged:

declare @curs_invk_vtable cursor
declare @tble nchar(5)
select @tble = 'TOTO' -- to check if debugger handles this as global or not
select @tble
execute p_varTable_in_glbCursor @cursor=@curs_invk_vtable output
FETCH FIRST FROM @curs_invk_vtable --INTO @ins, @y – There is an error here (see ERRMSG 02)

Example
Create Proc dbo.p_varTable_in_glbCursor (@cursor CURSOR VARYING Output)
As
Begin
declare @tble TABLE (local_c int )--, @v tinyint
declare @tble_2 TABLE (local_c int )
insert @tble values(55)
insert into @tble(local_c)
select distinct(convert(int,(5*contract+15))) from pubs..authors
select * from @tble -- watch what is in
set @cursor = CURSOR GLOBAL SCROLL DYNAMIC FOR
select a.au_id, a.au_lname, a.au_fname, a.phone
from @tble t2,-- my table variable
pubs..authors a,
@tble t -- my table variable
where a.city = 'Oakland'
and a.contract < t.local_c
and t2.local_c = t.local_c
FOR READ ONLY
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declare cursor_2 SCROLL cursor FOR
select a.au_id, a.au_lname, a.au_fname, a.phone
from @tble_2 t2,-- my table variable
pubs..authors a,
@tble t -- my table variable
where a.city = 'Oakland'
and a.contract < t.local_c
and t2.local_c >= 15*t.local_c
FOR READ ONLY
OPEN @cursor --open it
insert @tble_2 values(2*55)
insert into @tble_2(local_c)
select distinct(convert(int,(15*contract+25))) from pubs..authors
open cursor_2
FETCH FIRST FROM cursor_2
if (@@FETCH_STATUS = 0)
BEGIN
FETCH LAST FROM cursor_2
END
CLOSE cursor_2
DEALLOCATE cursor_2
end

Known Errors
Error Number

Description

ERRMSG 01

The variable '@curs_invk_vtable' does not currently have a cursor
allocated to it. (sev 0, MsgNo 16950, lineNo 0)

ERRMSG 02

Could not complete cursor operation because the table schema changed
after the cursor was declared. (sev 0, MsgNo 16943, lineNo 0)

See Also
Variables Window
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Support for Bracketed and Quoted Identifiers
The T-SQL Debugger supports Bracketed and Quoted Identifiers for example:
●

Quoted Identifiers (surrounded by " " )
"table", "procedure", "an anonymous identifier"

●

Bracketed Identifiers (surrounded by [ ] )
[table], [procedure], [an anonymous identifier]

These identifiers must conform with the required format and be supported by the target server.
They can appear:
●

in table column names

●

in the names of components "qualifying" an object name and in the object's name itself.

One consequence of this is that an alias name can be delimited (see Microsoft SQL-Server
documentation for more information).
Sybase Servers
The particularities of the way in which Sybase servers handle Quoted and Bracketed Identifiers in
some cases are not supported.
Limitations
For object names beginning with:
●

esp_ for Sybase servers

the use of delimited identifiers does have the following limitation:
●

●

The Step Into command is not authorized for object names beginning with sp_OA if such
an identifier is not the name of the parent object opened from SQL-Builder.
The Step Into is not authorized for object names beginning with esp_ whatever its
hierarchical position.

Workaround
A workaround for this limitation does exist - start the name of the object with a space. For
example, execution of a procedure whose name must contain sp_oa as the first valid characters:
●

●

EXECUTE [ sp_oa debugger stepinto n°2] - object name created with the inclusion of
a space, instead of:
EXECUTE [sp_oa debugger stepinto n°2]
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Printing from the Debugger window
SQL Builder's Debugger offers you the ability to print any of the Debugger main windows (not
the Variables Window or the Call Stack Window) if required.
How to print
The print options can be accessed when the Debugger is open and it is the active window:
1. You can click the File menu located on the toolbar and then select the Print option from
the drop down menu
2. You can also click the

button located on the toolbar

3. Or you can use the shortcut key: CTRL+P
All of these options will then launch the Print Region dialog box as described below.
Print Region dialog box
This dialog box enables you to Print either the Query Editor or the Results Section of the SQLSession window:

Click the option that corresponds to the section you want to print. When you click each option,
the red outline box will also move to indicate which area will be printed.
Press the OK button and the data will be sent to the printer. Click the Cancel button if you want
to abort the Print procedure.
You can also access the Print Setup options if you wish to change any of the default settings:
1. Click the File menu located on the toolbar and then select the Print Setup... option. This
will launch a standard Windows Print setup dialog box.
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Printing from the Debugger window

See Also
Print Options
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Flow Chart
●

What is the Flow Chart?

●

Activating the Flow Chart

●

Using the Flow Chart
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What is the Flow Chart?
The Flow Chart feature in SQL-Builder enables you to produce a simplified but extremely useful
Flow Chart diagram of the code of any Stored Procedure, Trigger, Function (Functions can only
be viewed when using Microsoft SQL Server 2000 or Oracle databases) Package Bodies (Oracle
only) and Views (Oracle only).
Flow Charts can prove particularly useful if you want to get a quick visual snapshot of the code in
your object - a graphical view of the entire code showing IF clauses and the "routes" of the
following TRUE and FALSE statements is displayed. Flow Charts are fully integrated into the
object editor, and are automatically activated.
See Also
Activating the Flow Chart
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Activating the Flow Chart
Flow Charts are fully integrated into each object editor for which the feature is available.
When you first open an existing object, the Flow Chart feature will be inactive and you will only
see the object's code.
●

To activate the Flow Chart, move the center code section "splitter" to the right as
displayed below (blue arrow):

The object's code is then automatically analyzed and the Flow Chart created - if any errors are
present, then the Flow Chart section will remain empty until the code becomes syntactically
correct. The editor is now in Flow Chart mode.
All code information is taken from the object exactly as it exists in the SQL-Builder Object
Manager.
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De-activation
To de-activate the Flow Chart, move the "splitter" to the left until only the code is visible. the
editor is now in standard mode.
See Also
Using the Flow Chart
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Using the Flow Chart
Automatic Update
Once the Flow Chart has been activated, any changes you make directly to the object's source
code will be automatically reflected in the Flow Chart section.
However, the Flow Chart will only update when the internal code analyzer detects that the code
is syntactically correct. While the code is "incorrect", the Flow Chart will remain the same and will
match the previous correct source code.
Source Code Editor behavior
When the Flow Chart is activated, the source code editor will behave slightly differently in that
line heights are adapted to match the size of the symbols in the flow chart:
●

Flow Chart activated

●

Flow Chart de-activated

However, this change only concerns the way in which the code is displayed - no empty lines or
other extra characters are added to the source code. Editing procedure also remains the same.
Flow Chart and source code interaction
Flow Charts have been designed as visual aids - and as such the source code and the Flow Chart
(when active) are always synchronized when the vertical scroll is used. This is so that the
source code matching one particular symbol is always on the same line as the generated symbol thus making the Flow Chart easy to read.
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Link color
The color of links in the Flow Chart depends on their direction:
●

Links that go from top to bottom or from left to right are displayed in red.

●

Links that go in opposite directions are displayed in brown.

Arrows are also added where link direction may not be clear.
Selecting symbols in the flow chart

●

Clicking any Flow Chart symbol once
By clicking a symbol in the Flow Chart once, the cursor will be automatically placed at the
beginning of the corresponding code element.

●

Double clicking a GOTO symbol
This will automatically place the cursor at the beginning of the destination label and, if
necessary, the code and graphic will be scrolled to this position.

●

Double clicking a test (IF) or loop (FOR or WHILE)
The cursor will be set to the next instruction, following the false branch.

●

Double clicking a link
If you double click a link, the cursor is set to the instruction matching the calling
symbol, not the called symbol. This feature is useful only for long links, typically those
that belong to a branch, a test resulting in a false results, and loop endings.

Flow Chart Symbols
Most symbols have one entry link and one exit link. Only test and loop symbols can have two
exits. Those exits are flagged with "true" or "false" stamps, to avoid confusion. Some symbols
have no entry links. Normally, only the first symbol matching the beginning of the code is like
this, but it may be true for other objects if some parts of the source code are unused (for
example, if a GOTO instruction skips some code which is never called).
In the same way, many symbols can have no exit - for example, if the source code has multiple
return instructions. test and loop symbols may only have a "true" branch if no symbol exists to
branch after the "false" link.
The following table displays all the symbols that can be displayed in the Flow Chart, along with
the type of code they correspond to:
Symbol

Code Type
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Variable declaration
Data access (SQL)
Basic code block
Procedure/Function call
DDL code
Cursor management code
Transaction (commit/rollback)
Test
Exit with or without return value
Branch
Label for branching
While loop (do...while, while...until etc...)
For loop
Try block
Case or exception block
Printing the Flow Charts
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To Print the Flow Chart (the Object Editor must be in Flow Chart mode) you can:
1. Click the File menu located on the menu bar and select Print from the drop down menu.
2. A dialog box will be displayed asking whether you want to print the Script and the Flow
Chart - select this.
However, in order to print a Flow Chart, various conditions must first be fulfilled:
1. The Flow Chart must perfectly match the source code, in other words you cannot
print if your code is not syntactically correct.
2. The Flow Chart must not be too big. There is no limit to length as such, but the Flow
Chart must not exceed half a page width. If the Flow Chart is very big, it will be printed in
landscape mode without lateral margins and with a small amount of zoom reduction (or a
combination of these).
Notes
●

Occasionally it may not be possible to print the Flow Chart even if the above criteria have
been fulfilled. This can be due to there being too many symbols included on one line of
source code. In this case, modify the source code to avoid this.
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Object Generators
●

What are the Object Generators?

●

Procedure Generator

●

Trigger Generator

●

Templates - information about templates that are used to define the style of the generated
Stored Procedures and Triggers
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What are the Object Generators?

What are the Object Generators?
SQL-Builder enables you to produce two types of objects based on Tables stored in your
Knowledge Base:
●

●

Stored Procedures > you can create elementary Stored Procedures from a list of Tables.
This is known as the Procedure Generator.
Triggers - you can produce a creation or update T-SQL script for all Triggers linked to one
or more Tables. This feature is known as the Trigger Generator.

See Also
Procedure Generator | Trigger Generator
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Procedure Generator

Accessing the Procedure Generator
The Procedure Generator can be launched directly from the Object Manager.
1. Select the table for which you want to create the Stored Procedure. You can also include
all the tables in a database by selecting the group folder TABLE. In addition, if your Object
Manager is in Two Pane mode you can select certain tables by holding down either the
SHIFT or CTRL keys.
2. Once you have selected the tables you require, right click to launch the shortcut menu
3. Select Advanced > Procedure Generator
The Procedure Generator dialog box will then be launched.
Interface
Generation
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To start the generation process, click OK. The procedures will then be created for the selected
tables and types on your SQL-Server.

Creation progress is shown in the bottom right hand corner of
the dialog box.
Notes
●

●

If the CAST Knowledge Base is installed on the current server and the database that will
receive the new stored procedures is registered in it, procedure references are
automatically added to the Knowledge Base to maintain integrity.
In order for the generator to operate it must first have the correctly recorded primary
and foreign keys of the selected tables.

Results
When the creation operation has been completed, as well as adding the new Stored Procedure(s)
to the SQL-Server (and the Knowledge Base where appropriate) SQL-Builder will also place them
in the User List so that you can immediately begin work on them.
For more information about the User List, click here.

See Also
User List | Trigger Generator
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Trigger Generator

What does it do?
The Trigger Generator lets you produce a creation or update T-SQL script for all triggers linked
to one or more tables by reading information stored in the CAST Knowledge Base.
Execution of this script in the database takes into account the possible presence of a CAST
Knowledge Base where the database is registered and, if necessary, automatically includes the
updated information affecting the triggers in the CAST Knowledge Base.
Accessing the Trigger Generator
The Trigger Generator can be launched directly from the Object Manager.
1. Select the table for which you want to create the Trigger. You can also include all the
tables in a database by selecting the group folder TABLE. In addition, if your Object
Manager is in Two Pane mode you can select certain tables by holding down either the
SHIFT or CTRL keys.
2. Once you have selected the tables you require, right click to launch the shortcut menu
3. Select Advanced > Trigger Generator
The Trigger Generator dialog box will then be launched.
Interface
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●

●

●

●

The left hand section of the dialog box displays a list of tables you selected in the Object
Manager prior to launching this dialog box.
Use the Select All check box to include all tables displayed in the list. Alternatively you
can select those you require with the mouse (when a table is selected it will be highlighted
in dark blue).
The Template list box displays the name of the Template used to define the style of the
Trigger that will eventually be created. For more information about Templates, please click
here.
Handle links with other databases > Check this option if you want to SQL-Builder to
take into account links that your selected tables may have with other tables in different
databases.

Generation
To start the generation process, click OK. The Triggers will then be created for the selected
tables and on your SQL-Server.
SQL-Builder will produce insert, update, and delete triggers where necessary (for some tables,
no triggers may be created at all). The links between tables are examined and the required TSQL code is generated automatically maintaining referential integrity.
Notes
●

If the CAST Knowledge Base is installed on the current server and the database that will
receive the new triggers is registered in it, trigger references are automatically added to
the Knowledge Base to maintain integrity.

Results
When the creation operation has been completed, as well as adding the new Triggers(s) to the
SQL-Server (and the Knowledge Base where appropriate) SQL-Builder will also place them in the
User List so that you can immediately begin work on them. For more information about the
User List, click here.
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See Also
User List
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Templates
What are Templates?

When using the Stored Procedure Generator or Trigger Generator, you will be asked to select a
Template. These templates are used to define the style of the Stored Procedures and Triggers
that are generated.

The templates displayed in the generator dialog boxes
are called Default and DefaultC, and usually cover
most needs.

These are stored on your PC along with all the other CAST Product files as DEFAULT.STP (used
for general stored procedures and triggers) and DEFAULTC.STP (manages cascaded deletes at
the trigger level).
The templates contain a pattern that describes the SQL code that needs to be generated to
create the triggers and stored procedures. This pattern description contains several functions,
which can have reserved names corresponding to the type of object to be generated (trigger in
insert, delete procedure on foreign key etc...)
Modifying a Template
If you want to modify a template, you need to load it into SQL-Builder's SQL-Session and make
any changes manually (see below for more information about the code in a template).
To do this:
1. Click File and select Load SQL-Script.
2. Locate the file you require (DEFAULT.STP or DEFAULTC.STP) and click Open.
3. The file will be loaded into the SQL-Session so that you can make the changes direct to
the code.
4. When you have completed the modifications, click File and select Save or Save As.
Creating a new template
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To create a new template:
1. Load an existing template into the SQL-Session, make your changes and save the
template with a different name but retaining the .STP extension.
2. Next time you run the Stored Procedure Generator or Trigger Generator, you will see your
new Template in the Template list box.
Deleting a Template
To remove a template you no longer use from the list box in the Stored Procedure Generator or
Trigger Generator, delete it from your PC.
What's in a Template?
A template bears a name, which must not be a reserved key word of the template description
language. This name enables SQL-Builder to recognize templates according to the code to be
generated, and also to call functions from a template. The code associated with a template is TSQL enriched with specific functions. The names of functions of the template definition language
begin systematically with the character "%". These functions have lower-case names. The user
functions may be either in upper-case or in lower-case.
The basic functions are of two types. The simplest generate a contextual code, which means
that, at their place, in the generated script there is a unique data item (table, column name), or
a complex formula (join between two tables). The others are enumeration functions, making it
possible to run a user function as many times as necessary. The functions are also effective
inside remarks or character strings in T-SQL code.
Glossary of simple functions
%sqlname

Name of the T-SQL object to be generated (procedure or trigger
name)

%tablename

Name of the table for which the object is being generated

%childname

Name of the current child table (only in an adapted loop)

%parentname

Name of the current parent table (only in an adapted loop)

%childjoin

Join between main table and current child table (in a loop)

%parentjoin

Join between main table and current parent table (in a loop)

%ifupdatefk

Code "if update" on all primary key columns of the main table

%ifupdatepk

Code "if update" on all foreign key columns of the main table

%ifisnotnullfk

Code "if foreign key is not null"

%ifisnullfk

Code "if foreign key is null"
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%username

Name of current user in clear

%usertrigram

Current user's trigram

%currentdate

Current date

%currenttime

Current time (the same for all objects)

%database

Current database (default)

%server

Name of server (@@servername)

%delchildjoin

Join between main table and child table "deleted"

%delparentjoin

Join between main table and parent table "deleted"

%inschildjoin

Join between main table and child table "inserted"

%insparentjoin

Join between main table and parent table "inserted"

%maincolumntype

Type of current column (in a loop only)

%maincolumn

Name of current column (in a loop only)

%childcolumntype

Type of current column of the current child table (in a loop only)

%childcolumn

Name of current column of the current child table (in a loop only)

%parentcolumntype

Type of current column of the current parent table (in a loop
only)

%parentcolumn

Name of current column of the current parent table (in a loop
only)

%identitycolumntype

Type of identity column of the current table (in a loop only)

%identitycolumn

Name of identity column of the current table (in a loop only)

%triggermode

Type of trigger to be generated (insert, update, delete, or a
combination of the three)

Glossary of enumeration functions
%foreachcolumn

Enumerates the columns of the main table

%foreachpkcolumn

Enumerates the columns of the primary key of the main table

%foreachnotpkcolumn

Enumerates the columns of the main table, excluding those of the
primary key

%foreachidcolumn

Enumerates the column of the main table that is identity type if
there is one
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%foreachnotidcolumn

Enumerates the columns of the main table, excluding the identity
column

%foreachnotidnotpkcolumn

Enumerates the columns of the main table, excluding those of the
primary key and any identity column

%foreachchildcolumnpair

Enumerates the pairs of columns in join between the main table
(primary key side) and the current child
table (foreign key side). Available only in a %foreachchild
enumeration

%foreachparentcolumnpair

Enumerates the pairs of columns in join between the main table
(foreign key side) and the current parent
table (primary key side). Available only in a %foreachparent
enumeration

%foreachchild

Enumerates the child tables of the main table

%foreachparent

Enumerates the parent tables of the main table

User functions
The basic functions, like the user functions, take no parameters. The name of the function is
simply replaced by the text it contains. There may however be nested functions. The
enumeration functions, for their part, require at least one parameter, the name of a user function
to be run for each element of the enumeration. Optionally, a second parameter can be added, in
order to indicate a separator to be added between elements (often a comma, a linefeed, or a TSQL combination key word, such as and). An enumeration function generates no T-SQL source
by itself, but the user function that follows it will give rise to as many successive source pieces as
there are elements in the enumeration. Enumerations can be nested (for example, one can list
pairs of columns in join between main table and child table inside the enumeration of child
tables).
The syntax to be used for a loop is as follows:
%foreach_xxx %user_function "separator"
The end of line indicates the end of the separator if the latter is not delimited by quotes or
double quotes. If the text of the separator is delimited, the end of line is ignored. No SQL code
may be placed after an enumeration function. The separator may contain tabulation, carriage
return, and line feed characters in C, i.e. \t, \r, and \n, respectively.
Reserved user function names
These functions are in fact models of procedures and of triggers. Their names are sufficiently
explicit, and are moreover entirely in upper-case to help you spot them. These names are:
INSERT_PROC
UPDATE_PROC
DELETE_PROC
DELETE_FOREIGN_PROC
EXIST_PROC
INSERT_TRIGGER
UPDATE_TRIGGER
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DELETE_TRIGGER
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Graphical Object Manager
●

What is the Graphical Object Manager?

●

Launching the Graphical Object Manager

●

Add Linked Objects dialog box

●

Linked Objects Selection dialog box

●

Graphical Object Manager Window

●

Handling Objects in the Graphical Object Manager window
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What is the Graphical Object Manager?

What is the Graphical Object Manager?
The Graphical Object Manager enables you to view the links between objects you have selected
in the Object Manager - in other words a Graphical View will be created that will actually enable
you to visualize objects and any links that they may have with other server side objects. In this
way you can find out what objects would be affected if you were to modify an object, thus
avoiding problems at a later date.
Notes
●

●

Please note that SQL-Builder's Graphical Object Manager is based entirely on CAST's
viewer module, but at a much more basic level and with some functional differences
explained here.
The Graphical Object Manager cannot handle objects that have multi owners. In some
cases, links and objects may not be displayed in the view following an Add Linked Objects
operation.

See Also
Launching the Graphical Object Manager
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Launching the Graphical Object Manager

Launching the Graphical Object Manager
When the Object Manager is active (i.e.: when you are working in it) there are two ways to open
the Graphical Object Manager:
1. Select an object (left click in the Object Manager to highlight it) or select several objects
by left clicking the first object and then holding down the SHIFT or CTRL keys and then
selecting the other objects. Then click the

button in the bottom

right hand corner of the Object Manager (if you are working in Two Pane mode).
2. You can select the objects you want to work with as described above, right click the
object (or any of the objects you have highlighted) to launch the shortcut menu and
then select the Graphical Object Manager option from the menu.
3. You can also open an object (click here for more information about this), and select
Graphical View from the object specific menu.
4. The Add Linked Objects dialog box will then be launched.
Notes
●

You can launch as many Graphical Object Managers as you require, simply repeat the
steps above to open a new window

Differences between the Graphical Object Manager and CAST's viewer module
●

Objects or links cannot be created, modified, or deleted.

●

Information is read only from the system catalog.

Automatically launching CAST's viewer module instead
Because the Graphical Object Manager is based on CAST's viewer module, you can choose
whether you want to launch CAST's viewer module instead of the Graphical Object Manager.
To do so:
1. Open the OM Options tab (click Options, General Configuration, then select the OM
Options tab).
2. Select Call Enlighten when possible.
3. Next time you launch the Graphical Object Manager, CAST's viewer module will be
launched instead.
Notes
●

When using the viewer module instead of the Graphical Object Manager, the object on
which you are launching the GOM must be registered and synchronized (i.e. via CAST
Analysis Manager) in the Knowledge Base. If not, no object will be placed in the
Graphical View. This is because CAST's viewer module can only read information from the
Knowledge Base.
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Launching the Graphical Object Manager
●

You must use CAST's viewer module at least once before selecting this option. If not, SQLBuilder will not be able to open it.
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Add Linked Objects dialog box
The Add Linked Objects dialog box will be launched immediately after you have selected either
of the options described here to launch the Graphical Object Manager:

This dialog box acts as a filter. By selecting the various check boxes, you can tell SQL-Builder
what type of linked objects you want to add to the Graphical Object Manager.
If you are only interested in the links your selected object has to tables and procedures for
example, then check the Add tables and the Add procedures check boxes, then click the OK
button. Alternatively, check all the check boxes to add ALL the linked objects to the Graphical
Object Manager, and then click OK.
At this point one of two things will happen:
1. If you only selected one object in the Object Manager to start with, then when you press
the OK button to confirm your choices, the Linked Objects Selection dialog box will be
launched.
2. If you selected more than one object in the Object Manager to start with, when you
press the OK button SQL-Builder will automatically add any objects corresponding to
your choices in the above dialog box and the original objects to the Graphical Object
Manager. The Linked Objects Selection dialog box will be skipped.
Notes
●

●

●

If you want to abort the selection of object types, click the Cancel button, or
, this will
close the dialog box and will add only the object or objects that you originally selected to
the Graphical Object Manager and any links that exist between these objects (if at all).
In addition, if you click OK without checking ANY check boxes, SQL-Builder will also add
only the originally selected objects to the Graphical Object Manager.
If for some reason this dialog box doesn't appear when you click the Graphical Object
Manager button, make sure that the Add Linked Objects option is checked in the OM
Options tab. To access this tab, click the Options menu when using the Object Manager,
then select the General Configuration option from the drop down menu, then click the
OM Options tab.
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file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/GOM/addlinked.htm (2 of 2) [10/07/2008 10:40:26]

Linked Objects Selection dialog box

Linked Objects Selection dialog box
If you only selected one object in the Object Manager when you started the Graphical Object
Manager process (see here for more details about how to launch the Graphical Object
Manager), when you press the OK button in the Add Linked Objects dialog box to confirm your
choices, the Linked Objects Selection dialog box will be launched:

This dialog box displays all the objects which are linked to your original object that you selected
in the Object Manager, together with a heading indicating the object type. It enables you to
select the objects that you want to insert into the Graphical Object Manager.
When it first opens, by default all the objects will be highlighted and the Select All check box
will also be checked. If you then press the OK button, all these objects will be placed in the
Graphical Object Manager.
If you only want to place some of the objects in the list into the Graphical Object Manager:
1. Clear the Select All check box, which will un-highlight the objects in the list.
2. Select the objects you require by left clicking with the mouse on the objects and at the
same time holding down the SHIFT or CTRL keys.
3. Click the OK button.
If you press the None button, SQL-Builder will add none of the linked objects to the Graphical
Object Manager, and only add the object you originally selected.
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Linked Objects Selection dialog box

See Also
Graphical Object Manager Window
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Graphical Object Manager Window
Once the you have selected the objects that you want to place in the Graphical Object Manager in
the Linked Objects Selection dialog box (click here for more information about how to do this), the
Graphical Object Manager will be launched:

By default, when the Graphical Object Manager first launches, the objects selected in the Linked
Objects Selection dialog box are then placed in the Graphical Object Manager in a circular fashion.
The central object will be the object that you originally selected in the Object Manager to start the
process.
Understanding the view
The objects in the view are all displayed in a unique way so that you can easily distinguish one type
from another. The red arrows denote a link between one object and another and the direction of the
arrows indicates whether one object is either calling the other object or is called by the other object.
You now have a snapshot image of part of your server, which makes understanding the complexities
much easier.
See Also
Handling objects in the Graphical Object Manager window
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Graphical Object Manager Window
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Handling objects in the Graphical Object Manager window

Handling Objects in the Graphical Object Manager window
●

Opening an Object

●

Refreshing the GOM

●

Objects and Links in the GOM - how to select, move, arrange, remove, undo/redo etc...
objects and links

●

Adding more Linked Objects

●

Selecting Linked Objects

●

Other Available Handling Functions - Zoom Options, Adjusting object size, Duplicate,
Square Form etc...
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Opening an object from the GOM

Opening an object from the GOM
To open an object directly from the Object Manager for editing purposes you can:
1. Double-click it in the Graphical Object Manager window.
2. Select the object in the Graphical Object Manager, then click the Graph menu located on
the toolbar and select the Open Object option from the drop down menu.
3. Select the object in the Graphical Object Manager, and then press the ENTER key on your
keyboard.
All options will launch the object's dedicated editor (for more information on dedicated editors,
click here) enabling you to make any modifications that may be necessary, save it on the server,
or compile it etc...
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Refreshing the GOM

Refreshing the GOM
If you do open an object from the Graphical Object Manager, modify it and then save it on the
server, you can use the Refresh Graphic option to update the Graphical Object Manager to
reflect any changes you may have made.
To access the Refresh Graphic function:
1. Click the Graph menu located on the toolbar when the Graphical Object Manager
window is active, then select the Refresh Graphic option from the drop down menu.
The Graphical Object Manager will then be re-drawn to reflect any objects or links modified or
dropped.
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Objects and Links in the GOM
Please make sure you are working in Select Mode before you use any of the following options.
Click here to find out more about how to do this.
Selecting Objects and Links
Selecting an object is a simple operation:
1. Left-click once on the object you require.
You can also select multiple objects:
1. Hold down either the SHIFT or CTRL keys down and then left-click the objects you want
to select.
2. You can draw a "box" around the objects that you want to select, by holding the left
mouse button down and then moving the mouse to surround the objects you want to
select.
3. Or you can click the Edit menu located on the toolbar and select the Select All option
from the drop down menu. This will select ALL the objects in the window.
When an object has been selected in the Graphical Object Manager, an outline box is displayed
around it:

Selecting Links
You can select links by left clicking once on the link. A small selection box will then appear on
the link as shown in the image.

Moving objects and Reshaping links
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Moving Objects
Once you have selected the objects you require, you can them move them. To do so:
1. Select the object or objects you want to move
2. Left click again, hold down the mouse button and drag the object(s) to their new
destination.
3. Release the mouse button to place the object(s) at this destination.
Reshaping Links
Links can also be reshaped, by adding "corners" to the line between two object.
1. Left-click a link, hold the mouse button down and drag the link to the position you require.
You can do this as many times as necessary.
To remove all the corners you have added to a link:
1. Right click the link to launch the contextual menu.
2. Select the Remove Corners option.
3. The link will then revert to its default straight line setting.
Arranging Objects
There is also an option enabling you to automatically arrange objects if they have become
disorganized and difficult to understand. This function may be more practical than manually
moving individual objects if there are a large number in the window. To access this option:
1. Click the Graph menu located on the toolbar when the Graphical Object Manager is the
active window?
2. Select the Arrange Objects option from the drop down menu.
All the objects in the window will then be re-arranged in a way that is easy to understand.
Notes
●

●

This option is extremely practical when there are large numbers of objects in the window,
however, with only a few objects, it may be easier to re-arrange objects manually.
This function is always global. All previously made manual modifications will be lost.
However, the function can be 'undone' by using the undo command which will recover any
data that is lost accidentally.

Removing objects and links
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Objects and Links in the GOM

If you want to remove any objects or links from the Graphical Object Manager window you
can do so by first selecting the object(s) or link(s), then you can:
●

●

●

Press the DEL button on your keyboard.
Click the Edit menu located on the toolbar and then select the Delete Graphic option
from the drop down menu.
Click the Edit menu located on the toolbar and then select the Cut option from the drop
down menu.

●

Click the

button located on the toolbar.

●

Use the shortcut key CTRL+X.

The last three options will place the data in the clipboard for you to use whenever you require
(by using the Paste option).
Notes
●

When you remove OBJECTS from the Graphical Object Manager window, they are NOT
removed from the database/schema (to do this you need to drop the object).

Sending objects ad links to the Foreground/background
The Foreground and Background options can easily enhance the understanding of the
Graphical Object Manager - particularly if you have a large number of objects displayed.
These options enable you to send a selected object(s)/link(s) to the background or bring them
to the foreground.
1. Select the object or link.
2. Right click to launch the respective contextual menus.
3. Select either the Foreground or Background options.
For example:
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Here, the Table object
is behind the link.

After the use of either
the Foreground
option on the object,
or the Background
option on the link, the
view is rendered
easier to understand.

Undo/redo
If at any time you move, remove or re-arrange an object or a link by accident, you can
always use the Undo option to undo any mistakes. You can also Redo the undo option:
1. Click the File menu located on the toolbar and select the Undo or the Redo options from
the drop down menu
2. Click either the

button (Undo) or the

button (Redo), both located on the toolbar

3. Or use the respective shortcut keys CTRL+Z (Undo) or CTRL+Y (Redo)

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/GOM/Handling/objlinks.htm (4 of 4) [10/07/2008 10:40:38]

Adding more linked objects

Adding more linked objects
Once you have added the objects to the Graphical Object Manager, you can then select another
object or objects and add further linked objects.
To do this you first need to select an object or objects in the Graphical Object Manager, then
you can either:
1. Click the Graph menu and then select the Add linked objects... option from the drop
down menu.
2. Or you can right click on the selected object or objects to open the shortcut menu and
then select the Add linked Objects... option.
Both of these options will then launch the Add Linked Objects dialog box. Once you have made
your choice of object types you want to add to the Graphical Object Manager, the Linked Objects
Selection dialog box will be launched. This lets you specifically select which objects you want to
add to the Graphical Object Manager and once you are satisfied with your choices, click the
OK button.
At this point the new linked objects will be added to the Graphical Object Manager as
displayed below:
Before the Add Linked Objects option is selected:
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Adding more linked objects

After the new linked object has been added to the Graphical Object Manager:
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file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/GOM/Handling/add.htm (3 of 3) [10/07/2008 10:40:40]

Selecting linked objects

Selecting linked objects
The Select Linked Objects option enables you to find out which objects are directly linked
(whether calling or called) to the object you initially select in the Graphical Object Manager.
You can access this option by:
1. Selecting the object you require in the Graphical Object Manager window.
2. Right clicking the selected object to launch the contextual menu.
3. Selecting the Select Linked Objects option.
This will then automatically highlight (i.e.: a selection box will appear) all other objects in the
Graphical Object Manager that are directly linked to the first selected object, as demonstrated
by the image below and on the right:
Before Select Linked Objects option:

After Select Linked Objects option:
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Selecting linked objects
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Other Available Functions
Zoom Options
When your Linked Objects are first placed in the Graphical Object Manager, the view will be
zoomed in close, in other words, you will not be able to see all the objects. Thus in order for you
to be able to view all the objects in the Graphical Object Manager, you need to use the Zoom
Options:
How to Zoom Out
1. You can click the Graph menu located on the toolbar, select the Zoom option from the
drop down menu and then select the Zoom Out option from the next sub-menu.
2. You can use the shortcut key: CTRL+ "-" (the minus key on the numeric key pad).
button located on the toolbar.

3. Or use the

This will zoom out one level, thus you need to repeat the process until you reach an appropriate
viewing level.
Zoom In
This process is virtually identical to the Zoom Out process above:
1. You can click the Graph menu located on the toolbar, select the Zoom option from the
drop down menu and then select the Zoom In option from the next sub-menu as shown
on the right.
2. You can use the shortcut key: CTRL+ "+" (the plus key on the numeric key pad).
3. Or the

button located on the toolbar.

Global View
The Global View option is particularly useful if you want to quickly view ALL the objects that are
in the Graphical Object Manager in one move:
1. Click the Graph menu located on the toolbar, select the Zoom option from the drop down
menu and then select the Global View option from the sub-menu
2. Or you can click the

located on the toolbar

One to One
This option is only accessible by clicking the

button located on the toolbar. This will set the

zoom factor to 100%
Manual Zoom Factor
combo box to manually input the zoom factor, or click the down arrow to
Use the
select a predefined factor from the drop down list.
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Other Available Functions

Notes
●

Please also see the section below on Select and Zoom Modes

Adjusting the object size
This option is useful for expanding the size of objects that have been placed (by default) in the
Graphical Object Manager in a contracted form. You may want to do this if you cannot see all
the information in a Table (for example). To access this feature you first need to select an object
in the Graphical Object Manager, then you can:
1. Click the Graph menu located on the toolbar and select the Adjust Object Size option
from the drop down menu as shown on the left.
2. Right click on the selected object in the Graphical Object Manager to launch the
contextual menu, then select the Adjust Object Size option from the menu.
3. Alternatively you can use the shortcut key: CTRL+J
The two images below show the feature in operation on a T-SQL table:

A T-SQL table displayed in the Graphical Object Manager
by default in its contracted form:

The same Table after the implementation of the Adjust
Object Size option:

Notes
●

You can also adjust the size of an object manually by selecting the object, then left
clicking and holding down the mouse button on the selection box handles and then
dragging the mouse pointer until you reach the required size.
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Duplicate (SQL-Server/Sybase users only)
The Duplicate function enables you to create identical objects in the Graphical Object
Manager. To use this function:
1. Select the object you want to duplicate, (click here for more information on how to do
this).
2. Right click this object to launch the contextual menu and then select the Duplicate
option.
At this point, an identical object will appear next to the object you selected to launch the option.
Its name will be followed by a number (in the form OBJECT NAME:NUMBER) to indicate that it is
a copy of the original - in addition, the original object's name will also be followed by the
number 1 to indicate that it is in fact the original object.
You can Duplicate any of the subsequent copies or the original object as many times as is
necessary.
Select/Zoom Mode
The Select and Zoom modes allow you to switch between:
●

●

Select mode (which, as the name suggests enables you to open, select, remove objects
and/or links - for example)
Zoom Mode, which, when activated, enables you to zoom in close to an area in the
Graphical Object Manager.

To access these functions you can:
1. Click the Graph menu located on the toolbar, select the Mode option from the drop down
menu, and then choose either Select or Zoom Mode as you require.
2. Alternatively use the shortcut keys: CTRL+F7 for Select Mode and CTRL+F8 for Zoom
Mode
Notes
●

A check mark will appear next to the mode which is currently active.

Square Form
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This options concern only Links in the Graphical Object Manager, and can thus only be
accessed by selecting a link, and then right clicking on that link to launch the contextual menu.

Square Form
By selecting this option the link will be displayed in square
form as displayed in the image on the left. In addition, a tick
will appear next to the item in the contextual menu to indicate
that it is the active mode for that link. To remove the Square
Form, simply re-select the link and then choose the Square
Link option again from the contextual menu. The link will
revert to its default straight line.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/GOM/Handling/other.htm (4 of 4) [10/07/2008 10:40:44]

Object Editors

Object Editors
●

What is an Object Editor?

●

Default Editor

●

Function Editor

●

Stored Procedure Editor

●

Rule Editor

●

Table Editor - see also Working with Constraints

●

Trigger Editor

●

UDT Editor

●

View Editor

●

Common Object Editor Specific Commands and Options

●

Working With Constraints
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What is an Object Editor?

What is an Object Editor?
An Object Editor is the dialog box displayed when you open an object in the Object Manager. You
can use it in two ways:
●

To enter code directly using the script editor in order to modify or create an object

●

To use the dialog box options and parameters in order to modify or create an object

The choice of which method you use is down to individual choice - alternatively you can use a
combination of both.
Each object type (whether table, function, stored procedure etc.) has its own specific editor with
specific options and parameters. Some options and parameters are common to all object types.
See Also
Default Editor | Function Editor | Stored Procedure Editor | Rule Editor | Table Editor | Trigger
Editor | UDT Editor | View Editor
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Default Editor

Default Editor

Upper Section
The upper section contains the definition of the Default. The definition will begin with the
keyword "As" (as shown above) and the default definition in the form "AS @state like "[A-Z][AZ]"" will follow.
Lower Section
The lower section contains errors that occur when you create the Default. You can select these
errors using the Next Error and Previous Error commands located in the Edit menu.
This lower section is generally hidden when no errors occur. You can alter the size of the two
sections using the splitter bar: place the mouse pointer over the division between the two
sections (the mouse will then change form), then click and hold down the left mouse button and
drag the section to the required size.
Editor Title
The title of the Default Editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname [(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a modification has been made to the
object, but that it remains unsaved.
Notes
●

●

Only Defaults owned by 'dbo' are dealt with by SQL-Builder (see Owner Management for
more information about this).
If you make any modifications to the object, you will need to send it to the server in order
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Default Editor

that the changes are taken into account. See Saving objects (sending objects to the
server) for more information.
See Also
Owner Management | Saving Objects
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Function Editor

Function Editor

Main Editor Window
The Function Editor has eight tabs which can each be accessed by clicking the corresponding name.
Each tab is explained below.
Owner Field

The Owner text box displays the name of the object owner. You can
alter the owner by clicking the down arrow and selecting a new owner.
Please see Owner Management for more information about this.

Name Field

The Name text box at the top of the Editor displays the name of
object. If you want to change the object's name, left click in the text
box and type the new name you require.
Click here to find out how to Save an object.
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Editor Title

The title of the editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname
[(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a
modification has been made to the object, but that it remains unsaved.

Editor tab
This tab is divided into two sections.
Upper section

This section contains a grid displaying column information for the
current object. You can enter new columns here or alter exiting ones.

Lower section

This section contains the objects' body code (you can enter code
directly should you require) and the Flow Chart feature.
When you first open the object, the Flow Chart section will NOT be
visible. Use the center "splitter" to activate the Flow Chart. To find out
more about the Flow Chart, click here.

Return Type tab
This tab enables you to define the function type.
Inline
Tablevalued
Scalar

This option enables you to force the Function to return a Table which is the result of a
single SELECT statement.
The Function will return a single data value of the type defined in the field Type. The
length of the type can be set in the Length field.

MultiThe Function will return a Table whose structure is defined in the Table Definition field by
statement using the following syntax
Tablevalued
{ TABLE (< table_type_definition >) | < table_type_definition > }
< table_type_definition > ::=
{ < column_definition > | < table_constraint > } [ ,... ]
< column_definition > ::=
column_name scalar_data_type
[ COLLATE collation_name ]
[ [ DEFAULT constant_expression ] | IDENTITY [ ( seed, increment ) ] ]
[ ROWGUIDCOL ]
[ < column_constraint > ]
< column_constraint > ::=
{ [ NULL | NOT NULL ]
| [ PRIMARY KEY | UNIQUE ]
| CHECK ( logical_expression )
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Function Editor

}
< table_constraint > ::=
{ { PRIMARY KEY | UNIQUE } ( column_name [ ,...] )
| CHECK ( search_condition )
}
The name of the table is defined in the field Table Name and must begin with "@".
Statements in the Function body insert rows into this variable to build the table result
returned by the Function.
Comments tab
Business Function

The section enables you to define a Business Function for your
object. A Business Function (BF) briefly describes what an object
actually does. Enter the text you require, then send the object to the
server. Next time you open the object, the BF will be visible in the
Script tab. For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU Date BF: 03/09/2001
*
The sections immediately beneath the main BF section display which
user last added or modified the BF and when this was done.
Notes
●

If you want to force SQL-Builder to remind you (with a warning
dialog box) that a BF has not been set every time you save an
object, you can do this in the Compiled Objects tab by selecting
the BF is required option.
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Maintenance Comment

This section enables you to enter a Maintenance Comment for your
object. In practice this means adding a comment each time a user
modifies or updates the object so that future developers can see what
has been done before and when. Enter the text you require, then send
the object to the server. Next time you open the object, the
Maintenance Comment and all other previous changes (with date) to
the Maintenance Comment will be visible in the Script tab and also in
the History section (explained below). For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU
Date BF: 03/09/2001
*
*Author: JHU
Date: 03/09/2001
* Comment: Modified Permissions
*Author: JHU
Date: 03/09/2001
* Comment: Updated BF
History
This section displays a read-only history of all the Maintenance
Comments added to the current object together with the addition date.
Add the comment in the main Maintenance Comment section.
Author
The sections immediately beneath the main Maintenance Comment
section display which user last added or modified the comment and
when this was done.
Notes
●

If you want to force SQL-Builder to remind you (with a warning
dialog box) that a Maintenance Comment has not been set every
time you save an object, you can do this in the Compiled Objects
tab by selecting the Maintenance is required option.

Insert Code tab
Code run before creation

Enter the code in this section that you want to be run BEFORE the
object is created.

Code run after creation

Enter the code in this section that you want to be run AFTER the object
is created.
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Notes
●

The code entered into these two columns will not be visible in the Script tab.

Dependencies tab
This tab displays the server objects that are calling and are called by the object. By left-clicking on an
object in either of the two lists and then right-clicking to launch the shortcut menu, you can open the
linked object and access its properties as well as modify it if necessary.
Click the

button to refresh the displayed data in case of changes to other objects.

Options tab
With Schema Binding

Select this option if you want Schema Binding to be taken into
account: Binds the view to the schema.
When SCHEMABINDING is specified, the select_statement must include
the two-part names (owner.object) of referenced tables, views, or userdefined functions.
Views or tables participating in a view created with the schema binding
clause cannot be dropped unless that view is dropped or changed so
that it no longer has schema binding. Otherwise, the SQL-Server raises
an error. In addition, ALTER TABLE statements on tables that
participate in views that have schema binding will fail if these
statements affect the view definition.

Permissions tab
This section displays the permissions for the current object. To find out more information about this tab
and the way in which SQL-Builder handles permissions, please click here.
Script tab
The Script tab contains the actual object script. The script in this tab is in Read-Only mode and to alter it,
you need to use the other tabs in the editor.
Click File > Save as to save the script in a .SQL file. A standard Windows Save dialog box will be
launched enabling you to select the file's name and location.
Notes
●

●

Functions are only available when using a Microsoft SQL-Server 2000 or above.
If you make any modifications to the object, you will need to send it to the server in order that the
changes are taken into account. See Saving objects (sending objects to the server) for more
information.
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Stored Procedure Editor

Stored Procedure Editor

Main Editor Window
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Stored Procedure Editor

The Stored Procedure Editor has seven tabs which can each be accessed by clicking the
corresponding name. Each tab is explained below.
Owner Field

The Owner text box displays the name of the object owner. You
can alter the owner by clicking the down arrow and selecting a
new owner. Please see Owner Management for more information
about this.

Name Field

The Name text box at the top of the Editor displays the name of
object. If you want to change the object's name, left click in the
text box and type the new name you require.
Click here to find out how to Save an object.

Editor Title

The title of the editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname
[(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a
modification has been made to the object, but that it remains
unsaved.

Editor tab
This tab is divided into two sections.
Upper section

This section contains a grid displaying column information for the
current object. You can enter new columns here or alter exiting
ones.

Lower section

This section contains the objects' body code (you can enter
code directly should you require) and the Flow Chart feature.
When you first open the object, the Flow Chart section will NOT
be visible. Use the center "splitter" to activate the Flow Chart. To
find out more about the Flow Chart, click here.

Comments tab
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Business Function

The section enables you to define a Business Function for your
object. A Business Function (BF) briefly describes what an object
actually does. Enter the text you require, then send the object to
the server. Next time you open the object, the BF will be visible
in the Script tab. For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU Date BF: 03/09/2001
*
The sections immediately beneath the main BF section display
which user last added or modified the BF and when this was
done.
Notes
●

Maintenance Comment

If you want to force SQL-Builder to remind you (with a
warning dialog box) that a BF has not been set every time
you save an object, you can do this in the Compiled
Objects tab by selecting the BF is required option.

This section enables you to enter a Maintenance Comment for
your object. In practice this means adding a comment each time
a user modifies or updates the object so that future developers
can see what has been done before and when. Enter the text you
require, then send the object to the server. Next time you open
the object, the Maintenance Comment and all other previous
changes (with date) to the Maintenance Comment will be visible
in the Script tab and also in the History section (explained
below). For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU
Date BF: 03/09/2001
*
*Author: JHU
Date: 03/09/2001
* Comment: Modified Permissions
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*Author: JHU
Date: 03/09/2001
* Comment: Updated BF
History
This section displays a read-only history of all the Maintenance
Comments added to the current object together with the addition
date. Add the comment in the main Maintenance Comment
section.
Author
The sections immediately beneath the main Maintenance
Comment section display which user last added or modified the
comment and when this was done.
Notes
●

If you want to force SQL-Builder to remind you (with a
warning dialog box) that a Maintenance Comment has not
been set every time you save an object, you can do this in
the Compiled Objects tab by selecting the Maintenance is
required option.

Insert Code tab
Code run before
creation

Enter the code in this section that you want to be run BEFORE the
object is created.

Code run after creation

Enter the code in this section that you want to be run AFTER the
object is created.

Notes
●

The code entered into these two columns will not be visible in the Script tab.

Dependencies tab
This tab displays the server objects that are calling and are called by the object. By left-clicking
on an object in either of the two lists and then right-clicking to launch the shortcut menu, you
can open the linked object and access its properties as well as modify it if necessary.
Click the

button to refresh the displayed data in case of changes to other objects.

Options tab
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With Recompile

Select this option if you want to With Recompile to be taken
into account.

Permissions tab
This section displays the permissions for the current object. To find out more information about
this tab and the way in which SQL-Builder handles permissions, please click here.
Script tab
The Script tab contains the actual object script. The script in this tab is in Read-Only mode and to
alter it, you need to use the other tabs in the editor.
Click File > Save as to save the script in a .SQL file. A standard Windows Save dialog box will be
launched enabling you to select the file's name and location.
Notes
●

If you make any modifications to the object, you will need to send it to the server in order
that the changes are taken into account. See Saving objects (sending objects to the
server) for more information.
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Rule Editor

Upper Section
The upper section contains the definition of the Rule. The definition will begin with the keyword
"As" (as shown above) and the Rule definition in the form "AS @state like "[A-Z][A-Z]"" will
follow.
Lower Section
The lower section contains errors that occur when you create the Rule. You can select these
errors using the Next Error and Previous Error commands located in the Edit menu.
This lower section is generally hidden when no errors occur. You can alter the size of the two
sections using the splitter bar: place the mouse pointer over the division between the two
sections (the mouse will then change form), then click and hold down the left mouse button and
drag the section to the required size.
Editor Title
The title of the Rule Editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname [(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a modification has been made to the
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object, but that it remains unsaved.
Notes
●

●

Only Rules owned by 'dbo' are dealt with by SQL-Builder (see Owner Management for
more information about this).
If you make any modifications to the object, you will need to send it to the server in order
that the changes are taken into account. See Saving objects (sending objects to the
server) for more information.

See Also
Owner Management | Saving Objects
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Table Editor

Main Editor Window
The Table Editor has several tabs which can each be accessed by clicking the corresponding
name. Each tab is explained below.
Owner Field

The Owner text box displays the name of the object owner.
Please see Owner Management for more information about this.

Name Field

The Name text box at the top of the Editor displays the name of
object.

Data-Session

button (located in the top right-hand corner) will
The
launch the Data-Session which allows you to manage the data in
your table.
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Editor Title

The title of the editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname
[(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a
modification has been made to the object, but that it remains
unsaved.

Column tab
The main Grid section displays various information about the table columns, providing the name,
type (including length and scale), default value and any comments that may have been added.
The characteristics of the constraints can also be viewed here.
Numerous checks are carried out to eliminate any input errors or incompatibility with regard to
the server characteristics and version - this will be signaled in the bottom left-hand corner with
the series of lights:
●

Green for "Status OK"

●

Orange for "Busy"

●

Red for "Error has occurred"

When an error does occur when you input new data, the red light will show in the bottom lefthand corner and a brief explanation of the problem will appear in the text box to the right of the
status lights.
Please note that when creating a new column, its name must be entered before any other
parameters.
Buttons
This button will insert a new column below any already existing. You can then enter
the parameters as required. You can also:
●

right-click in the editor and select New Column

●

or use CTRL+SHIFT+N

This button will insert a new column above the column selected before clicking the
button. You can then enter the parameters as required. You can also:
●

right-click in the editor and select Insert Column

●

or use CTRL+SHIFT+I
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Clicking this button will delete the selected column. You can also:
●

right-click in the editor and select Suppress Column.

●

or use DEL

Clicking this button will print a list of the columns in the Table.
Click this button to copy the selected column to the clipboard. You can also:
●

right-click in the editor and select Copy Column.

●

or use CTRL+SHIFT+C

Click this button to paste a column (that you already have copied to the clipboard) into
the Table, below the existing columns. The column will be renamed XXX1 (where XXX
equals the column name) so as to avoid confusion with the existing column.
You can also:
●

right-click in the editor and select Paste Column.

●

or use CTRL+SHIFT+V

Clicking this button will move the selected column up one level. Repeat the process until
you reach the required position.
You can also:
●

right-click in the editor and select Move Row then Up.

●

or use CTRL+SHIFT+UP (arrow key)

Clicking this button will move the selected column down one level. Repeat the process
until you reach the required position.
You can also:
●

right-click in the editor and select Move Row then Down.

●

or use CTRL+SHIFT+DOWN (arrow key)

Clicking this button will automatically launch the table's associated UDT (User Data
Type). If grayed out, no UDTs are associated to the table. Click here for more
information on UDTs.
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Notes
●

A Drag and Drop option is also available to move columns: select a column or columns
that you want to move with the left mouse button, then move the mouse to the
destination position and release the mouse button to drop the columns.

Keys/Constraints
This tab lists the various constraints associated with the table columns. Each constraint is
described as follows:
●

Name (constraint name)

●

Type (constraint type)

●

Level (level of constraint)

●

Column(s)\Check (name of column on which constraint is situated)

●

References (database name and object name of constraint)

●

State (modified or new etc...)

You can create new constraints (by clicking the

button) and modify (with the

button after selecting the constraint) and/or drop (with the

button after

selecting the constraint) existing constraints. As with the general editing procedure, checks are
also carried out to eliminate any inconsistencies or inaccuracies. The name of the constraint, its
type, columns referenced by the constraint, external columns (i.e.: Foreign Keys) as well as the
constraint’s status (modified, new, etc.) are also displayed in the list.
When you click the New button, a special Constraints dialog box will be launched containing a
series of tabs corresponding to each type of constraint you can create. This is explained here.
The same is true for the Drop and Modify commands, which will launch the associated individual
constraint tab.
Dependencies tab
This tab displays the server objects that are calling and are called by the object. By left-clicking
on an object in either of the two lists and then right-clicking to launch the shortcut menu, you
can open the linked object and access its properties as well as modify it if necessary.
Click the

button to refresh the displayed data in case of changes to other objects.

Permissions tab
This section displays the permissions for the current object. To find out more information about
this tab and the way in which SQL-Builder handles permissions, please click here.
General tab
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This tab contains complementary information about the table depending on the server type you
are using. Thus you can specify the Table storage location from the drop down list box:
Filegroup for those using Microsoft servers and Segment for those using Sybase/ASE servers.
If you are using a Sybase/ASE server, you can also specify further options concerning the
storage of the Table such as:
Partition check box
If this option is selected the table will be partitioned: you can select the number of partitions in
the Partition Value text box immediately to the right of the check box.
Max Rows per Page which limits the number of rows on data or index pages. Its main use is to
improve concurrency in all pages-locked tables, since reducing the number of rows can reduce
lock contention.
Identity Gap
This option is only available when working with a Sybase server version 12 or above.
Enables you to input the interval for the identity values of the table. This value redefines the
interval parameter of the system identity values for the chosen table.
Script tab
The Script tab contains the actual Table script and is automatically refreshed after every drop or
create order. The

button is particularly useful when carrying out Alter Table

modifications after which the script will not be refreshed unless the option is selected (see the
for more details).
Click File > Save as to save the script in a .SQL file. A standard Windows Save dialog box will be
launched enabling you to select the file's name and location.
The script in this tab is in Read-Only mode. To alter it, use the Column tab.
Notes
●

If you make any modifications to any of the tabs in the Table Editor, you will need to send
the Table to the server in order that the changes are taken into account. See Saving
objects (sending objects to the server) for more information. See the section on the Data
Preservation Assistant for more information about saving a modified Table.

See Also
Working With Constraints | Table Editor Configuration tab | Working with remote tables
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Trigger Editor

Trigger Editor

Main Editor Window
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The Trigger Editor has several tabs which can each be accessed by clicking the corresponding
name. Each tab is explained below.
Owner

The text box to the left of the displays the name of the object
owner. Please see Owner Management for more information
about this.

Name Field

The Name text box at the top of the Editor displays the name of
object. If you want to change the object's name, left click in the
text box and type the new name you require.
Click here to find out how to Save an object.

Editor Title

The title of the editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname
[(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a
modification has been made to the object, but that it remains
unsaved.

Editor tab
This tab is divided into two sections:
Upper section

After (SQL-Server 2000 only)
Specifies that the trigger is fired only when all operations
specified in the triggering SQL statement have been executed
successfully. All referential cascade actions and constraint checks
must also succeed before this trigger can be executed. AFTER is
the default setting, if FOR is the only keyword specified. AFTER
triggers cannot be defined on views.
Instead of (SQL-Server 2000 only)
Specifies that the trigger is executed instead of the triggering
SQL statement, thus overriding the actions of the triggering
statements.
At most, one INSTEAD OF trigger per INSERT, UPDATE, or
DELETE statement can be defined on a table or view. However, it
is possible to define views on views where each view has its own
INSTEAD OF trigger.
INSTEAD OF triggers are not allowed on updateable views WITH
CHECK OPTION. SQL Server will raise an error if an INSTEAD OF
trigger is added to an updateable view WITH CHECK OPTION
specified. The user must remove that option using ALTER VIEW
before defining the INSTEAD OF trigger.
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Insert, Update and Delete
These options are keywords that specify which data modification
statements, when attempted against the selected table, activate
the trigger. At least one option must be specified. Any
combination of these in any order is allowed in the trigger
definition.
Select the option(s) you require for the Trigger and then select
the table on which you want this action to be implemented in the
drop down On Table list box. This will display a list of tables
stored in the same database as the current Trigger.
Lower section

This section contains the objects' body code (you can enter
code directly should you require) and the Flow Chart feature.
When you first open the object, the Flow Chart section will NOT
be visible. Use the center "splitter" to activate the Flow Chart. To
find out more about the Flow Chart, click here.

Comments tab
Business Function

The section enables you to define a Business Function for your
object. A Business Function (BF) briefly describes what an object
actually does. Enter the text you require, then send the object to
the server. Next time you open the object, the BF will be visible
in the Script tab. For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU Date BF: 03/09/2001
*
The sections immediately beneath the main BF section display
which user last added or modified the BF and when this was
done.
Notes
●

If you want to force SQL-Builder to remind you (with a
warning dialog box) that a BF has not been set every time
you save an object, you can do this in the Compiled
Objects tab by selecting the BF is required option.
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Trigger Editor

Maintenance Comment

This section enables you to enter a Maintenance Comment for
your object. In practice this means adding a comment each time
a user modifies or updates the object so that future developers
can see what has been done before and when. Enter the text you
require, then send the object to the server. Next time you open
the object, the Maintenance Comment and all other previous
changes (with date) to the Maintenance Comment will be visible
in the Script tab and also in the History section (explained
below). For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU
Date BF: 03/09/2001
*
*Author: JHU
Date: 03/09/2001
* Comment: Modified Permissions
*Author: JHU
Date: 03/09/2001
* Comment: Updated BF
History
This section displays a read-only history of all the Maintenance
Comments added to the current object together with the addition
date. Add the comment in the main Maintenance Comment
section.
Author
The sections immediately beneath the main Maintenance
Comment section display which user last added or modified the
comment and when this was done.
Notes
●

If you want to force SQL-Builder to remind you (with a
warning dialog box) that a Maintenance Comment has not
been set every time you save an object, you can do this in
the Compiled Objects tab by selecting the Maintenance is
required option.

Insert Code tab

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Object_Editors/trigger.htm (4 of 6) [10/07/2008 10:41:14]

Trigger Editor

Code run before
creation

Enter the code in this section that you want to be run BEFORE the
object is created.

Code run after creation

Enter the code in this section that you want to be run AFTER the
object is created.

Notes
●

The code entered into these two columns will not be visible in the Script tab.

Dependencies tab
This tab displays the server objects that are calling and are called by the object. By left-clicking
on an object in either of the two lists and then right-clicking to launch the shortcut menu, you
can open the linked object and access its properties as well as modify it if necessary.
Click the

button to refresh the displayed data in case of changes to other objects.

Options tab

Enable

Select this option if you want to activate this Trigger for its
associated Table.

Disable

Select this option if you want to de-activate this Trigger for its
associated Table.

Not for Replication

This option is used by Microsoft SQL Server replication to
implement ranges of identity values in a partitioned environment.
It is also especially useful in transactional or merge replication
when a published table is partitioned with rows from various
sites.

Notes
●

Please note that this section will only contain options if you are using an ASE Sybase 12
SQL-Server or above, or a MS SQL-Server 7.x or above. In all other cases this tab will be
blank.

Script tab
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Trigger Editor

The Script tab contains the actual object script. The script in this tab is in Read-Only mode and to
alter it, you need to use the other tabs in the editor.
Click File > Save as to save the script in a .SQL file. A standard Windows Save dialog box will be
launched enabling you to select the file's name and location.
Notes
●

If you make any modifications to the object, you will need to send it to the server in order
that the changes are taken into account. See Saving objects (sending objects to the
server) for more information.
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UDT Editor

UDT Editor

A User Data Type (UDT) is a type defined by the user. It is always built from a system type
(the base type) and can be associated with the null attribute, a Rule or a Default value.
Theses types can be used to define repeated columns with an advanced data type on several
different tables.
Name
Contains the name of the UDT (see Identifier for more information)
Type
Contains the name of the base type (one of the system datatypes).
Null / Not Null / Identity
These options display the UDT's property:
●

Null Definition > The null property associated with a column or an UDT means that it
can take the null value (zero for numerical types).
This attribute is always taken by default.

●

Not Null Definition > The not null property associated with a column or a UDT implies a
forbidden zero value for the column.
This attribute is often used with quantities which cannot be null.

●

Identity Definition > The identity property associated with a column or a UDT implies
that the column is handled as an identity counter by the SQL-Server. This attribute must
be set with the 'numeric' datatype and with scale set to 0.
This attribute is only available with Sybase System 10 or above, or Microsoft SQL-Server
7.0 or above.
When using Microsoft SQL-Server 7.0 or above, this attribute can be assigned to a
tinyint, smallint, int, decimal(p,0) or numeric(p,0) columns.
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UDT Editor

Length/Prec
Allows you to specify a length (mandatory for characters and binary-like datatypes) or an
optional precision (for exact numeric datatypes and 'float' datatypes).
An integer value is required lower than or equal to 255 for characters and binary-like datatypes,
lower than or equal to 38 for exact numeric datatypes, or lower than or equal to 48 for 'float'
datatypes.
Scale
Allows you to specify an optional scale for exact numeric (decimal/numeric) datatypes. An
integer value is required here lower than or equal to precision. If no precision is specified, you
can't specify a scale.
Rule
Lists the Rules which can be associated with the UDT.
Default
Lists the Default Values which can be associated with the UDT.
Immediate
If unselected, this flag prevents existing columns of a user-defined datatype from acquiring the
new rule or default.
Editor Title
The title of the UDT Editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname [(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a modification has been made to the
object, but that it remains unsaved.
Notes
●

●

●

When you create an already existing UDT, it must first be dropped. If it is being used, it
cannot be dropped. In this case, SQL-Builder can only modify the rule/default associated
with this UDT and a message warns you (after the display of the existing links).
If you make any modifications to the object, you will need to send it to the server in order
that the changes are taken into account. See Saving objects (sending objects to the
server) for more information.
To find out more about ownership of UDTs, please click here.
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View Editor

View Editor

Main Editor Window
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View Editor

The View Editor has several tabs which can each be accessed by clicking the corresponding
name. Each tab is explained below.
Owner Field

The Owner text box displays the name of the object owner. You
can alter the owner by clicking the down arrow and selecting a
new owner. Please see Owner Management for more information
about this.

Name Field

The Name text box at the top of the Editor displays the name of
object. If you want to change the object's name, left click in the
text box and type the new name you require.
Click here to find out how to Save an object.

Data-Session

button (located in the top right-hand corner) will
The
launch the Data-Session which allows you to manage the data in
your view.

Editor Title

The title of the editor will take the form:
LoginName@ServerName:[Database].[Owner].Objectname
[(Type of Object)]
An asterisk (*) at the end of the Editor title indicates that a
modification has been made to the object, but that it remains
unsaved.

Editor tab
This tab is divided into two sections.
Upper section

This section contains a grid displaying column information for the
current object. You can enter new columns here or alter exiting
ones.

Lower section

This section contains the objects' body code.

Comments tab
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View Editor

Business Function

The section enables you to define a Business Function for your
object. A Business Function (BF) briefly describes what an object
actually does. Enter the text you require, then send the object to
the server. Next time you open the object, the BF will be visible
in the Script tab. For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU Date BF: 03/09/2001
*
The sections immediately beneath the main BF section display
which user last added or modified the BF and when this was
done.
Notes
●

Maintenance Comment

If you want to force SQL-Builder to remind you (with a
warning dialog box) that a BF has not been set every time
you save an object, you can do this in the Compiled
Objects tab by selecting the BF is required option.

This section enables you to enter a Maintenance Comment for
your object. In practice this means adding a comment each time
a user modifies or updates the object so that future developers
can see what has been done before and when. Enter the text you
require, then send the object to the server. Next time you open
the object, the Maintenance Comment and all other previous
changes (with date) to the Maintenance Comment will be visible
in the Script tab and also in the History section (explained
below). For example:

*Procedure Name: GetAuthors
*Database: Castpubs
*Server: FRESU
*SQL-Builder4.0
*
*Business Function : Gets a list of Authors
*Author BF: JHU
Date BF: 03/09/2001
*
*Author: JHU
Date: 03/09/2001
* Comment: Modified Permissions
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View Editor

*Author: JHU
Date: 03/09/2001
* Comment: Updated BF
History
This section displays a read-only history of all the Maintenance
Comments added to the current object together with the addition
date. Add the comment in the main Maintenance Comment
section.
Author
The sections immediately beneath the main Maintenance
Comment section display which user last added or modified the
comment and when this was done.
Notes
●

If you want to force SQL-Builder to remind you (with a
warning dialog box) that a Maintenance Comment has not
been set every time you save an object, you can do this in
the Compiled Objects tab by selecting the Maintenance is
required option.

Dependencies tab
This tab displays the server objects that are calling and are called by the object. By left-clicking
on an object in either of the two lists and then right-clicking to launch the shortcut menu, you
can open the linked object and access its properties as well as modify it if necessary.
Click the

button to refresh the displayed data in case of changes to other objects.

Options tab
With Check Option

Select this option if you want the Check Option to be taken into
account: Forces all data modification statements executed against
the view to adhere to the criteria set within select_statement.
When a row is modified through a view, the WITH CHECK OPTION
guarantees that the data remains visible through the view after
the modification has been committed.
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View Editor

Attributes

With Schema Binding (Microsoft SQL-Server 2000 only)
Binds the view to the schema. When SCHEMABINDING is
specified, the select_statement must include the two-part names
(owner.object) of tables, views, or user-defined functions
referenced.
Views or tables participating in a view created with the schema
binding clause cannot be dropped unless that view is dropped or
changed so that it no longer has schema binding. Otherwise, SQL
Server raises an error. In addition, ALTER TABLE statements on
tables that participate in views having schema binding will fail if
these statements affect the view definition.
With View MetaData (Microsoft SQL-Server 2000 only)
Specifies that SQL Server will return to the DBLIB, ODBC, and
OLE DB APIs the metadata information about the view, instead of
the base table or tables, when browse-mode metadata is being
requested for a query that references the view. Browse-mode
metadata is additional metadata returned by SQL Server to the
client-side DB-LIB, ODBC, and OLE DB APIs, which allow the
client-side APIs to implement updatable client-side cursors.
Browse-mode meta data includes information about the base
table that the columns in the result set belong to.
For views created with VIEW_METADATA option, the browsemode meta data returns the view name as opposed to the base
table names when describing columns from the view in the result
set.
When a view is created WITH VIEW_METADATA, all its columns
(except for timestamp) are updatable if the view has INSERT or
UPDATE INSTEAD OF triggers.

Permissions tab
This section displays the permissions for the current object. To find out more information about
this tab and the way in which SQL-Builder handles permissions, please click here.
Script tab
The Script tab contains the actual object script. The script in this tab is in Read-Only mode and to
alter it, you need to use the other tabs in the editor.
Click File > Save as to save the script in a .SQL file. A standard Windows Save dialog box will be
launched enabling you to select the file's name and location.
View editor limitations
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View Editor

The View editor has several limitations, listed below:
●

The option "WITH ENCRYPTION" is not supported. This means that:
❍

it is not possible to open an object that uses this option
❍

●

●

this option is not offered by the editor

If the modification of a view in the editor results in a drop/create instead of an alter, any
triggers or indexes on this view will be destroyed but NOT recreated.
The view editor does not support indexes on views.

Notes
●

If you make any modifications to the object, you will need to send it to the server in order
that the changes are taken into account. See Saving objects (sending objects to the
server) for more information.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Object_Editors/view.htm (6 of 6) [10/07/2008 10:41:18]

Object Editor Commands and Options

Object Editor Commands and Options
The various SQL-Builder Object Editors have their own specific toolbar menus which provide a
variety of special commands. This section covers the commands that are available in these
menus, plus various other features associated exclusively with the Object Editors. Some options
are specific to one type of object editor and some are common to all or several object editors.
Common
●

Save Objects

●

Drop Objects

●

Set Current Connection

●

Links...

●

Flag/Unflag

●

Get/Release Permanent Lock

●

Find Matching Begin/End

●

Go To Line...

●

Test Now

●

Printing with SQL-Builder

Stored Procedure
●

Execute Current Procedure

Table
●

Data Preservation Assistant

●

Save Script in File

●

Working with remote tables

General Features
●

Permissions

●

Definition of Identifier

●

Owner Management

●

Editor Features

●

Code-Beautify

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MA.../SQLBLD/Features/Object_Editors/Common/index.htm (1 of 2) [10/07/2008 10:41:25]

Object Editor Commands and Options
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Set Current Connection

Set Current Connection
This option enables you to associate the active window with a new or existing server
connection. If no connection is already open, the Connection dialog box will be launched enabling
you to select a new server to connect to. Otherwise the Existing Connections dialog box will be
opened in which you can select a different server connection from those already open.
In this way, you can open an object on one server and then directly create it on another.
Accessing the Command
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Click the appropriate object specific menu located on the toolbar (whether Stored Pr.,
Trigger etc...) and select the Set Current Connection option from the drop down menu.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Object_Editors/Common/setcurrcon.htm [10/07/2008 10:41:27]

Links...

Links...
Usage (for Rules/Defaults)
Launched from the Rule and Default menus, this command displays the columns of Tables and
UDTs linked to the current Default value or Rule. SQL-Builder will display these links in the
Rule/Default Dependencies dialog box:

The dialog box is split into two different sections: the upper most list box contains the Names of
Linked Table Columns. The lower list box contains the linked UDTs.
You can go move through these two sections with their respective scroll bars.
Table - Columns

Lists the column names of the tables which are linked to the
selected UDT, Rule or Default.

User Data Type

Contains the UDT names which are linked to the selected Rule or
the Default.
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Links...

Save Links

You can check this option to save the links between the Rule or
the Default and the object(s) displayed in the two list boxes in a
file, and when dropping the Rule or the Default itself. You can
then restore these links by running this SQL-Script file in the
SQL-Session.

Drop

Click this button to break the links between the Rule or the
Default and the object(s) displayed in the two list boxes, and to
delete the Rule or the Default itself.

Notes
●

This dialog box will also be displayed when using the Drop command from either the Rule
or Default menu. Click here to find out more information about dropping objects.

Usage (for UDTs)
Launched from the UDT menu, this command displays the columns of Tables linked with the
current UDT. SQL-Builder will display these links in the UDT Dependencies dialog box:

This dialog box is virtually identical to the Rule/Dependency dialog box explained above.
Similarly, this dialog box displays the Table Columns (in the upper list box) and the Stored
Procedure Parameters (in the lower list box) linked to the selected UDT.
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Links...

Accessing the command
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Then click the appropriate object specific menu located on the toolbar (this command is
only only available for Default, Rule or UDT objects) and select the Links... option from
the drop down menu.
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Flag/Unflag
Setting a Flag on an object simply means to mark it. In other words, you could flag a particular
object to remind you to carry out maintenance on it (for example).
When you Flag an object or open a Flagged Object, the
symbol will appear at the
bottom of the screen and the object icon color will change to green in the Object Manager:
Unflag
To unflag a flagged object, click the object specific menu and select Flag/Unflag.
Accessing the Command
SQL-Server/Sybase users
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Click the appropriate object specific menu located on the toolbar and select Flag/Unflag
from the drop down menu.
Oracle users
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Select Flag/Unflag from the Knowledge Base menu located on the toolbar.
See Also
Get/Release Permanent Lock
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Get/Release Permanent Lock

Get/Release Permanent Lock
Setting a permanent lock on an object means that the object will be locked in the Knowledge
Base for your use only. In other words no other user can edit or modify an object you have
locked.
When you set a permanent lock on an object or open a Locked Object, the
will appear at the bottom of the screen.

symbol

Release Lock
To release a permanent lock, click the object specific menu and select Get/Release Permanent
Lock.
Accessing the Command
SQL-Server/Sybase users
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Click the appropriate object specific menu located on the toolbar and select Get/Release
Permanent Lock from the drop down menu.
Oracle users
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Select Get/Release Permanent Lock from the Knowledge Base menu located on the
toolbar.
See Also
Flag/Unflag
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Find Matching Begin/End

Find Matching Begin/End
Edit > Find Matching Begin/End
You can use this command when you have highlighted a begin statement in the object editor
and you want to find the corresponding end statement (and vice versa), or when you have
highlighted an open parenthesis and you want to find the corresponding close parenthesis.
SQL-Builder will automatically move the cursor to the correct position.
Accessing the Command
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Mark the begin statement or the open parenthesis.
3. Click the Edit menu located on the toolbar and select Find Matching Begin/End from
the drop down menu.
4. You can also use the shortcut key: ALT+!
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Go To Line

Go To Line
You can use this command to go to a specific line in the object code. A small dialog box will be
launched enabling you to enter the line you require - SQL-Builder will then move the cursor to
the corresponding line.

Accessing the Command
1. Open an object from the Object Manager. Click here for more information on how to do
this.
2. Then click the Edit menu located on the toolbar and select Go To Line from the drop
down menu.
3. You can also use the shortcut key: ALT+F5
See Also
Object Editors
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Test Now

Test Now
This option enables you to "test" your Stored Procedure or Function in the SQL-Session. When
you select the option, the Connection dialog box will open - enter the appropriate user name and
password here. The SQL-Session will automatically be launched and the code in your Stored
Procedure or Function will be pasted in the SQL-Session Query Editor.
You can then send your Stored Procedure or Function to the server to test it. Click here for
more information on how to send a query to the server from the SQL-Session.
Accessing the Command
1. Open a Stored Procedure or Function from the Object Manager. Click here for more
information on how to do this.
2. Select Test Now from the Stored Pr. or Function menu located on the toolbar.
3. Error messages will be displayed in the Messages and Errors List.
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Execute Current Procedure

Execute Current Procedure
This command will open an SQL-Session, and then insert an execution script into it, as displayed
below:

Use the Go command (CTRL + G) from the T-Sql menu to execute the script.
Accessing the Command
1. Open a Stored Procedure from the Object Manager. Click here for more information on
how to do this.
2. Select Execute current procedure... from the Stored Pr. menu located on the toolbar.
3. You can also click the shortcut key: CTRL+E
4. Error messages will be displayed in the Messages and Errors List.
Notes
●

If you activate the Ask parameter value when executing procedures option in the
General tab (Options > General Configuration) a Parameter Input dialog box will be
displayed allowing you to enter any required procedure parameters.
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Data Preservation Assistant

Data Preservation Assistant
When you modify a Table and then want to save (to find out more about how to save the Table
Editor, please click here) it again on the server, the Table will first need to be dropped and then
recreated necessitating a Drop Procedure and then a Create Procedure (depending on the
modification you make).
To ensure that no data is lost when the Table is dropped, SQL-Builder will automatically launch
the Data Preservation Assistant which will carry out the Drop and Create procedures for you
to reflect your modifications.

How to use it...
The Assistant contains three distinct sections:
●

●

●

on the left you will find the section that displays the contents of the temporary table
created by SQL-Builder (containing the data from the main table)
to the right is the section that contains the current table with the modified data
below is the section that contains the data preservation order that has been automatically
generated by SQL-Builder

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MA...QLBLD/Features/Object_Editors/Common/datpres.htm (1 of 2) [10/07/2008 10:41:48]

Data Preservation Assistant

What next?
●

●

First check the validity of the data preservation order as displayed in the lower section.
Some cases cannot be handled by the assistant, so, if necessary test the procedure with
the Verify data preservation order button.
If the procedure is correct, click Proceed to start the process.

The assistant will then:
●

Create a temporary table with the same structure as the main table

●

Copy the data from the main table to the temporary table

●

Drop the main table and all its dependent objects (external constraints and triggers)

●

Recreate the main table and all its dependent objects

●

Execute the instruction to transfer the data from the temporary table to the main table
and then drop the temporary table

Notes
●

●

If you want to abort the process click Cancel at any time before you click Proceed. Your
table will remain in a modified state without having been executed.
Please note that if you are adding a column or renaming an existing column, the DataPreservation Assistant will display a message warning that clicking the "Verify Script"
button will not work unless you have manually edited the displayed script. This is because
the automatically created script includes references to column names that don't yet exist
in the database.
This does not mean that the execution of the Data Preservation Assistant will fail - only
the verification of the script will fail!

When is a Drop procedure necessary?
A Drop Procedure is obligatory in the following situations:
●

when the column number changes (following an insert, column position change, etc...)

●

when an alter operation is not possible on the server depending on the version

●

when the table name is modified

●

when a column name is modified

●

when the column identity type is modified

●

when the table's general values are modified (such as the segment or the file group)
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Save Script in File

Save Script in File
This command will save the table script as an ASCII file with a .SQL extension.
Accessing the Command
1. Open a Table from the Object Manager. Click here for more information on how to do
this.
2. Select Save Script in File from the File menu located on the toolbar.
3. SQL-Builder will propose a file: [table_name].SQL in the My Documents folder. You can
change this if required.
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Working with remote tables

Working with remote tables
SQL-Builder permits you to create and access tables on a remote server. To do so, both servers
must mutually reference each other and you must be logged in with the same username and
password on both servers.
When a remote table is opened, SQL-Builder will open it in read-only format, however, you can
use the Data-Session to input data if required.
You can also drop the table if necessary.
Notes
●

For Sybase users, please note that this feature is only supported for server versions 11.9
and above.
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Permissions
This page provides a detailed explanation of the Permissions that can be granted in the various
Object Editors in SQL-Builder. It covers all database servers that can be used in conjunction with
SQL-Builder (Oracle, Microsoft SQL-Server and Sybase).
Permission Management in SQL-Builder
Object Permissions in SQL-Builder
On the three types of servers, the following permissions are handled by SQL-Builder:
●

ALTER (only for Oracle servers)

●

DELETE

●

EXECUTE

●

INSERT

●

REFERENCES

●

SELECT

●

UPDATE

Other permissions do exist although these are not handled by SQL-Builder. Permissions are
handled for the following types of objects:
Oracle - Table, View, Procedure, Function, Package
SQL-Server - Table, View, Procedure
Sybase - Table, View, Procedure
The type of privileges granted depend on the type of object. See the tables in the sections below
for more information.
Oracle Permissions by Object Type
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Tables

Views

Procedures,
Functions,
Packages

ALTER

X

-

-

DELETE

X

X

-

EXECUTE

-

-

X

INSERT

X

X

-

REFERENCES

X

X (only for 9i)

-

SELECT

X

X

-

UPDATE

X

X

-

Object Privilege

Oracle Tables
ALTER

Change the table definition with the ALTER TABLE statement.

DELETE

Remove rows from the table with the DELETE statement. Note: You must grant
the SELECT privilege on the table along with the DELETE privilege.

INSERT

Add new rows to the table with the INSERT statement.

REFERENCES

Create a constraint that refers to the table. You cannot grant this privilege to a
role.

SELECT

Query the table with the SELECT statement.

UPDATE

Change data in the table with the UPDATE statement.

Oracle Views
To grant a privilege on a view, you must have that privilege with the GRANT OPTION on all of the
view's base tables.
DELETE

Remove rows from the view with the DELETE statement.

INSERT

Add new rows to the view with the INSERT statement.

REFERENCES

Define foreign key constraints on the view.

SELECT

Query the view with the SELECT statement.

UPDATE

Change data in the view with the UPDATE statement.

Oracle Procedures, Functions, Packages
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Note: Users do not need this privilege to execute a procedure, function, or package indirectly.

EXECUTE

Compile the procedure or function or execute it directly, or access any program
object declared in the specification of a package.

Microsoft Permissions by Object Type

Multistatement
tablevalued
Functions
(version
2000 only)

Scalarvalued
Functions
(versions
2000 only)

Table

View

Procedure

TableValued
Functions
(version
2000
only)

ALTER

-

-

-

-

-

-

DELETE

X

X

-

X

-

-

EXECUTE

-

-

X

-

-

X

INSERT

X

X

-

X

-

-

REFERENCES

X

X

-

X

-

X

SELECT

X

X

-

X

X

-

UPDATE

X

X

-

X

-

-

Object
Privilege

GRANT, DENY, and REVOKE statements to specify who can use which data-modification
statements:
●

●

●

GRANT: gives permissions to either work with data or execute other Transact-SQL
statements.
DENY: denies permission and prevents the specified user, group, or role from inheriting
the permission through group and role memberships.
REVOKE: removes previously granted or denied permissions.

The permissions that can be granted for objects are:
●

SELECT: Permits a user to issue SELECT statements against a table or view.

●

INSERT: Permits a user to issue INSERT statements against a table or view.

●

UPDATE: Permits a user to issue UPDATE statements against a table or view.

●

DELETE: Permits a user to issue DELETE statements against a table or view.

●

REFERENCES: Permits a user to make foreign key references to the primary key and
unique columns of a table. Also used to allow SCHEMABINDING references from views and
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functions.
●

EXECUTE: Permits a user to issue EXECUTE statements against a stored procedure.

Sybase Permissions by Object Type

Object Privilege

Table

View

Procedures

ALTER

-

-

-

DELETE

X

X

-

EXECUTE

-

-

X

INSERT

X

X

-

REFERENCES

X

-

-

SELECT

X

X

-

UPDATE

X

X

-

The references permission refers to referential integrity constraints that you can specify in an
alter table or create table command. The other permissions refer to SQL commands.
Table Limitations in SQL-Builder
Permissions for Tables can be consulted in SQL-Builder, but CANNOT be modified. In addition,
column level permissions are not handled (and are thus NOT displayed in the SQL-Builder
Permissions tab).
Using the Permissions tab in SQL-Builder's Object Editors
The Permissions tab is available in most object editors and allows you to set permissions as
required for a particular object. The image below shows the Permissions tab for the Table
Editor. As mentioned already, permissions cannot be modified for Tables within SQL-Builder, but
they are displayed for information purposes.
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You can, however, modify permissions in any other object editor that provides a Permissions
tab, as shown below for the Function Editor (SQL-Server/Sybase only):
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To modify the permissions for a particular user and action (execute update etc.) click in the cell
that corresponds to the permission you want to modify and use the drop down list box to select
the permission.
You can choose from the following options:
●

Grant

●

Revoke

●

Deny (only if the SQL-Server version is 2000 or above)

●

Grant with grant option

●

a blank option enabling you to cancel a modification without having to close the editor and
then start all over again.

The editor will only display the permission columns pertinent to the particular type of object you
are editing.
For Oracle users, the column "User" contains all the server's schemas as well as "Public".
For SQL-Server users, the column "User" contains all the logins (Windows group, Windows user
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and standard) that have access to the object's database. Only the "sa" login is not included in
this column.
For Sybase users, the column "User" contains all the groups and all the logins that have access
to the object's database.
As result, if a user inherits a particular permission by virtue of being a member of a group, and
the same permission is explicitly granted to the user, no row is added to sysprotects. For
example, if "public" has been granted select permission on the phone column in the authors
table, then John, a member of "public," is granted select permission on all columns of authors.
The row added to sysprotects as a result of the grant to John will contain references to all
columns in the authors table except for the phone column, on which he already had permission.
This is also true for groups that inherit from other groups. As a result, the "User" column displays
only those groups that have different permissions from the groups that they inherit from. For
users, permissions are always displayed. Thus, if the "guest" user does not have the "select"
permission, where as the "public" group from which the user inherits DOES have the
permissions, then the editor will display:

If on the other hand "guest" that inherits from the "public" role and "testeur_jpc1" that inherits
from the "testeur" group that in turn inherits from the "public" role, have the same permissions
as their originating group, nothing will be displayed:

Finaly, if the "testeur" group has one permission that is different from the permissions accorded
to "public", then this role is displayed:

This means that:
●

"public" has the "Execute" permission

●

"guest" has the "Execute" permission inherited from "public"

●

"testeur" does not have the "Execute" permission

●

"testeur_jpc1" does not have the "Execute" permission
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Notes
●

If you require more in-depth information about permissions, please consult the User Help
Guide for Sybase and Microsoft SQL-Server. More information about Oracle permissions
can be found here at the main Oracle documentation site:
http://otn.oracle.com/documentation/index.html
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Definition of Identifier
An identifier is a Stored Procedure name, Table name, Column name or Parameter name. An
identifier must comply with rules defined on the server.
In particular, for Microsoft 7.0 SQL-Server and above, identifiers fall into two classes:
●

●

Regular identifiers that conform to the rules for identifier format.
Delimited identifiers that are enclosed in either double quotation marks "" or brackets ([
]).

When using delimited identifiers, you must NOT specify the delimiters when defining a name
in a control, but when entering T-SQL commands, the delimiters MUST be specified.
For example, when you define a Stored Procedure name, the delimiters are not specified (ex : for
the procedure name "Sales By Year", you will specify Name=Sales By Year, but in the header in
the Procedure Editor, you will see: Create Proc "Sales by Year")
Moreover, if you execute this Stored Procedure in the SQL-Session (for example), you should
specify : Exec @res = "Sales by Year" ...
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Owner Management
Tables, triggers, rules and default values
In SQL-Builder, only tables, triggers, rules and default values owned by "dbo" (database owner)
are handled. Objects of these types owned by other owners can only be opened in read-only
mode.
UDT
All UDT are handled in SQL-Builder, but you can only modify UDT you own except the user "dbo"
who can modify all UDTs. Other UDT can be opened in read-only mode. All UDT can be accessed
from the table column editor and from the parameter's definition dialog box.
Notes
●

●

On Microsoft SQL Server 2000 and above, UDTs with 'public' ownership can only be
modified by 'dbo'.
When the user "dbo" modifies a UDT owned by someone else, ownership of this UDT will
be transferred to "dbo".

Stored Procedures and Views
Stored Procedures and Views handled in SQL-Builder can belong to any user defined in the
database.
●

●

On Sybase SQL-Servers, you can modify only Stored Procedures and Views that you own.
Other Stored Procedures and Views can be opened in read-only mode.
On Microsoft SQL-Server 2000 and above, you can modify:
❍

❍

❍

Stored Procedures and Views you own
All Stored Procedures and Views if you are logged in as "dbo" or connected as an
alias of "dbo" or if you have the "db_owner" role or the "db_dlladmin" role
Stored Procedures and Views belonging to a Microsoft Windows NT group if you are
defined as a member of that group

Notes
●

●

Other Stored Procedures and Views can be opened in read-only mode. When you can
modify/create a new Stored Procedure or View, you can specify the owner of the object,
depending on the rights you have in the current database. The owner is specified in the
creation script when saving the object (on the server or in a file).
When you call the Execute procedure template, stored procedures you will be able to
access are those you own and those belonging to "dbo" and possibly those belonging to
the groups you are member of. No owner is specified in the template of code calling the
selected stored procedure.
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Editor Features
This section provides information about the features included in the CAST Editor (i.e. when
editing objects or when using the SQL-Session). In addition to the standard Windows Editor
features, the CAST Editor includes syntax highlighting and other extended options:
Syntax Coloring
The editor highlights comments, strings, keywords, system variables, system datatypes,
variables, and parameters. A distinct color is used for each syntactic element, which you can
choose yourself (click here for more details about this option). Comments and strings are
handled in all lines. Nested comments are also handled in the same way as SQL syntax.
Keyword Completion
If the cursor follows one or more characters and you press LEFT CTRL+SPACE BAR, the editor
completes the current word with a language keyword beginning with these letters or displays
the next language keyword matching these letters; note that SHIFT+LEFT CTRL+SPACE BAR
displays the previous language keyword matching these letters.
By pressing RIGHT CTRL+SPACE BAR, the editor completes the current word with a name of an
object beginning with these letters or displays the next object name matching these letters; note
that SHIFT+RIGHT CTRL+SPACE BAR displays the previous object name matching these letters.
Selection Modes
This editor provides two selection modes: Stream Mode (character to character) and Box
Mode. When using Box Mode you can drag your mouse to select any rectangle in your text. This
rectangular text can be deleted, cut or copied to the clipboard. If you paste a piece of text in Box
Mode, the pasted text lines will be inserted into the existing lines at the cursor’s vertical position.
You can define the selection mode with the Stream Mode and Box Mode options from the Edit
menu. The ESCAPE key cancels any selections and resets to Stream Mode. When you click the
text while holding down the ALT key, selection begins in Box Mode. This feature lets you define
a rectangular selection in one operation.
Notes
●

Some tab characters in your text may be replaced by spaces when using box mode, but
only when absolutely necessary.

Undo/Redo
This feature enables you to Undo and Redo work with all editor operations (keyboard, cut,
paste, find/replace, etc.). You can undo up to 100 operations, and redo any undone operations.
Supercursor
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When you are in Box Mode (see Selection Modes), you can define a line to line selection with a
null width. A thin vertical line appears on screen. This line is considered a "supercursor", so that
when you press a key, the same character is inserted on all lines. In this mode, you can use the
character keys, tab key, backspace, delete, and the left and right arrow keys. The up and down
keys (used without SHIFT) will remove the supercursor. Paste operations are not handled by the
supercursor: this functions as it would in Box Mode.
Auto-indent
When you press the ENTER key, the cursor takes the same character position as in the previous
line. You can also indent lines in one operation. To do this, select some lines (in Stream Mode)
use the TAB key to indent, and SHIFT+TAB to un-indent. This is useful when adding an "if" or
"while" statement to existing code, for example.
Keystrokes
All the usual combinations are allowed:
●

Arrow keys: move the cursor

●

CTRL + left or right arrow: move one word left or right

●

●

●

Page up, page down: displays the previous or next page (a page is defined by window
size)
Home: toggles between the true first character and the first visible character (indentation)
End: toggles between the true last character and the last visible character (trailing spaces
or tabs)

●

CTRL + home: takes you directly to the beginning of the text

●

CTRL + end: takes you directly to the end of the text

●

SHIFT + any keys defined above: define selection

Mouse Operation

●

Click: set cursor position

●

Click then drag: define a selection

●

SHIFT + Click: define a selection

●

ALT + Click: set "Box mode" selection

●

ALT + Click then drag: define a rectangular selection

●

SHIFT + ALT + Click: define a rectangular selection

Limitations
This editor can handle up to 64,000 lines each containing 4096 characters.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MAS.../SQLBLD/Features/Object_Editors/Common/editor.htm (2 of 3) [10/07/2008 10:45:43]

Editor Features

Upper/Lower Case conversion
You can highlight a piece of code in any editor and convert it into lower or case letters. To do so:
1. Highlight the text.
2. Use the option Edit > Make Lower or Edit > Make Upper as required.
3. There are two shortcut keys: CTRL+U (Make Upper) and CTRL+SHIFT+U (Make Lower).
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Code-Beautify
What does it do?
You can use this command to restructure code you have inputted into the Editor tab of any
Object Editor (where an Editor tab is available) or in the SQL-Session. Code will be formatted in
compliance with normal display standards.
The code itself will not be changed, rather the spacing is altered to render it more user-friendly.
Accessing the Command
To access this command:
1. Open an Object Editor and make sure you are working in the Editor tab (or open the SQLSession)
2. Click Edit and then select Code-Beautify from the drop down menu
3. Any code displayed will be reformatted
Example
Before using Code-Beautify, the following script is displayed as follows:

declare @ErrCode int, @IdCdb int, @MySelf varchar(3)
exec @ErrCode = Proc1 1
@MySelf,
36
if (@ErrCode != 0)
select col1
from Table1
where (Col2 = 36) and (Col3 = 'xx')
The same code after using Code-Beautify:

declare @ErrCode int, @IdCdb int, @MySelf varchar(3)
exec @ErrCode = Proc1 1
@MySelf,
36
if (@ErrCode != 0)
select col1
from Table1
where (Col2 = 36) and (Col3 = 'xx')

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Object_Editors/Common/beautify.htm [10/07/2008 10:45:45]

Object Manager

Object Manager
●

What is the Object Manager?

●

Displaying the Object Manager

●

Object Manager Interface

●

Shortcuts for the Object Manager

●

Configuring your Object Manager

●

Object Manager Toolbars
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What is the Object Manager?
The Object Manager is a visual representation of the server you are connected to. All
databases/schemas, objects, components and directories stored on the server are represented
hierarchically down to the lowest level.
You can expand/collapse an item to view lower level objects by either double-clicking it or by
clicking the "+" or "-" boxes once.
Notes
●

Concurrent connections are possible with SQL-Builder. Information about other servers will
also be displayed in the Object Manager. To find out more information about this see the
section on Connection.

See Also
Object Manager Interface
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Displaying the Object Manager
The Object Manager is displayed automatically during the SQL-Builder start-up procedure when
you connect to a server, as described here. You can, however, display it in several other ways:
1. You can click View > Panels > Object Manager... on the toolbar menu.
2. You can click the

button located on the toolbar.

Notes
●

You can also hide the Object Manager by selecting View > Panels > Object Manager
located on the toolbar or by clicking the Object Manager toolbar button as shown above.
This does not close the Object Manager, but hides it instead. The tick next to the option
indicates that the window is displayed.

See Also
Object Manager Interface
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Object Manager Interface
When the Object Manager is launched it will be displayed by default in the "two pane" style as
shown below:

The Two Pane style (click here for information on how to change this display) contains two
sections: on the left hand side a hierarchical list displays the various databases/schemas
and object types stored on your server. The right hand side displays the contents of the
current node that you have selected in the left hand list.
Icons displayed in the Object Manager
An instance on a server
A database/schema stored on a server that has not been synchronized with the
Knowledge Base.
A database/schema that has been synchronized with the Knowledge Base.
Object type
Default
Function (when using MS SQL-Server 2000)
Rule
Stored Procedure
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Table
Table Column
Trigger
UDT
View
View Column
Buttons
The following Object Manager buttons are only available in non-docked mode:
Open

The Open button opens an object that you have selected. Click here for more
information on how to open objects.

New

Clicking the New button when any object is selected, will launch a corresponding
empty object editor enabling you to define a new object. Click here for more
information on how to do this.

Graphical Clicking this button when one or more objects are selected will launch a
Object
Graphical View allowing you to visualize the links between the objects you have
Manager selected. Click here for more information on this feature.
Please note that this feature is similar to the features offered by CAST's viewer
module.
Associated toolbar icons

These icons are available on the toolbar. Clicking one once will cause SQL-Builder to
automatically display the type of object corresponding to the object icon you clicked. The objects
displayed will be stored in the database/schema that you are working on before you select the
icon (see Changing the working database for more information about this).
Changing the Object Manager display
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You can change the Object Manager's display by right clicking anywhere in the Object Manager
to launch the contextual menu. Next, select either the Two Pane Object Manager or the
Docking View option from the menu as described below:
●

Two Pane Object Manager/ One Pane Mode (non-docked)
This option will be selected by default. you can turn the option off and work in One Pane
mode. When you do so, the right hand section of the Object Manager will be removed.
The contents of the current node are then displayed with the databases and the object
types. You will however lose the extra information about each object displayed in the right
hand section when working in List Form.

●

Docking View option
If you select this option, the Object Manager will become docked on the left hand side
of the main window. In other words, it will remain anchored in its position. As with the
One Pane Object Manager option described above, the right hand section will be
removed, and the objects in the current node will be displayed with the databases and
object types. Again, you will lose the extra information about each object displayed in the
right hand section when working in List Form.

Objects as Small, Large Icons or in List Form
You can change the appearance of the right hand section of the Object Manager to display the
icons in large, small or list form as follows:
●

●

●

Click the View menu located on the toolbar when the Object Manager is active and
select the View option from the drop down menu. Then select either Large, Small or List
from the secondary menu.
You can click the
,
,
buttons located on the toolbar, corresponding in the same
order to Large, Small and List form.
You can right click in the Object Manager to launch the shortcut menu, then click the View
option and select the display type you require from the secondary menu.

By default, objects in the Object Manager are displayed in list form which displays additional
information about the object in column form, including:
●

the owners of the objects

●

creation date and most recent modification date

●

their status (valid or invalid)

In addition you can change the sort order of the objects displayed in the right hand section
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when working in List form by clicking the column header to switch between ascending and
descending.
Sorting the Objects when displayed in Two Pane and List Form
You can change the sort order of the objects displayed in the right hand section when working
in Two Pane and List form by clicking View on the menu bar, selecting Sort by and then
choosing an option from the sub menu.
For example, choosing Created will sort all the objects in the right-hand section and display
them according to the date when they were created. The order will either be ascending or
descending. Select the option again if the sort direction is incorrect. A check mark will appear
next to the option in the sub-menu indicating which is currently active.
You can also sort the objects in the right hand section by clicking the column header to toggle
between ascending and descending.
Using the Object Manager filter
It is possible to create a filter to alter the type of objects that are displayed in the Object
Manager. By default, all objects, regardless of their type, are displayed.
For example, you may only want to display all Stored Procedures and Functions that are
locked in the Knowledge Base.
To do so you you need to create a filter. All necessary information about filters and how to
implement them can be found in the Object Manager Filter tab.
See also Hiding a schema/database for more information about filtering the display in the Object
Manager.
See Also
Object Editors | Open objects | Create new objects | Drop objects | Capturing parameters |
Dependencies (Calling and Called) | Generate Script

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/Object_Manager/interface.htm (4 of 4) [10/07/2008 10:46:07]

Shortcuts for the Object Manager

Shortcuts for the Object Manager
The Object Manager provides several shortcuts to help you use the available functions more
easily.
●

●

●

●

●

●

●

●

In list form, you can change the sort order of the displayed objects by clicking the column
header.
A single click of the mouse (in the left-hand list) shows the contents of a node
(displayed in the right-hand list) when working in two pane mode.
A double click expands a node or opens an object (click here for more information about
how to edit objects).
You can move through the list of objects and object types with the arrow keys or with
the PGUP, PGDN, HOME or END keys located on the keyboard.
Press RETURN to open (and expand or collapse) the node currently selected.
To force expansion of the selected node when working in One Pane view or Docked View
use the + icon next to an object or object type, the - icon will force its collapse.
You can type the first letter(s) of the object and the selection automatically changes
according to the letter(s) typed. To browse through objects with the same initial, continue
pressing the same key as often as necessary. If nothing matches the key(s) pressed, a
short beep will be emitted (in this case, note that the next key stroke will cause a new
search).
You can REFRESH the Object Manager when objects have been updated or created. To
do this click the View menu when the Object Manager is active and then select the
Refresh option from the drop down menu. You can also press F5.
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Output Window
●

What is the Output Window?

●

Messages and Errors List

●

User List

●

Reference List

●

Foreign List
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What is the Output Window?
The Output Window contains a variety of tabs that each provide information or other facilities.
Clicking each tab will display the relevant information.
If you want to hide the Output Window:
1. Click View > Panels > Output
2. Repeat the process to re-display the window
3. You can also click the close icon in the top right-hand corner.
4. You can also use the

icon located on the toolbar to toggle the display mode.

By default, the window will be "docked" at the bottom of the screen. However, you can move the
window to a different location should you require:
1. Double-click anywhere in the title bar - this will "undock" the window and you will then be
able to move it as normal.
The window has other "docked" positions which can be used by moving the window until its
outline changes shape and then releasing the mouse button.
See Also
Messages and Errors List | User List | Reference List | Foreign List
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Messages and Errors List
The Messages and Errors List will launch automatically when you first start the application. This
window logs any messages or error messages sent from the server or the application. This logging of
messages can help localize a problem very quickly. CAST can also use the log file to diagnose serious
errors.

How does it work?
Each time a warning or an error (i.e. from the server) is received a new message is displayed in the Log
Window - in other words a new line will be created. For each message displayed in the list, information
will be provided via a variety of different columns.
The information displayed in the Log Window is stored in temporary files (*.tmp) on your hard drive, on
a "per-application" basis:
%TEMP%\CAST\CAST\<version_number>\logs
The contents of this folder is associated to each session created by each CAST application that has been
executed on the workstation by the specific user. You can delete the contents of this temporary folder if
you need to free up space on your hard disk, however, make sure that you kill all CAST applications
before doing so
Shortcut menu
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A shortcut menu is also available (you can access it by right clicking anywhere in the window) enabling
you to:
●

●

●

●

●

●

Copy the marked selection. You can also use the shortcut key CTRL+C, the toolbar button
click the Edit toolbar and select the Copy option from the drop down menu.

, or

Print > This option will send the entire contents of the window to the printer. You can also use
CTRL+P, or click the File menu and select the Print option from the drop down menu (this option
only works if the Messages and Errors tab is active).
Select All. This will select or mark the entire contents of the window. This option also has a
shortcut key CTRL+A or you can click the Edit menu and choose the Select All option from the
drop down menu.
Clear All. Choose this option if you want to erase the entire contents of the Messages and
Errors window. You can also click the Edit menu located on the toolbar and then select the
Clear Messages option from the drop down menu (this option is always available), or you can
also use the shortcut key CTRL+DEL.
New User List. Selecting this option will create a new User List.
New Foreign List. Selecting this option will create a new Foreign List. A standard Windows Open
dialog box will be displayed enabling you to select the .XML file that contains the list generated in
another application.

Log File
The Messages and Errors List has an associated Log File that automatically records the contents of
the Log List for viewing at a later date. If you want to find out more about how to configure this, click
here.
See Also
Messages & Errors tab | User List | Reference List | Foreign List
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User List
The User List enables you to store a list of objects. These objects might be particular in some way or
you may work with them more often than others. Using the right-click shortcut menu you can then save
the contents of the list or carry out various other operations, such as opening objects etc...

Adding objects to the User List tab
There are two ways to add an object to the list:
1. You can select an object in the Object Manager, hold down the left mouse button, drag it to the
list and then drop it by releasing the mouse button. The object will be added to the list.
2. Alternatively you can use the Object Manager shortcut menu: select an object that you want to
add, right-click the object to launch the shortcut menu and select Add to User List. Selecting
this option will append the object to the default tab.
If, however, you hold down the CTRL key while selecting Add to User List, the object will be added to a
brand new list tab.
Notes
●

Please note that adding objects to the User List does NOT remove them from the Object Manager.
A copy of the object is placed in the list instead.

Removing objects from the list
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User List

To remove an object from the User List, select the object in the list, right-click to launch the shortcut
menu and then select Remove.
You can also clear ALL the objects from the User List if you require. Right-click anywhere in the tab and
then select the Clear All option from the shortcut menu. All objects will then be removed from the list.
Notes
●

Removing an object from the User List does NOT remove it from the Object Manager. This is done
with the Drop Objects option.

Opening objects from the list
You can open an object directly from the User List. To do this, select the object and right-click to launch
the shortcut menu, then select the Open option.
The object will then be opened and its editor will be displayed.
Loading and Saving the contents of the list
Once you have added the objects that you require you can them save them to file and re-load them at a
later date.
●

Saving
Right-click anywhere to launch the shortcut menu and then select Save or Save As. SQL-Builder
will then prompt you for a name for the file and a location at which to save it. The file will be
stored as an .XML file.

●

Loading
To re-load a group of objects that you have previously saved, click anywhere in the User List tab
to launch the shortcut menu, then select Load. A standard Windows Open dialog box will then be
launched in which you can select the name and location of the .XML file.
Once loaded, the objects will appear in the list. They can then be used as normal.

Shortcut menu
Other options are available from the User List shortcut menu:
Open

Opens the selected object.

Remove

Removes the selected object from the list. The object will NOT be
removed from the server. See Removing objects from the list.

Load

Load a User List you have already saved as an .XML file. See Loading
and Saving the contents of the list.

Save As

Enables you to save the list under a different name (or the same
name) if you require. List will be saved as an .XML file.
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Save

Saves the current list as an .XML file.

Export to CSV

Enables you to save the User List as .CSV file that can be opened with
Microsoft Excel (for example).

Order by

Selecting this option will display a sub-menu with further options:
●

by Server

●

by Schema/Database

●

by Object Name

●

by Object Type

Selecting one of these options will sort the list of objects by that type.
For example, selecting by Object Name will sort the list of objects in
ascending or descending alphabetical order by their name. A check
mark next to the item in the sub-menu will indicate which option is
currently in operation. A small arrow will indicate the sort direction in
the User List column headings.
If the objects are sorted in ascending alphabetical order and you
require descending order, select the option again from the sub-menu.
You can also sort objects in the list by clicking the column headings.
A small arrow in the column headings will indicate the sort direction.
Auto resize columns

Reset the column display sizes to their defaults.

Show flag column

Displays a new column in the User List that indicates whether the
object has been flagged in the Knowledge Base (you will need to be
using a Knowledge Base for this to function, see Knowledge Base
connection).

Refresh

Refreshes the contents of the User List.

Clear All

Clears the entire contents of the User List.

Remove Panel

Selecting this option will completely remove the User List tab you are
currently working in. All objects will thus also be removed. The default
tab can also be removed.
To create a new tab, right click in the Messages and Errors List and
select New User List.

New User List

Opens a new User List (in addition to the current User list).

New Foreign List

Opens a new Foreign List.

Notes
●

The User List can be made persistent between two SQL-Builder sessions. Select the Persistent
panels option in the General tab.

See Also
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User List

Messages and Errors List | Reference List | Foreign List
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Reference List
The Reference List tab displays the results of the search carried out by the Search in SQLObjects function. This tab is NOT normally visible when using other functions and is ONLY used to
display the results of a character string search.
For more detailed information about the Reference List tab, click here.
See Also
Messages and Errors List | User List | Foreign List
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Foreign List
The Foreign List tab can be displayed from within either the Messages and Errors List or the User List
tab (select New Foreign List from the right click shortcut menu).
It enables you to display a list of objects generated with another application (for example CAST's
viewer module) and which have been saved as an .XML file. You can select the .XML file you require
when you launch the tab.

A shortcut menu is also available (you can access it by right clicking anywhere in the window) enabling
you to:
●

Open the selected object. SQL-Builder may not be able to open all object types, particularly if
they are not server objects. If it is able to open the object, the Existing Connections dialog box
will be launched enabling you to select the correct server.

●

Load another .XML into the Foreign List tab.

●

Save As. Enables you to save the list under a different name (or the same name) if you require.

●

●

●

●

●

●

Export to CSV. Enables you to save the User List as .CSV file that can be opened with Microsoft
Excel (for example).
Auto resize columns. Reset the column display sizes to their defaults.
Remove Panel. Selecting this option will completely remove the Foreign List tab you are
currently working in. All objects will thus also be removed.
Edit in new User List. This option will create a new User List, and display the same objects. You
can then work with the objects as normal.
New User List. Selecting this option will create a new User List.
New Foreign List. Selecting this option will create another new Foreign List. A standard
Windows Open dialog box will be displayed enabling you to select the .XML file that contains the
list generated in another application.

See Also
Messages and Errors List | User List | Reference List
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Query Assistant
●

What is the Query Assistant?

●

Launching Query Assistant

●

Query Assistant Interface - a presentation of the main dialog box

●

Using the Mouse - how to use the Query Assistant as a point-and-click tool

●

Using the Keyboard - how to use the Query Assistant via the keyboard

●

●

●

Tips and Advanced Features - how to exploit some of the more advanced options (SELECT
Sub-Statements and ORDER-BY clauses)
Using the Auto-Join Clauses feature - includes a brief explanation of SQL Joins
Building SQL statements - a detailed description of the five supported query statements
SELECT, INSERT, UPDATE, DELETE, CURSOR
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What is the Query Assistant?
The Query Assistant is a user-friendly and powerful tool for building and developing SQL
statements. It has been designed to be used in many different ways (see the section on Query
Assistant Interface for more details), but primarily it was created in order to save development
time when writing and validating SQL queries.
To achieve this, the time-consuming part of the development of SQL statements (e.g.:
searching and obtaining syntax elements or retrieving server object information) is carried
out by the inner engine which constantly ensures the consistency of the statement.
In addition, the interface always shows you only relevant items which can be added to the query.
However, no restriction is made for the edition of complex expressions within the statement
clauses.
The Query Assistant is unique in that you can create SQL statements simply by clicking the
mouse button - no direct code entry is necessary unless you want to create a particularly
complex query. In addition, it supports the development of SELECT, INSERT, UPDATE, DELETE
and CURSOR statements.
See Also
Query Assistant Interface
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Launching the Query Assistant

Launching the Query Assistant
The Query Assistant can be accessed from wherever you are able to write SQL code, in other
words, from almost all of the Object Editors (such as the editor for a Stored Procedure) and
also from within the SQL-Session itself.
Once you are in the correct document and view, move the mouse pointer to where you want to
insert a statement in the code. Then you can:
1. Click the Template menu located on the toolbar and then select the Query Assistant
option
2. Or click the

button located on the toolbar

3. Or use the shortcut key: CTRL+Q
4. If you want to insert the query into an editor, right click at the position you want to insert
the query to launch the shortcut menu, then select the Query Assistant option.
All these options will then launch the Query Assistant main dialog box, which is explained indepth, here.
See Also
Query Assistant Interface

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/QA/QA_2Launch.htm [10/07/2008 10:46:52]

Query Assistant Interface

Query Assistant Interface
The Query Assistant main dialog box is divided into three distinct sections:
Clause Containers
So that you can build complex statements efficiently, the tabs and the grid containers on the left-hand
side of the window display the different query clauses in a simplified way.

Query Tabs

The five tabs at the top of the section enable you to build SELECT,
INSERT, UPDATE, DELETE and CURSOR statements - click the tab
which corresponds to the type of statement you would like to build.
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Clause Grids

Underneath the tabs, various grid containers are displayed according
to the query tab you select and these reflect the clauses that can be
found in the corresponding statement:
●

●

●

●

●

SELECT has FROM + SELECT clauses, plus optionally WHERE
and ORDER BY clauses.
INSERT has TARGET + VALUES clauses unless it has a SELECT
sub-statement.
UPDATE has TARGET + SET clauses and an optional WHERE
clause.
DELETE has TARGET clauses and an optional WHERE clause.
CURSOR has TARGET + UPDATE + WHERE clauses plus a
SELECT sub-statement

Server Item Browser
The server item browser on the right hand side of the window allows easy selection of all relevant
objects (databases, tables, views, etc.) that are used during the construction of the query statement.
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History Control

The familiar blue back and forward arrows along with the drop down
button
list allow rapid navigation through the history file. The
takes you directly to a higher folder level (e.g. to the server). These
options are also available in the shortcut menu explained below.

User Database and
System Database buttons

These buttons will be displayed when you are navigating around the
databases stored on your server. By pressing either button, you can
filter the type of database that is displayed in the area immediately
below.

User Tables, Views and
System Tables buttons

As with the User Database and System Database buttons
explained above, these buttons will be displayed when you are
navigating around the objects stored on the databases on your server.
By pressing any of the buttons, you can filter the type of object that is
displayed in the area immediately below.

Case-Sensitive
Completion

If you select this checkbox, case-sensitivity will be invoked when
using the keyboard to select tables and views (they will automatically
highlighted when a key corresponding to the object name is pressed).
In other words if the option is selected, typing a "D" will find only
those objects which start with "D" and will ignore objects beginning
with "d".

Auto-Join Mode

If you select this option, the foreign keys will be automatically
detected in join clauses. In addition, the Auto-Join Clauses dialog
box will be launched, which is explained here.

Shortcut Menu

If you right click in this section, a contextual menu will be launched
offering you several options. The Back, Forward and Up One level
options are all described above. The Display option will launch a submenu with three options allowing you to change the way the objects
are displayed. A black dot will appear next to the option currently
active. The Refresh option updates the contents of the viewer.
If you right click on an object, some additional options will also be
activated which are primarily used when building statements. Click
here for more information on how to do this. The use of shortcut
menus is explained in more detail here.

Query Results
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The Query Results section at the very bottom of the screen has three important functions:
●

it enables you to get a preview of the results of the query you are building

●

it displays the code itself

●

it displays any messages that may get returned from the server

Result Set Preview tab
This tab contains a read-only grid that displays the result set that is returned by the
server from the query you are building. The results are displayed here automatically when
you are in the process of building and can thus prove extremely useful when you are
validating the query.
You can also use the
button to refresh the data displayed in the tab (for
example if you increase the number of rows that can be displayed - see below), or you
can check the Auto-Refresh check box which will (as the name suggests) automatically
refresh the contents if any display changes are made. These two options are not shown
in the above image.
The Row Count Limit option enables you to choose the number of rows that will be
displayed. Simply click the up and down arrows to increase or decrease the number of
rows displayed - you can also enter a number manually with the numeric keypad. This
option is not shown in the above image.
Query Statement tab
This read-only tab will display the SQL statement exactly as it will be inserted into the
window you launched the Query Assistant from (SQL-Session or the Object Editors). You
can also use the Formatting Style drop down list to alter the way in which the code is
displayed (see example below) and the Execution Context drop down list to change the
database from which the query will be executed.
Formatting Style
●

Condensed - Each line starts with a key word.

SELECT
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'city' = a1.city, 'title' = t1.title
FROM
CASTPubs..authors a1, CASTPubs..titles t1

●

Expanded and In Line - Both are similar. Each table or column is written on a
different line as follows:

SELECT
'city'
'title'

=
=

a1.city,
t1.title

FROM
CASTPubs..authors
CASTPubs..titles

a1,
t1

Server Messages tab
This tab will launch automatically whenever the server reports that there is a problem (a
warning or error for example) with the query that you are currently building. In the case
of syntax errors, the message displayed will tell you where the problem is located so that
you can rectify it.
Status Indicator and Other Information
The three lights in the bottom left hand corner of the Query Assistant indicate as
follows:
●

Green = Valid Statement

●

Yellow = Server Busy

●

Red = Invalid Statement

The box immediately to the right of the lights also displays status information, the next
box indicates how long it took for the server to execute the statement and the final box
displays how many rows have been displayed in the Result Set Preview tab.
Other buttons

This button will paste the query in its current form into the window you accessed the
Query Assistant from.
Close
Click the close button to abort the Query Assistant session and return to the original window.
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Query Assistant - Using the Mouse

The most intuitive way to handle the Query Assistant is to use the mouse. However, if
you are familiar enough with your server objects and with SQL programming, you
may prefer to take advantage of the keyboard interface.
Drag and Drop
The ability to drag and drop server objects to the Clause Containers (see Query Assistant
Interface for more details) is by far the most practical way of building a query.
You can drag either Tables, Views or Columns, depending on the target Clause Container
considered for dropping:
FROM and TARGET (the target object of INSERT, UPDATE, DELETE and CURSOR statements)
clauses can only contain Table or View objects. All other clauses should only contain Columns
(whether these columns are defined as keys, columns and references or not) or expressions
(which may be composed with columns).
Example 1 - Building queries using drag and drop
Using the CASTPUBS example database, the aim is to build a select statement that will retrieve
the first names, last names and phone numbers of all Californian authors:
1. Ensure the query tab displays the SELECT Clause Containers.
2. Use the Server Item Browser to open the CASTPUBS database and find the AUTHORS
table.
3. Drag and drop the AUTHORS table to the FROM clause container, AUTHORS is given the
alias a1.
4. Click the WHERE clause container; the Server Item Browser will display all objects that
can be added.
5. Drag and drop the a1.STATE column to the WHERE clause container; the = operator is
selected by default.
6. Enter "CA" as the right operand expression (no need to enter any quotation marks).
7. Drag and drop a1.AU_FNAME, a1.AU_LNAME and a1.PHONE to the SELECT clause
container.
8. The following statement can now be pasted into the source code:

SELECT
'au_fname' = a1.au_fname, 'au_lname' = a1.au_lname, 'phone' = a1.phone
FROM
CASTPubs..authors a1
WHERE
( a1.state = 'CA' )
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Double-click shortcuts
If you double-click an item in the Server Item Browser, this will open the item's contents if
anything exists: (Databases contain Tables, Tables contain Columns, etc.). Note that the
view style automatically adjusts in order to obtain the most relevant information concerning the
different object levels. However, when double-clicking on a column, Query Assistant will assume
that this column is to be added to the query and it will therefore be added to the most
appropriate Clause Container. When building a SELECT statement, columns will be placed in
the SELECT clause, otherwise they will be placed in the VALUES, UPDATE or SET clauses.
Example 2 - Building queries using the mouse
This example explains how to build the same SELECT statement as in Example 1. You first need
to right-click any Clause Container to launch the contextual menu and then select Clear Entire
Query to reset the Query Assistant).
1. Locate the AUTHORS table from the CASTPUBS database and double-click on it.
2. Double-click the columns AU_FNAME, AU_LNAME and PHONE; the table AUTHORS is then
automatically added to the FROM clause and given the alias a1.
3. Drag and drop the STATE column in the WHERE clause container and enter "CA" as the
right expression.
4. The same SQL statement has now been created, but with significantly less mouse moves.
Right button shortcut menus
The Server Item Browser and all Clause Containers have contextual menus that can be
accessed with a right-button click.
With regard to the item browser, the contextual menu
(displayed here on the right) contains various commands that
can also be used to build query statements:
●

●

●

●

Open: Does exactly the same as the double-click
command (disabled on column items).
Add to Clause: Adds the selected items to the
highlighted clause container (SELECT in the current
sample).
Add to/Build WHERE Clause adds the selected items
to the WHERE clause container or builds a series of
joins if more than one column is selected.
Go to Reference Columns is a shortcut command
allowing easy navigation from reference to key
columns.
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Example 3 - Building queries using the contextual commands
Starting from either the first or the second example above, you can simply replace the drag and
drop or double-click steps with the following commands: Open, Add to SELECT Clause and
Add to WHERE Clause.
Notes
●

The Server Item Browser can display the columns of several tables at the same time (or
the tables of several databases).
To do this, select all desired objects (using SHIFT+Left Click or CTRL+Left Click) and then
choose Open from the right-button contextual menu. The view description (displayed in
the History drop-down list) indicates the list of parents.>
Example: The view "CASTPUBS.{AUTHORS,ORDERS}.<PKs,Cols,FKs>" contains all
columns of the tables AUTHORS and ORDERS from the database CASTPUBS.
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Query Assistant - Using the
Keyboard
The keyboard interface offered by the Query Assistant may be more efficient than using
the mouse to construct the SQL statement for it provides powerful controls to help you as
a keyboard user.
Advanced Completion
All Clause Containers provide an advanced editing completion feature. This completion is either
restrictive with regard to the Server Item Browser contents (i.e.: you cannot enter anything that
is not in the current view) or not. FROM or TARGET are restrictive clauses, whereas SELECT or
WHERE are not (you may enter any expression, whether based on items from the browser view
or not).
Example - how to take advantage of the Clause Container editing completion feature
This example makes use of objects from the CASTPUBS database. The aim is to build a select
statement retrieving the city locations of all the stores.
FROM Clause Container

Server Item Browser

1. Go to the FROM clause container (ALT+F) and press F2
to enter the editing mode; the Server Item Browser
automatically displays all tables in the CASTPUBS
database.
2. Press the letter "s" (see here for more information about
Case Sensitivity); the browser view then automatically
displays the five acceptable items which are the tables
sales, salesdetails, Stock, Stock_Line and stores, all
beginning with "s"
3. From this point onwards, you can then continue with the
letters "t", "o" and "r" (the "s" is automatically chosen)
so that "stores" is the only possible choice. If you
wanted to select a different object, you could use the
TAB or Down Arrow keys to return the desired result.
4. Pressing the ENTER key then validates the highlighted
item; the "stores" table is added to the FROM clause and
the expression s1.* will then appear in the SELECT
clause.
5. Go to the SELECT clause container by using the ALT+S
shortcut key; the Server Item Browser then shows the
list of columns from the "stores" table.
6. Press F2 to enter editing mode again, then press the
END key to go to the end of the s1.* expression and
remove the trailing *; the browser view will then select
all columns but no single one will be highlighted.
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7. Press the "c" and "i" keys (for "city") and confirm your
choice with the ENTER key; s1.city is then registered in
the SELECT clause container.
8. This demonstrates a simple and effective method of
constructing the following statement without using the
mouse:

The statement will look like this after you have completed the instructions above:

SELECT
'city' = s1.city
FROM
CASTPubs..stores s1

Shortcut Keys
In the previous section it was demonstrated how easy it is to switch back and forth between the
Clause Containers and activate the edit mode (F2). The Query Assistant, however, provides
many shortcut keys to ease the life of keyboard users.
Some of these shortcuts are displayed below:
●

ALT+Left Cursor and Alt+Right Cursor to navigate through the Server Item Browser
history (ALT+H and F4 to view the history contents)

●

Backspace to go up one level, Enter to open an item in the Server Item Browser

●

F5 to refresh the Server Item Browser view

●

●

●

ALT+J to disable or re-compute the join clause detection (Alt+T to display the Auto Join
Clauses dialog box)
Context key or SHIFT+F10 to launch contextual menus at any location
ALT+R activates the Result Set Preview tab or refreshes the data grid if the tab is
already visible

●

CTRL+A to select all non-empty lines within a Clause Container

●

Delete to remove the selected line from a Clause Container

●

Insert to create a new blank line above the focused cell in a Clause Container

●

CTRL+Up/CTRL+Down to move selected Clause Container lines up and down

●

CTRL+Shift+Home/CTRL+Shift+End to move selected Clause Container lines to the
top or bottom

Shortcut menus
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QA - Using the Keyboard

As with mouse users, keyboard users may find contextual menus very useful.

Example - The WHERE
Clause Container
By pressing the Context
key in the Where Clause
Container, the menu
shown in the figure on
the right will be launched
Users can then press the
letter L to access the
logical expression
management commands.
Note that users may also
use the direct shortcuts
which match the buttons
that can be found
underneath the Where
Clause Container.
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QA - Tips and Advanced Features

Query Assistant - Tips and Advanced Features

When exploring Query Assistant you will find many more features which are accessible
when necessary. The purpose of such an interface tool is to remain as efficient and easy-touse as possible whenever the user is editing either a basic or a complex query statement.
ORDER-BY Clause
The ORDER-BY Clause Container is available when building a SQL SELECT statement (click here
for more information about building a SELECT statement). To access it, right-click the SELECT
Clause Container with the mouse and choose the View ORDER-BY Clause command from the
contextual menu.
The window containing the ORDER-BY Clause (see image) is a non-modal dialog box, therefore
you can continue working with the main dialog box even when located on top of it.

You can select the
ORDER-BY direction by
clicking the Direction
column and selecting
from the drop down list.
This window also
contains quick add and
remove buttons (left
and right arrows) and a
sub-instance of the
Server Item Browser,
displaying only the
columns of tables in the
FROM Clause.

SELECT Sub-statements
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QA - Tips and Advanced Features

Whenever you need to build an INSERT...SELECT, the SELECT STATEMENT... button allows you
to access a sub-instance of the main dialog box which only contains the SELECT tab.
This sub-SELECT should be built exactly the same way as you would build a normal SELECT
statement. Click the Close button when you have finished with the sub-statement and the
parent query will reflect the changes made.
This feature is also available when you are building a CURSOR statement:
●

Launched by the SELECT STATEMENT button in Oracle versions

●

Launched by the FOR READ ONLY button in SQL-Server/Sybase versions

As with the INSERT...SELECT statement described above, you can change the items in the
SELECT clause, but the FROM clause will remain read-only.
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QA - Using the Auto Join Clauses feature

Query Assistant - Using the Auto Join Clauses feature

What does it do?
In essence, the Auto Join Clauses dialog box enables you to easily build or include join
clauses between linked tables that have Foreign Keys.
Each join detected by the Query Assistant is represented by a numbered row down the left
hand side of the dialog box. You can then select the check box on each row if you want to include
that join in the query. Finally, select the join type you require from the drop down list and press
the OK button to return to the Query Assistant window. Click Cancel to abort the process.
If the Generate Ansi-mode-auto-joins in Query Assistant option is checked in the General
Configurations section (click here for more details), auto-joins will be generated in ANSI Mode
(in the FROM clause). However, this will also mean that only inner joins will be allowed.
When the option is left unchecked, if you don't want to use an inner join, you can also select a
left outer join or a right outer join for each checked row.
Example of ANSI-mode-auto-join:

SELECT
p1.*,
s1.*
FROM
Northwind..Suppliers

s1
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QA - Using the Auto Join Clauses feature

Inner join
On

Northwind..Products
p1.SupplierID
=

p1
s1.SupplierID

What are joins?
There are three types of Joins offered in the Auto Join Clauses dialog box:
●

Inner Join
An Inner Join is an operation which selects rows from two tables where the value in one
column of the first table also appears in a certain column of the second table.
For example in SQL this could read as:

SELECT * FROM A, B
WHERE A.x = B.y
In the above example, A and B are the tables. The column names (x and y in this
example) can be, but are not necessarily, the same.
●

Left Outer Join and Right Outer Join
An Outer Join, also includes ALL rows from the first operand ("left outer join", "*="), or
the second operand ("right outer join", "=*").
For example, if you wanted to obtain a list of all employees and their employee ID
number, but not all employees have a number, then in SQL you could do the following:

SELECT employee.name, empnum.number
WHERE employee.id *= empnum.id
The "*" means "left outer join" and signifies that all rows from the "employee" table will
appear in the result, even if there is no match for their ID number in the "empnum" table.
Accessing the Auto Join Clauses feature
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QA - Using the Auto Join Clauses feature

When you are creating a SELECT statement (click here for more information on SELECT
statements), the Query Assistant will automatically detect if two tables or views that you have
added to the FROM clause are joined. If a join is detected, the Auto Join Clauses dialog box
will be automatically launched (see image below).
If you then return to the Query Assistant main window, you can go back to the Auto Join
Clauses dialog box by clicking the

button in the main Query Assistant

window when the SELECT tab is active. The number next to Auto Joins in the button
corresponds to the number of joins between tables in the FROM clause detected by the Query
Assistant.
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Building SQL Statements

Building SQL Statements
The primary function of the Query Assistant is to facilitate the construction of SQL statements
or queries. This section provides a detailed description of all five of the Query Assistant clause
tabs (SELECT, INSERT, UPDATE, DELETE and CURSOR).
Please choose a statement type that you would like to know more about:
●

SELECT Statements

●

INSERT Statements

●

UPDATE Statements

●

DELETE Statements

●

CURSOR Statements
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SELECT Statement

SELECT Statement
You can build a SELECT statement by clicking the SELECT tab from the Query Assistant main
window, which is explained in detail here.

The SELECT tab is divided into three sections:
SELECT section
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SELECT Statement

The selection of expressions depending on columns of the selected tables and views in the FROM
section is made here in the SELECT section. Columns can be selected by typing their name or by
selecting them in the navigation interface on the right-hand side of the Query Assistant Window.
Expression Column

Expressions made with constants, operators, aggregates,
functions and columns of the selected tables and views in the
FROM grid can be entered here.

Assignment/Description
Column

Enter the name you want to assign to your expression, or an
output variable in this column.

Datatype Column

Displays your expression data type.

FROM section
The selection of referenced tables and views in your query is made in the FROM grid. You can
select tables and views by typing their name or by selecting them in the navigation interface on
the right-hand side of the Query Assistant Window.
Source Object Column

Enter the table or view names here.

Database Column

Displays the Source Object database.

Alias Column

Enter the name you want to assign to your selected table or view
in this column.

WHERE section
You can make your selection of data filters in the WHERE grid.
Expression Columns

Expressions made with constants, operators and columns of
the selected tables and views in the FROM grid can be entered
here.

Operator Column

Enter the comparison operator between the two selected
expressions in the current row in this column. You can select
these from the drop down list.
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SELECT Statement

Buttons

The default WHERE clause is made with each row of the WHERE
section linked by an AND operator. You can modify this by
selecting rows in the WHERE grid and clicking on the parenthesis
buttons or one of the Boolean operator buttons.
button will add an open parenthesis on the left of the
The
first selected row, and a closed parenthesis on the right of the
last selected row.
The

button will add a "!" (negation operator) before each

and
buttons will respectively add
selected row and the
"AND" and "OR" operators between each selected row.
Auto Joins... button
When Query Assistant detects joins between objects in the
FROM clause, you can launch the Auto Join Clauses dialog
box, which is explained in more detail here.
Notes
●

●

Please note that Query Assistant's auto completion feature can help you type your
object names. For example, if you enter the first few letters of a column in the WHERE
grid, Query Assistant will automatically suggest the full column name.
You can find out more information about creating SQL statements with the Query
Assistant using the Mouse and the Keyboard.
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INSERT Statement

INSERT Statement
You can build an INSERT statement by clicking the INSERT tab from the Query Assistant main
window, which is explained in detail here.

The INSERT tab is divided into two sections:
INSERT section
Insertions to be made and their target table can be selected in the "INSERT" grid. Selection of
the table is made by typing its name or by selecting it in the navigation interface on the righthand side of the Query Assistant Window.
Target Object Column

Enter the target table in which insertions are to be made in this
column.

Database Column

Enter the selected target table database in this column.

VALUES section
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INSERT Statement

The VALUES section is where you can select the selected target table columns and expression
values you want to insert into these columns. Columns can be selected by typing their name or
by selecting them in the navigation interface on the right-hand side of the Query Assistant
Window.
"Column" Column

Enter the selected table column names here.

Datatype Column

Displays the selected column data type.

Assignment Column

Enter the variable or constant value you want to assign to the
selected column here.

Notes
●

●

●

The SELECT STATEMENT button launches a new window which enables you to construct
a SELECT statement into which a result set will be inserted in the target table. This button
is described here in more detail.
Please note that Query Assistant's auto completion feature can help you type your
object names. For example, if you enter the first few letters of a column in the WHERE
grid, Query Assistant will automatically suggest the full column name.
You can find out more information about creating SQL statements with the Query
Assistant using the Mouse and the Keyboard.
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UPDATE Statement

UPDATE Statement
You can build an UPDATE statement by clicking the UPDATE tab from the Query Assistant main
window, which is explained in detail here.

The UPDATE tab is divided into three sections:
UPDATE section
The selection of the target table to be updated is made in the "UPDATE" section. You can select
the table by typing its name or by selecting it in the navigation interface on the right-hand side
of the Query Assistant Window.
Target Object Column

Enter the target table to be updated in this column.

Database Column

Enter the selected target table database in this column.

SET section
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UPDATE Statement

You can select columns of the selected target table and expression values you want to assign to
these columns here. Columns can be selected by typing their name or by selecting them in the
navigation interface on the right-hand side of the Query Assistant Window.
"Column" Column

Enter the selected table column names here.

Datatype Column

Displays the selected column data type.

Assignment Column

Enter the variable or constant value you want to assign to the
selected column here.

FROM CLAUSE... button

When you click this button, a new window will be launched
enabling you to build a SELECT Statement where the result set
will be used for assignment in the "SET" grid.

WHERE section

The WHERE section is where the selection of data filters is made.
Expression Columns

Enter expressions made with constants, operators and columns of
the target table in this column.

Operator Column

Enter the comparison operator between the two selected
expressions in the current row in this column.

Buttons

The default WHERE clause is made with each row of the WHERE
section linked by an AND operator. You can modify this by
selecting rows in the WHERE grid and clicking on the parenthesis
buttons or one of the Boolean operator buttons.
The
button will add an open parenthesis on the left of the
first selected row, and a closed parenthesis on the right of the
last selected row.
The

button will add a "!" (negation operator) before each

and
buttons will respectively add
selected row and the
"AND" and "OR" operators between each selected row.
Notes
●

●

Please note that Query Assistant's auto completion feature can help you type your
object names. For example, if you enter the first few letters of a column in the WHERE
grid, Query Assistant will automatically suggest the full column name.
You can find out more information about creating SQL statements with the Query
Assistant using the Mouse and the Keyboard.
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UPDATE Statement
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DELETE Statement

DELETE Statement
You can build a DELETE statement by clicking the DELETE tab from the Query Assistant main
window, which is explained in detail here.

The DELETE tab is divided into two sections:
DELETE section
Rows to be deleted and their target table can be selected in the "DELETE" grid. The table can be
selected by typing its name or by selecting it in the navigation interface on the right-hand side of
the Query Assistant Window.
Target Object Column

Enter the target table in which the deletion is to be made in this
column.

Database Column

Enter the selected target table database in this column.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/M...BLD/Features/QA/Statements/QA_Build_4DELETE.htm (1 of 2) [10/07/2008 10:47:14]

DELETE Statement

FROM CLAUSE button

This button launches a new window enabling you to construct a
SELECT Statement which will sharpen the WHERE clause of the
DELETE statement.

WHERE section
The "WHERE" section is where the selection of data filters is made.
Expression Columns

Expressions made with constants, operators and columns of
the selected tables and views in the FROM grid can be entered
here.

Operator Column

Enter the comparison operator between the two selected
expressions in the current row in this column. You can select
these from the drop down list.

Buttons

The default WHERE clause is made with each row of the WHERE
section linked by an AND operator. You can modify this by
selecting rows in the WHERE grid and clicking on the parenthesis
buttons or one of the Boolean operator buttons.
button will add an open parenthesis on the left of the
The
first selected row, and a closed parenthesis on the right of the
last selected row.
The

button will add a "!" (negation operator) before each

and
buttons will respectively add
selected row and the
"AND" and "OR" operators between each selected row.
Notes
●

●

Please note that Query Assistant's auto completion feature can help you type your
object names. For example, if you enter the first few letters of a column in the WHERE
grid, Query Assistant will automatically suggest the full column name.
You can find out more information about creating SQL statements with the Query
Assistant using the Mouse and the Keyboard.
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CURSOR Statement

CURSOR Statement
You can build a CURSOR statement by clicking the CURSOR tab from the Query Assistant main
window, which is explained in detail here.

The CURSOR tab is divided into three sections:
CURSOR section
The CURSOR section is where the selection of the cursor target table is made. You can select the
table or view by typing its name or by selecting it in the navigation interface on the right-hand
side of the Query Assistant Window.
Target Object Column

In this column you can enter the source table or source view for a
read only cursor, or select a target table for an Update Cursor.

Database Column

In this column the selected source table or view database can be
entered.

Cursor Name Column

This column enables you to enter a name for the CURSOR
statement.
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CURSOR Statement

COLUMNS section
The "COLUMNS" grid is where the selection of columns of the selected target table or of views
and expression values you want to assign to these columns is made. Users can select columns by
typing their name or by selecting them in the navigation interface on the right-hand side of the
Query Assistant Window.
"Column" Column

You can enter the selected table or view column names here.

Datatype Column

This command will display the selected column data type.

Assignment Column

Enter the variable or constant value you want to assign to the
selected column for an Update Cursor here.

FOR READ ONLY...
button

This button launches a new window enabling you to construct a
SELECT statement where the result set will be used for
assignment in the "SET" grid.

WHERE section
The "WHERE" grid is where the selection of data filters is made.
Expression Columns

Expressions made with constants, operators and columns of
the selected tables and views in the FROM grid can be entered
here.

Operator Column

Enter the comparison operator between the two selected
expressions in the current row in this column. You can select
these from the drop down list.

Buttons

The default WHERE clause is made with each row of the WHERE
section linked by an AND operator. You can modify this by
selecting rows in the WHERE grid and clicking on the parenthesis
buttons or one of the Boolean operator buttons.
button will add an open parenthesis on the left of the
The
first selected row, and a closed parenthesis on the right of the
last selected row.
The

button will add a "!" (negation operator) before each

and
buttons will respectively add
selected row and the
"AND" and "OR" operators between each selected row.
Notes
●

Please note that Query Assistant's auto completion feature can help you type your
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CURSOR Statement

object names. For example, if you enter the first few letters of a column in the WHERE
grid, Query Assistant will automatically suggest the full column name.
●

You can find out more information about creating SQL statements with the Query
Assistant using the Mouse and the Keyboard.
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Search in SQL-Objects

Search in SQL-Object
●

What is the Search in SQL-Objects option?

●

Launching Search in SQL-Objects

●

Step 1: Specifying the Search Location

●

Step 2: Entering the Search String

●

Step 3: Report

●

Results
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What is the Search in SQL-Objects option?

What is the Search in SQL-Objects option?
SQL-Builder provides a tool that enables you to search for any word, series of words or regular
expressions located in SQL objects. You can also specify the database/schema, type of object or
the individual objects you want to search.
The Search in SQL-Objects feature thus offers you:
●

●

●

●

the option of identifying all explicit references contained in all server objects
support for regular expressions used to describe the different forms of the word (or
series of words) being searched for
automatic positioning on the lines of identified code to enhance comprehension
the possibility of saving the results to an .XML file type so that they can be exported
via E-Mail or for reporting, etc.

See Also
Launching Search in SQL-Objects
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Launching Search in SQL-Objects

Launching Search in SQL-Objects
Search in SQL-Objects is a wizard based option that can be launched from the majority of
features in SQL-Builder by doing one of the following:
1. Clicking Navigation > Search in SQL-Objects... option from the drop down menu.
2. Right-clicking anywhere in the Object Manager (in the right hand section of the Object
Manager, when working in two pane view, you will need to select an object/object type
first by left clicking it once) to launch the shortcut menu and then selecting the Search in
SQL-Objects... option.
Once you have completed either of these actions, Step 1 of the Search In SQL-Objects Wizard
will be launched.
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Step 1: Specifying the Search Location

Step 1: Specifying the Search Location
When you first launch the Search in SQL-Objects Wizard, the first screen you will see enables
you to select the location for your search. You can, for example, search the entire server and
all the databases/schemas stored on it, or you can search specific objects in specific
databases/schemas.
Thus you have the ability to search on both a wide and narrow scale. This page describes how
to select your search location and provides tips on how to use the built-in shortcuts that can help
when you make this selection.

Interface
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Step 1: Specifying the Search Location

Left-hand column
This section displays the contents of the server, i.e.: its various sub-items (instance,
schema/databases, analyses, object types and objects). You can browse the tree structure with
the mouse.
Selecting an object causes all of its "children" to be automatically selected as well. This is
indicated by a check mark in the object checkbox. However, a gray check mark next to an object
indicates that only some of its "children" are selected.
Some handy and useful shortcut keys also exist:
●

●

●

A single click with the mouse (in the left-hand list) will display the contents of a node (in
the right-hand list)
A double click with the mouse (in the left-hand list) will expand a node or open a
terminal object.
You can move through the list with the arrow keys or with the [PgUp], [PgDn], [Home]
and [End] keys

●

Press [Return] to open (and expand or collapse) the currently selected node

●

To force expansion of the selected node use the [+] key

●

The [-] key forces its collapse.

●

●

Typing the first letter(s) of the object will automatically select the corresponding object the selection will change according to the key(s) entered.
Browse through objects with the same initial, pressing the same key as often as needed. If
nothing matches the key(s) pressed, a short beep will be emitted (when this occurs, note
that the next key stroke will cause a new search)

Right-hand column
The right-hand section displays the contents of the item that you select in the left-hand section.
When objects are displayed here, any relevant information about them is displayed in the various
self-explanatory columns.
You can sort the objects displayed in the right-hand section according to each column and in
ascending or descending order.
Click the relevant column name and the objects will be sorted in ascending or descending
order accordingly.
Selecting the search location
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Step 1: Specifying the Search Location

To select your search location:
1. Left click in the check box next to the item that you want included in the search. If you
select a database/schema, all the objects stored in that database/schema will also be
selected. If, for example, you want to search the whole server, simply check the server
check box which will then check ALL the databases/schemas and objects stored on it.
2. You can also check individual objects should you require, thus enabling you to narrow
down the search field. If you only check some of the objects within an Object Type
group, the parent folder check box will be grayed as shown on the right here.
3. When you have selected the locations for the search, click the Next button located at the
bottom of the wizard window. This will then move you on to Step 2.
See Also
Step 2 - Entering the Search String | Step 3 - Report | Results
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Step 2: Entering the Search String

Step 2: Entering the Search String
Step 2 of the Search in SQL-Objects Wizard enables you to enter the search string and define
various other Advanced parameters if you require.
When first launched the two lower advanced option areas (Expression Search In and Regular
Expression) are not displayed and will only be displayed when you click the Advanced button.

Expression
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Step 2: Entering the Search String

The upper most area entitled Expression, enables you to enter the phrase or word that you
want to find in your server objects.
To enter a Search Expression:
1. Left-click in the Find What combo box
2. Enter the word or phrase that you want to search for.
Notes
●

All the expressions that you enter in the combo box will be saved so that you can use
them again. Click the down arrow on the right-hand side of the combo box and select
the expression you require from the drop down list. This feature enables you to avoid
typing in expressions that you search for on a regular basis - up to ten previous
expressions can be stored.

Match whole word only
If you select this option, the results that are returned by the search will correspond exactly to
the string you enter in the Expression text box.
For example (see text example below for corresponding numbers):
Search String = TITLE[A-Z]+ will identify the following hypothetical results:
●

1, 5 for string: TITLES

●

4, 5 for string: TITLEAUTHOR

●

6, for string: TITLES_AUTHOR

●

7, for string: TITLEA_AUTHOR

●

8, for string: TITLES_____AUTHOR

●

9, for string: TITLESAUTHOR

●

11, for string: TITLEdAUTHOR

If you leave this option blank, then the default setting will be applied. In effect this means that
the results that are returned by the Reference Finder will correspond in part to the string you
enter in the Expression text box.
For example (see text example below for corresponding numbers):
Search String = TITLE[A-Z]+ will identify the following hypothetical results:
●

1, 2, 5 for string: TITLES, _TITLES, TITLES

●

4, 5 for string: TITLEAUTHOR

●

6, for string: TITLES_AUTHOR

●

7, for string: TITLEA_AUTHOR

●

8, for string: TITLES_____AUTHOR

●

9, for string: TITLESAUTHOR
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Step 2: Entering the Search String
●

11, for string: TITLEdAUTHOR

Text Examples
●

1. 'select * from TITLES

●

2. 'select * from _TITLES

●

3. 'select * from vTITLE

●

4. 'select * from TITLEAUTHOR

●

5. 'select * from TITLEAUTHOR, TITLES

●

6. 'select * from TITLES_AUTHOR

●

7. 'select * from TITLEA_AUTHOR

●

8. 'select * from TITLES_____AUTHOR

●

9. 'select * from TITLESAUTHOR

●

10. 'select * from TITLE

●

11. 'select * from TITLEdAUTHOR

Match Case
If you select this option, the search will only return results that match the case sensitivity of
the string you entered.
In other words, if you enter Select, the Reference Finder will not return SELECT or select. By
default this option is left blank, meaning case sensitivity will be ignored.
Advanced options

If you want to include more advanced options in your search, then click the

button

which will then display the bottom two option fields entitled Expression Search In and Regular
Expression.
Expression Search In
Code except quoted
strings and comments

If you select this option, the wizard will search for your
expression in all SQL code but will ignore Quoted Strings (i.e.
code between quote marks) or Comments (i.e. - / EXAMPLE /) in
the code. This option will be checked by default.

Quoted Strings

If you select this option, the wizard will search for your
expression in Quoted Strings only (i.e. code between quote
marks). This option will be checked by default.

Comments

If you select this option, the wizard will search for your
expression in Comments only (i.e. - / EXAMPLE /).

You can select more than one of these options if you require a certain search combination.
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Step 2: Entering the Search String

Regular Expression
Use Regular
Expressions

Select this option if you want to include Regular Expressions in
your search. If you enter an incorrect Regular Expression, the
wizard will launch a warning dialog box when you click the Next>
button.
Click here to find out more about Regular Expressions (the
Help Regular Expression button in the wizard will also launch
this page.)

What to do next?
Once satisfied with your selections, click <Back to return to previous step, Next> to move on
to the next step, Finish to go directly to the Step 3 or Cancel to abort the process.
See Also
Step 1 - Specifying the Search Location | Step 3 - Report | Results
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Step 3: Report

Step 3: Report
The Report step is always the final step in the wizard. All settings are summarized here so that
you can review them and make amendments (by clicking the <Back button to return to the
corresponding step).
Various options are also available, each one is explained below:
Save Report
You can use the Save report... button to create a copy of the search settings on your PC. A
standard windows Save As dialog box will be launched enabling you to select a location for a
.TXT or .HTML file.
What to do next...
Once the settings have been reviewed and you are satisfied, click Search to start processing the
search.
If you want to make any amendments, click <Back until you reach the required Step, make your
changes and then return to the Final Step again.
For more information about how search results are displayed, please click here.
See Also
Step 1 - Specifying the Search Location | Step 2 - Entering the Search String | Results
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Search in SQL Objects: Results

Search in SQL Objects: Results
The Reference List tab displays the results of the search carried out by the Search in SQL-Objects
function. The objects containing the search expression you entered in Step 2 - Entering the Search
String will be displayed along with the matched string.

Interface explained
The Reference List contains a list of all the objects which contain the matched string found by SQLBuilder. This tab is NOT normally visible when using other functions and is ONLY used to display the
results of a character string search.
Each result is displayed in the tab, along with the server and database/schema the object is stored
in, the object type, the owner of the object, the object name, the name of the file representing
the object (File - only if object is saved as a file) and finally the matched string.
Sorting the Objects
You can sort the results in ascending or descending order should you require. To do so, left click the
column heading to toggle between ascending and descending order. A small arrow icon on the
column heading will indicate the sort direction. You can only sort the objects one column at a time,
but all columns can be sorted.
Displaying the matched string in the object's code
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To display the matched string in the object's code, double-click the object whose code you want to
view. The object will then be opened and the matched string will be automatically book marked:

Reference List Shortcut menu
Right clicking an object in the Reference List tab will launch a shortcut menu that enables you to carry
out various operations, all explained in more detail below:
Open

This option will open the selected object. This is the same as doubleclicking an object in the list.

Remove

This will delete the selected object from the list - particularly useful if
you have an erroneous result that you do not want to include when
saving the results (see below).

Load

Select this option if you have previously saved your results (using the
Save As option explained below). A standard Windows Open dialog
box will be launched enabling you to select the file you require.

Save As

Use this option to save the results of your search analysis as an .XML
file type. This means you can access the result at any time after you
have closed the Reference List. A standard Windows Save dialog box
will be launched enabling you to select a filename and location.

Save

Use this option to save the results again.

Export to CSV

Export the results to a .CSV file that can be read in Microsoft Excel for
example.

Order: by Server, by
Database, by Owner, by
Object Name, by Object
Type

Selecting an option in the sub menu will sort the results in ascending
or descending order accordingly. You can also sort the results by
clicking a column heading.

Auto resize columns

Reset the column display sizes to their defaults.
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Show flag column

Displays a new column in the Reference List that indicates whether the
object has been flagged in the Knowledge Base (you will need to be
using a Knowledge Base for this to function, see Knowledge Base
connection).

Clear All

Removes all results from Reference List tab.

Remove Panel

Removes the Reference List tab. To re-display it, you need to carry out
another search operation.

New User List

Opens a new User List.

New Foreign List

Selecting this option will create another new Foreign List. A standard
Windows Open dialog box will be displayed enabling you to select the
.XML file that contains the list generated in another application - see
here for more information.

See Also
Step 1 - Entering the search string | Step 2 - Specifying the Search Location | Step 3 - Report
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SQL-Session

SQL-Session
●

What is the SQL-Session?

●

Launching an SQL-Session

●

SQL-Session window - what are the main components in the SQL-Session window?

●

Entering an SQL Query

●

Sending a Query to the Server

●

Multiple Query Execution

●

Stopping or Pausing Query Execution

●

Using the History Log File

●

Printing from the SQL-Session window

●

Using the Previous Query/Next Query Commands

●

Using Detailed Output

●

No Exec/Show Plan

●

Configuring your SQL-Session

●

Advanced Options - Save Editor Content, Run SQL-Script, Save All Results, Run Test
Session etc...
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What is the SQL-Session?

What is the SQL-Session?
The SQL-Session enables you to test your objects and applications by sending them to your SQL
server.
You can open as many SQL-Sessions as necessary and connect to as many SQL servers as
necessary. Once you have entered your SQL code and sent it to the server, the results will be
displayed in an easy-to-view format.
In addition, SQL-Builder's SQL-Session enables you to save your SQL statements and any
associated results in a log file, thus allowing you to replay any of your successful SQL queries at
any time.
See Also
Launching an SQL-Session
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Launching an SQL-Session

Launching an SQL-Session
There are several ways to open an SQL-Session:
1. You can select the New SQL-Session command from the File menu located on the menu
bar
2. You can click the

button located on the toolbar

3. You can use the shortcut key, CTRL+W
4. Or you can right a Profile click in the Object Manager to launch the shortcut menu shown
and then choose the New SQL-Session command. This option will NOT call the
Connection dialog box (see below) but will instead use the selected Profile's server
connection.
The first three options will then launch the Connection dialog box in which you need to specify
the server on which you want to work, together with a username and the corresponding
password. Click OK once you have entered the appropriate information and the SQL-Session
window will then be displayed.
Reset Connection - SQL-Server/Sybase users only
This command enables you to close the current SQL-Session connection (i.e.: the current
DbProc) and then re-open it with exactly the same parameters. If the connection you reset is
shared then all the sessions that are using the same connection will also be reset.
This command is very useful when testing Stored Procedures that use temporary tables under
interactive mode. To use the command:
1. Click the File menu located on the toolbar and select Reset Connection (only available
when the SQL-Session is active).
Notes
●

●

You can open more than one SQL-Session window if you require whether to the same
server, or to a different server(s).
You can also open a "light" SQL-Session, which can be quicker to open and more
responsive. See the SQL-Session tab for more information.
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SQL-Session window

SQL-Session window
The SQL-Session window as displayed below, is split into two sections:

Results Section
The upper section is known as the Results Section, in which the results of any query sent to the
SQL server are displayed.
On the left hand side of this section, there are two tabs:
●

●

The Text tab will display the query results in simple text format
The #1 tab will display results in a grid format. Sometimes, when entering multiple queries in
the Query Editor, there will be more than one grid format tab (named #2 and #3 for
example, depending on the number of queries entered) which will each display the result of
an individual query. Please click here for more information about entering multiple queries.

The Results Section is a "read-only" editor, although you can use the toolbar command Copy
in both the Text and Grid format.
You can change the visual presentation of the Results Section by clicking the Options > Current
SQL-Session Configuration... option from the drop down menu. If you do change a parameter here,
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SQL-Session window

the Results Section will be instantly modified - there is no need to re-send your query to the
server.
Notes
●

You can switch between the Text Format tab and the Grid Format tab by using the shortcut
keys CTRL+PGUP and CTRL+PGDN.

Query Editor
The lower section is known as the Query Editor in which you can enter your SQL commands and it
provides all the standard editing features used by other CAST editors such as syntax highlighting,
box/stream selection mode, auto-indent etc...(click here to find out more information about the
editing features provided by CAST Products). You can also use the clipboard commands
copy/cut/paste and the Find and Replace dialog boxes can be accessed from the Edit menu
located on the toolbar
Notes
●

To find out more about entering queries, click here.

Notes
●

●

If you want to change the sizes of the two sections, place the mouse on the dividing bar
between the two sections and then left click and hold down the mouse button and move to
your preferred size.
The title of the SQL-Session window displayed in the top left-hand corner (sa@castpubs in
the example above) displays the user name and the server that this user name is connected
to. A number in square brackets before the user and server name (i.e.: :[2]) indicates the
number of SQL-Sessions that have been opened during the current SQL-Builder session.

See Also
Entering an SQL Query | SQL-Session Display tab | Editor Features
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Entering an SQL Query

Entering an SQL Query
In the Query Editor section (lower section) you can enter your SQL query and then send it to the
server you are connected to. In the image below, a simple SQL query has been entered (note the
syntax highlighting in operation):

If you want to define several queries at a time in the same SQL-Session, separate them with a
carriage return or a SPACE. Each query you enter will then be run one after the other when the
entire script is sent to the server (click here for more details on how to do this).
Inserting Code Templates
You can also insert a pre-defined code template if you know that you are going to use a standard
query. To do this, you can:
1. Drag and drop them directly from the Code Templates tab.
To find out more about using Templates, click here.
Using the Query Assistant to enter code
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Entering an SQL Query

You can also insert an SQL query into the Query Editor direct from the Query Assistant. The
Query Assistant is a powerful tool designed to facilitate the development of SQL statements.
To enter a query with the help of the Query Assistant:
1. Left click in the Query Editor section at the point at which you want to insert the query and
then click the Template menu located on the toolbar and then select the Query Assistant
option from the drop down menu.
2. Or right click at the position you want to insert the query to launch the shortcut menu, then
select the Query Assistant option
3. Or click the

button located on the right hand vertical toolbar menu

4. Or use the shortcut key: CTRL+Q
All of these options will then launch the Query Assistant main dialog box, explained here. Once the
query is pasted in the Query Editor, you can send it to the server like any other SQL query.
Drag and drop objects
You can also drag and drop objects from the Object Manager. This is most useful in the case of
Stored Procedures, however, please see the General tab for more information about activating the
Ask parameter value when executing procedures if you require SQL-Builder to display a
Parameter Input dialog box to allow you to enter any required procedure parameters.
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Sending a Query to the Server

Sending a Query to the Server
When you have finished editing your SQL query or queries, you can then send it or them to the
server in order to obtain the information you require.
To do this you can:
1. Click the TSql menu located on the toolbar, and then select the Go command from the drop
down menu.
2. Click the

button located on the toolbar.

3. Use the shortcut key CTRL+G
If the query was executed correctly, it will be transferred from the Query Editor to the Results
Section.
Notes
●

Please make sure that you are working in the correct database BEFORE you send the query to
the server. For more information see Changing the working database.

Text Format
The example above shows the results of the query displayed in text format (the Text tab is active).
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Sending a Query to the Server

A shortcut menu can be accessed by right clicking anywhere in the window. It enables you to:
●

copy selected text

●

add a bookmark to the selected line

●

move to the next bookmark

●

open a selected object

●

show the command history

●

or send the command to the server

Grid Format
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Sending a Query to the Server

Below is an example of the query results displayed in grid format:

A shortcut menu can be accessed by right clicking anywhere in the window. It enables you to
●

copy selected text

●

adjust column width (all or selected columns)

●

save the selected results to file (as an Excel compatible .CSV file)

●

show the command history

●

send the command to the server

What to do if not all the results are visible
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Sending a Query to the Server

If you cannot view all the results from your SQL query, you can alter the SQL-Session configuration
parameters by clicking the Options > Current SQL-Session configuration.
1. Select the SQL-Session Display tab and in the General Output area, increase the number
of rows that the SQL-Session will display. (You can also access this tab by selecting the
General Configuration command from the Options drop down menu).
You can also alter the number of rows displayed in the Results Section by
using the toolbar. On the far right hand side of the toolbar, you can enter the
number of rows to be displayed by using the combo-box. You can either
manually enter the number, or you can click the arrow and choose from
several options.
You can force SQL-Builder to display the maximum number of lines (32,000) by sending the
query to the server by using the command CTRL+ALT+G (instead of the normal shortcut key
CTRL+G), or by displaying a previous/next result (click here for more information about
previous and next results) with CTRL+ALT+P/CTRL+ALT+N (instead of ALT+P and ALT+N).
When the server returns a fail status
If the server returns a fail status (i.e.: if the query is incorrect or there are syntax errors) then the
appropriate error message will appear in the Messages and Errors List. The query which returned
the error message will then remain in the Query Editor so you can rectify the problem.
If the query successfully returns results, the Query Editor will be emptied and will then become
available for you to enter a new query.
Notes
●

If you want to delete the entire contents of the SQL-Session (Query Editor and Results
Section) at any other time, you can do so by clicking the Edit menu located on the toolbar
and then selecting the Erase Buffer option from the drop down menu.
Please be aware however, that this option will also erase the entire contents of the
History Log File.

●

When using the SQL-Session, the Knowledge Base will NOT be updated. When creating a
table in a SQL-Session, comments are added at the end of the code so that the Knowledge
Base can be updated with the modified object.
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Multiple Query Execution
Entering Multiple Queries
If you want to enter several SQL queries in the Query Editor at the same time, it is possible to do
this as shown by the example below.

Here, two simple SQL select queries have been entered in the Query Editor, and have been
separated by a carriage return.
As with a normal single query, you can send this to the server (for more details about how to do
this, click here), which will then return both results at the same time in either Text Format, or
Grid Format. (In the case of Grid Format, a tab for EACH query result will be available).
Sending Multiple Queries to the server individually
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Multiple Query Execution

If you want to enter multiple queries in the Query Editor, but send them one-at-a-time to the
server you can do so by marking or selecting the query you want to send as displayed below:

When you click the

button located on the toolbar to send the query to the server (click here,

to find out more about how to do this), only this query is sent and not the other queries that
you may have also entered in the Query Editor. Thus if the query is successful, ONLY the
results for this query are displayed in the upper Result Section.
In addition, all the queries will remain in the Query Editor (normally the Query Editor section
is cleared after a query is successfully sent to the sever), enabling you to progressively extend
the marked area to encompass all queries step-by-step. You won't have to re-enter the queries
manually, and nor will you have to use the History Log File to re-obtain the previous query.
See Also
Using the SQL-Session History Log File
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Stopping or Pausing Query Execution

Stopping or Pausing Query Execution
Stopping
If you want to stop a query being executed (i.e.: when it is being sent to the server) you can:
1. Click the TSql/Pl-Sql (according to your server version) menu located on the toolbar and
then select the Stop command from the drop down menu
2. Or you can click the

button located on the toolbar

The query will then fail and all lines sent to the server will be deleted.
Pausing
If you want to pause the return of query results during the execution process, you can:
1. Click the TSql/Pl-Sql (according to your server version) menu located on the toolbar and
then select the Pause command from the drop down menu
2. Or you can click the

button located on the toolbar

The return of the query results will then be paused. If you want to re-start the execution
process, you can:
1. Click the TSql/Pl-Sql (according to your server version) menu located on the toolbar, and
then select the Go command from the drop down menu
2. Or click the

button located on the toolbar

3. Or Use the shortcut key CTRL+G
However, if you decide to cancel the execution process completely, after you have paused it,
please follow the instructions in Stopping above.
See Also
Sending a Query to the Server
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Using the SQL-Session History Log file

Using the SQL-Session History Log
file
The History Log File saves queries that have successfully been sent to the sever during your current
SQL-Session and places them in a list. You can then browse this list, select a query and then reexecute it or re-edit it.
Accessing the History Log file
1. You can click the TSql/Pl-Sql (according to your server version) menu located on the toolbar
and then select the Show history command from the drop down menu
2. Or you can click the

button located on the toolbar

3. Or you can use the shortcut key, ALT+SHIFT+P
4. Or you can right click in the Results Section of the SQL-Session window to launch the shortcut
menu and then choose the Show History command
All these options will then launch the History Log File.
Using the History Log file

The History Log File is relatively self-explanatory:
●

the area entitled Last Commands displays, in list form, all the queries that have been
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Using the SQL-Session History Log file

successfully sent to the server in your current SQL-Session.
●

●

Left-click on a query in the list to highlight it as shown above, the syntax will then be
displayed in the area immediately underneath.
You can use the scroll bars here to view all of the code if it is too large for the box. Once you
have selected the query you want to work with, you have a choice of options using the buttons
on the right hand side of the dialog box:

Remove

Click this button to remove the selected query from the history list.
You need to select at least one query for this button to be enabled.

Execute

This button copies the selected query to the Query Editor of the
current SQL-Session and automatically runs it.

GoTo

This button will go to the selected query in the Query Editor and also
display its results in the Result Section of the SQL-Session window
(as if using Next Query/Prev. Query until the selected query is
displayed).

Copy

This button copies the selected query to the Query Editor. The
corresponding results are NOT, however, displayed and you will need
button to Send it to the server and then view the
to press the
results.

Erase Buffer
If for any reason you want to remove the entire contents of the SQL-Session window and the
History Log File, you can use the Erase Buffer option:
1. Click the Edit menu located on the toolbar and select the Erase Buffer option from the drop
down menu
Notes
●

Only commands that were CORRECTLY executed appear in the History Log File. Any queries that
return a fail status are not stored.
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Printing from the SQL-Session window

Printing from the SQL-Session
window
SQL Builder's SQL-Session offers you the ability to print either the Query Editor or the Results
Section if you should require a hard copy of any SQL code you have entered or any results that
have been returned by the server.
How to print
The print options can be accessed when the SQL-Session is open and it is the active window:
1. You can click the File menu located on the toolbar and then select the Print option from
the drop down menu
2. You can also click the

button located on the toolbar

3. Or you can use the shortcut key: CTRL+P
All of these options will then launch the Print Region dialog box as described below.
Print Region dialog box
This dialog box enables you to Print either the Query Editor or the Results Section of the SQLSession window:

Click the option that corresponds to the section you want to print. When you click each option,
the red outline box will also move to indicate which area will be printed.
Press the OK button and the data will be sent to the printer. Click the Cancel button if you want
to abort the Print procedure.
You can also access the Print Setup options if you wish to change any of the default settings:
1. Click the File menu located on the toolbar and then select the Print Setup... option. This
file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/Features/SQL-Session/print.htm (1 of 2) [10/07/2008 10:50:40]

Printing from the SQL-Session window

will launch a standard Windows Print setup dialog box.
Preview
The results displayed in the Grid tab of the Results Section will be printed in HTML format. In
addition, before printing begins, a Print Preview panel will be displayed enabling you to preview
what will be printed.
1. Click Print to start the print process.

See Also
Print Options
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Using the Previous Query/Next Query Commands

Using the Previous Query/Next Query Commands
When you have successfully sent several queries to the server using the SQL-Session, you can
use the Previous Query or the Next Query commands provided by the SQL-Session to
navigate through the queries. This is similar to using the History Log File (although the log file
offers more flexibility).
Previous Query
This command allows you to move to the list of previous queries successfully sent to the
server. When you use this command, the SQL syntax and the corresponding query results will
be displayed in the SQL-Session window. To use this command:
●

Click the TSql/Pl-Sql (according to your server version) menu located on the toolbar and
then select the Prev. Query command from the drop down menu

●

Or click the

button located on the toolbar

●

Or use either of the shortcut keys: ALT+P / ALT+LEFT

If you then want to go back to the query you were viewing before, use the Next Query
command, explained below.
Next Query
This command, similar to the Previous Query command, enables you to move to the next
query in the list of successful queries sent to the server. When you use it, the results
corresponding to the query will also be displayed in the Results Section of the SQL-Session
window. You can do this by:
●

Clicking the TSql/Pl-Sql (according to your server version) menu located on the toolbar
and then selecting the Next Query command from the drop down menu as shown on the
right

●

Clicking the

button located on the toolbar

●

Or use either of the shortcut keys: ALT+N / ALT+RIGHT

Notes
●

Click here to find out more about what to do if you cannot see all the results of your query
in the SQL-Session Results Section.
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Detailed Output

Detailed Output
Results displayed by the SQL-Session in the Results section are by default using Standard
mode. You can however change this to Detailed mode to receive more information.
Standard mode
In Standard Mode a simple query sent to the server will display results as follows (in Text
Format mode):

"
spid
[smallint]
1
2
3
4
5

status
[char ]
sleeping
sleeping
sleeping
sleeping
running

loginame
hostname
[char ] [char ]
CWTest
carroll
sa
sa
sa
CWTest
carroll

blk
[char]
0
0
0
0
0

dbname
[char]
pubs2
master
master
master
pubs2

cmd
[char]
AWAITING COMMAND
NETWORK HANDLER
MIRROR HANDLER
CHECKPOINT SLEEP
SELECT

5 rows affected by this transaction.
..."

Detailed mode
In Detailed Output mode (when the Detailed Output option is checked in the SQL-Session
Display tab) the results will be displayed as follows. The example below only shows one row of
results, (row number 5 as highlighted in red in the above example,) because it would otherwise
be too large.

"
spid[smallint]
status[char]
loginame[char]
hostname[char]
blk[char]
dbname[char]
cmd[char]

5
running
CWTest
carroll
0
pubs2
SELECT

5 rows affected by this transaction.
..."

Activating Detailed mode
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Detailed Output

In the SQL-Session display tab, check the Detailed Output check box.

Notes
●

●

The Detailed Output mode only affects the results displayed in the Text Format mode.
Results in the Grid Format are unaffected by a change in the configuration options.
This page also serves to configure certain sections of the Debugger, as the SQL-Session
and the Debugger have some similar characteristics.
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No Exec/Show Plan

No Exec/Show Plan
To find out more about what these options do, please consult the page SQL-Session tab in the
Server section.
Turning the Options ON
You can set the No Exec and Show Plan options to ON by:
1. Clicking the Options tab located on the toolbar and then selecting the NoExec/Show
Plan option (a check mark will appear next to the item to indicate that the option is set to
ON).
2. Clicking the

button located on the toolbar (a check mark will appear next to the item

in the Options menu to indicate that the option is set to ON)
3. Clicking the Options menu then selecting the Current SQL-Session configuration
option and then selecting the SQL-Session tab which is explained in detail here.
See Also
SQL-Session tab
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SQL-Session Advanced Options

Advanced Options
●

Save Editor Content

●

Run SQL-Script

●

Edit SQL-Script

●

Save All Results

●

Save All Queries

●

Run Test Session (same as Run SQL-Script command)

●

Save Test Session

●

Run T-SQL MetaBatch

Please also consult:
●

SQL-Script Files

●

Test Files

SQL-Builder's SQL-Session offers you various Advanced options in order to get the most out
of the available capabilities. All the options below can be found in the Advanced sub-menu:
To access this sub-menu:
1. Launch the SQL-Session
2. Click the File menu located on the
toolbar
3. From the drop down menu, select the
Advanced option and then select the
option you require from the sub-menu
as shown below
Three of the options have keyboard
shortcuts which you can also use.
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Save Editor Content

Save Editor Content
SQL Builder's SQL-Session offers you the ability to save either the Query Editor or the Results
Section as standard ASCII files if you should require a copy of any SQL code you have entered or
any results that have been returned by the server.
The Save options can be accessed when the SQL-Session (or the Debugger) is open and it is
the active window:
1. Click the File menu located on the toolbar and then select the Advanced option from the
drop down menu
2. Select Save Editor Content from the sub-menu
This option will then launch the Save Region Content dialog box as described below.
Save Region Content dialog box

This dialog box enables you to Save either the Query Editor or the Results Section of the SQLSession/Debugger window:
1. Click the option that corresponds to the section you want to save.
2. When you click each option, the red outline box will also move to indicate which area will
be saved.
The Save Output Text and the Save Output Grid options refer to the Text Format and
the Grid Format of the Results Section.
3. Then press the OK button and the data will be saved on your client hard disk (NOT on the
server) as a .TXT file. Click the Cancel button if you want to abort the Save procedure.
Notes
●

Please note that a further option (Save Test) is also available when you are using the Test
Session.
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Save Editor Content
●

This Save Region option should not be confused with the Save options (located in the File
menu).
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Run SQL-Script

Run SQL-Script
How to run an SQL-Script
The Run SQL-Script option can be accessed when the SQL-Session is open and it is the active
window:
1. Click the File menu located on the toolbar and then select the Advanced option from the
drop down menu
2. Select the Run SQL-Script option from the sub-menu
3. You can also use the keyboard shortcut key CTRL+U
This option will then launch a standard windows Open dialog box enabling you to open any files
ending in the .SQL extension (when launching from the Run Test Session command, you can
open files ending in the .SST extension).
Notes
●

See Load SQL-scripts to find out how to load a script into the SQL-Session.

Further Instructions
An SQL-Script file is an ASCII file that contains T-SQL queries separated, or not, by the 'go'
token. These files may come from an old SQL-Session saved by the Save File command.
Here is a sample of an SQL-Script file:

select @@servername
go
select @@version
go
exec sp_who
go
When SQL-Builder reads this type of file, each file's query appears in the Query Editor as it
would be typed, and it is sent to the SQL-Server. SQL-Builder obtains the results corresponding
to the query, displays them and then fetches the next query into your SQL-Script file. SQLBuilder iterates these operations until the end of the file or if an error occurs.
SQL-Script files may be edited with an external editor using the Edit SQL-Script command.
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Run SQL-Script

SQL-Script files and Test files
SQL-Script files differ from Test Files in that SQL-Script files contain only T-SQL queries where
test files contain queries AND their corresponding results.
Test files can be loaded by using the Run Test-Session command.
Notes
●

This command is identical to the Run Test Session command. Test files have an .SST
extension.

See Also
Load SQL-scripts | Edit SQL-Script
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Edit SQL-Script

Edit SQL-Script
The Edit SQL-Script option can be accessed when the SQL-Session is open and it is the active
window:
1. Click the File menu located on the toolbar and then select the Advanced option from the
drop down menu
2. Select the Edit SQL-Script option from the sub-menu.
3. Or use the shortcut key CTRL+SHIFT+E
This option will then launch a standard windows Open dialog box enabling you to open any
ASCII files ending in the .SQL extension. The file will then be opened in an external editor so
that you can edit it as your require.
It is particularly useful for editing SQL-Script Files generated with the Save File command
allowing you the possibility of altering transactions using the Load SQL-Script command before
they are loaded into the system.
Notes
●

●

For SQL-Server/Sybase users, you can change the external editor if you require (it is set
to Notepad by default), by accessing the General tab (General Configurations dialog box).
Do not use this editor to edit Test Files generated with the Save Test-Session
command.

See Also
Load SQL-scripts | Save objects and SQL scripts as files
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Save All Results

Save All Results
This option enables you to save the entire contents of the SQL-Session (queries and results)
into a .LOG file.
The Save All Results option can be accessed when the SQL-Session (or the Debugger) is open
and it is the active window:
1. Click the File menu located on the toolbar and then select the Advanced option from the
drop down menu.
2. Select the Save All Results option from the sub-menu. When you do so, a standard
Windows Save dialog box will be launched.
Notes
●

You can find out more information about the SQL-Session History Log File here.

See Also
Using the SQL-Session History Log file | Debugger
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Save All Queries

Save All Queries
This option enables you to save or back up the entire contents of the SQL-Session Query Editor
(i.e.: queries NOT results) as an ASCII file. You can then use these files in the same SQLSession and/or another SQL-Session to replay the commands saved - see Load SQL-Script
command.
After saving the commands, it is also possible to edit them by using an external editor such as
the one associated with the Edit SQL-Script command.
The Save All Queries option can be accessed when the SQL-Session (or the Debugger) is open
and it is the active window:
1. You can then click the File menu located on the toolbar and then select the Advanced
option from the drop down menu
2. Select the Save All Queries option from the sub-menu. When you do so, a standard
Windows Save dialog box will be launched.
Notes
●

●

SQL-Session queries AND results can be saved in an ASCII file format by using the Save
All Results command.
SQL-Script files may also be built manually with an external editor, and also edited with an
external editor by using the Edit SQL-Script command.
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Save Test Session

Save Test Session
Use this command to save ALL of the current SQL-Sessions. Everything will be saved: including
the History, any Results produced and the Queries entered.
You can then compare the results with the Run Test-Session command.
The Save Test Session option can be accessed when the SQL-Session is open and it is the
active window:
1. Click the File menu located on the toolbar and then select the Advanced option from the
drop down menu
2. Select the Save Test Session option from the sub-menu. When you do so, a standard
Windows Save dialog box will be launched.
See Also
What are Test Files?
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Run T-SQL Metabatch File

Run T-SQL Metabatch file
Use this command to load an SQL MetaBatch file.
A MetaBatch File is an ASCII file that contains queries separated, or not, by the 'go' token. All
templates that exist within a MetaBatch File are substituted by their corresponding value before
the T-SQL commands are sent to SQL Server. This allows you to write and use a kind of generic
batch without hard coded values.
The Run T-SQL Metabatch File option can be accessed when the SQL-Session is open and it is
the active window:
1. Click the File menu located on the toolbar and then select the Advanced option from the
drop down menu
2. Select the Run T-SQL Metabatch File option from the sub-menu. When you do so, a
standard Windows Open dialog box will be launched
Here is an example of a T-SQL MetaBatch file:

/* ----------------- */
/* Meta-Batch header */
/* ----------------- */
META_BEGIN
/* Templates description
** --------------------*/
CARTOUCHE
BEGIN
"Objects type" <<type>> varchar(2) mandatory
default {"P"} ,
"Pattern for LIKE test" <<pattern>> varchar(30)
optional default {"sp[_]a[_]%"}
END
META_END

/* ------------ */
/* Batch itself */
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Run T-SQL Metabatch File

/* ------------ */
USE master
go

/* Since pattern is optional, we handle here when it has been entered
empty */
/*
-----------------------------------------------------------------------*/
DECLARE @pattern varchar(30)
IF LTRIM(RTRIM("" + <<pattern>> + ""))
IS NULL

SELECT @pattern = "%" /* So, pattern will match anything */
ELSE
SELECT @pattern = LTRIM(RTRIM("" + <<pattern>> +
""))

/* Request by itself */
/* ----------------- */
SELECT name FROM sysobjects
WHERE type = <<type>>
AND name LIKE @pattern
go
When SQL-Builder reads this type of file, each token that is declared in the cartouche will be
displayed to the user of the Metabatch to get their corresponding values. Once all the values
have been collected, SQL-Builder substitutes all the patterns for their current values and then
executes the resulting T-SQL as a pure batch file.
Metabatch files should be edited with an external editor using the Edit SQL-Script command.
Metabatch files differ from SQL-Script Files and Test Files in that SQL-Script Files contain only
T-SQL queries (i.e. queries without templates) and Test Files contain queries AND their
corresponding results.
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Run T-SQL Metabatch File

Please note that when using a Metabatch file, no object will be updated in the CAST Knowledge
Base.
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What are SQL-Script Files?

What are SQL-Script Files?
SQL-Script files are ASCII text files that contain T-SQL commands. These commands can be
automatically sent as a set, or one-by-one in a step-by-step mode to the SQL-Server.
A very simple example could be a text file that contains the following:

select @@servername
go
select @@version
go
exec sp_who
go
Unlike Test Files, SQL-Script files can be edited with any editing tool that can read and write in
ASCII file format.
With SQL-Builder, it is possible to create a new SQL-Script file reflecting your current
interactive session by using the command Save All Queries command in an SQL-Session. This file
can then be re-loaded during the same or another interactive session by using the Load SQLScript command.
It is also possible to edit an SQL-Script file with an editor of your choice by selecting Edit SQLScript from the file menu.
See Also
SQL-Session tab
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What are Test Files?
Test Files are files that have a special format and that cannot be edited or modified with a
normal text editor. If you change the contents of a Test File, you will not be able to use it in
future Test Sessions.
These special files contain queries in SQL-Script Files as well as their associated results. SQLBuilder allows you to replay this special type of batch. Each query in the Test File is sent to the
SQL-Server, the corresponding results are retrieved as usual and then immediately compared
against those previously stored in the Test File. SQL-Builder will then indicate any differences
that exist.
How to create a new Test file
1. Test the behavior of a functional unit in an interactive SQL-Session. Try to be as
exhaustive as possible without neglecting specific or other cases.
2. Save your session as a script.
3. Edit this script with the editor of your choice. Remove all errors and/or queries that have
no relation to the tested functional unit.
4. While editing the script, add new tests which are based on the existing model but change
the call parameter values of your functional unit. This phase must not be omitted. Make
full use of the copy/paste/replacement features included in your editor. Document your
tests as if you were documenting your SQL code.
5. In the on-going session (a newly-opened session in which no query has been entered) replay your script.
6. Verify the results of each script query one by one.
7. If all the results seem satisfactory, record your query and results session.
8. Exit the session and re-play it. Check the results one by one again. Check that the test
journal has no messages concerning different results. If you see differences in behavior
and/or results, this means your test set is unstable. In other words, it causes side effects
on the server: two successive calls to the same function return different results, for
example.
9. Modify your script as needed to make it stable and/or complete.
10. Repeat steps 8 and 9 as often as necessary.
11. Keep this session and play it back at regular intervals during development. Add the
necessary elements each time an error appears in your functional unit that was not
recognized by your tests. Do not remove any of your tests just to speed up a long test
procedure. No test procedure is too long or too exhaustive. If possible, divide your file into
several sub-assemblies if your functional unit allows this.
12. This test session is an integral part of your code. Therefore, you need to take care with it,
save it as often as you save your code. Don't hesitate to document each test as much as
you document your code. Encourage any person working on your functional unit to use
and add to this test session. Every test added to the session will save hours of errorhunting!
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What are Test Files?

See Also
Save All Queries | Edit SQL-Script
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Templates

Templates
●

●

What are Templates?
Templates Configuration dialog box - how to define and configure SQL-Object and Code
Templates

●

Create/Edit Template dialog box

●

Insert SQL-Object Template dialog box

●

Execute Command - how to insert specific Stored Procedures into an SQL-Session and
other objects

●

Parameter Input dialog box

●

Test Parameters Command
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What are Templates?

What are Templates?
SQL-Builder provides an extensive set of templates to meet your coding requirements. They can
be used to access text or code that you use on a regular basis, for example, a Generic Header
comment that has to be included in each procedure. In addition, they provide Help for SQL code
such as a model of cursor management.
SQL-Builder has an in-built library of templates that you can extend to your needs. This library
can be shared by multiple users and each user can select a limited number of templates for their
own use.
There are two types of Templates provided by SQL-Builder:
●

SQL-Object Templates
These templates are used to initialize newly created SQL-Objects (for example a new
Stored Procedure or a new Trigger). In other words, you can use these templates as a
basis for creating your SQL-Objects.

●

Code Templates
Code templates enable you to add samples of SQL code to your SQL-Session, Object
Editor or Debugger.

You can manage your templates in the Template Configuration dialog box (click Options >
Templates Configuration... on the toolbar), or (for Code Templates only) in the Tools window.
If you want to then insert the Code Templates into an SQL-Session or Object Editor, click here
for more information (the SQL-Object Templates will be displayed when you create a new
object).
See Also
Template Configuration dialog box | Tools window
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Template Configuration dialog box

Template Configuration dialog box
The Template Configuration dialog box enables you to manage all your templates:

Accessing the Template Configuration dialog box
The Template Configuration dialog box can be launched directly from the toolbar
1. Select Options > Template Configuration
The Template Configuration dialog box will then be launched.
Notes
●

You can also access a list of Code Templates directly in the Tools window.

SQL-Objects Template tab
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Template Configuration dialog box

These templates are used to initialize newly created SQL-Objects (for example a new Stored
Procedure or a new Trigger). In other words, you can use these templates as a basis for creating
your SQL-Objects.
The SQL-Object Templates tab is thus used to link the various templates stored in supplied SQLBuilder files to the various object types. When you subsequently create a new object to which you
have linked a template, that new object will contain the template code.
Templates Groups
This section consists of a combo-box and a list of templates. The combo box, entitled SQLObjects, indicates the type of object that the template will be linked to. Simply click the down
arrow and select the object type you want to link a template to.
The list of Selected Templates displays those templates that are linked to the object type selected
in the above combo-box.
To add a template to the list
1. Use the

button to transfer the highlighted SQL-Object Template from the Library

section on the right hand side into this section.
2. The

button will remove the template from the list.

You can also link more than one template to an object type if you require. If you do so the Insert
SQL-Object Template dialog box will be launched when you create new objects enabling you to
choose the correct template. You can use the
and the
buttons to re-order the selected
templates. Highlight the template you want to move, then click either arrow to move it up or down.
As with the Library section, if you want to edit an SQL-Object Template that is already stored in
the SQL-Builder file folders, first select the template in the left hand section by left clicking on it
once, then click the Edit button. This will launch the Edit Template dialog box.
Templates Library
This section on the right hand side of the tab automatically displays the library of SQL-Object
Templates stored in the SQL-Builder file folders (in the TPL folder at the root of the installed CAST
files). They are displayed with a name and a comment column to help you identify them.
If you want to create a new SQL-Object Template, click the New button. This will launch the Create
Template dialog box.
If you want to edit an SQL-Object Template that is already stored in the SQL-Builder file folders:
1. First select the template in the right hand section by left clicking on it once, then click the
Edit button.
2. This will launch the Edit Template dialog box, which is in fact identical to the Create
Template dialog box.
To delete an SQL-Object Template from the Library stored in the SQL-Builder file folders, first
highlight the template, then click the Delete button.
The Directory field at the bottom of the tab indicates where the Library is stored. You can if you
wish, have multiple libraries, each stored in a different directory. The Browse button lets you select
a new directory.
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OK
Once you are satisfied with your selections, click the OK button to close the dialog box - alternatively
click the Cancel button to abort the operation.
When you next create an object, the template you have linked to it will automatically appear in the
object body. If you have linked more than one template to an object, the Insert SQL-Object
Template dialog box will be launched, and you can choose the template you want to initialize the
object with.
Code Templates tab
Code templates enable you to add samples of frequently used SQL code to your SQL-Session or
Object Editor.
Templates Library
This section on the right hand side of the tab displays the library of Code Templates stored in the
SQL-Builder file folders. They are displayed with a name and a comment column to help identify
them.
If you want to create a new Code Template:
1. Click the New button.
2. This will launch the Create Template dialog box which is explained here.
3. You can also create a new Code template using the Tools window.
If you want to edit a Code Template that is already stored in the SQL-Builder file folders:
1. Select the template in the right hand section by left clicking on it once
2. Click the Edit button.
3. This will launch the Edit Template dialog box, which is identical to the Create Template
dialog box and is explained here.
To delete a Code Template from the Library stored in the SQL-Builder file folders:
1. Highlight the template
2. Click the Delete button.
The Directory field at the bottom of the tab indicates where the Library is stored. You can if you
wish, have multiple libraries, each stored in a different directory. The Browse button lets you select
a new directory.
Selected Templates
The templates appearing in the left hand section are those that will appear in the Code Templates
tab in the Tools window.
Use the

button to transfer the highlighted Code Template from the Library section on the

right hand side into this section. The

button enables you to remove a Template from the list.
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Template Configuration dialog box

Builder file folders:
1. First select the template in the left hand section by left clicking on it once
2. Click the Edit button.
3. This will launch the Edit Template dialog box, which is explained here.
and the
buttons to re-order the selected templates. For instance, you can
You can use the
move more frequently used templates to the top of the list if you require. Highlight the template you
want to move, then click either arrow to move it up or down.
OK
Once you are satisfied with your selections, click the OK button to close the dialog box - alternatively
click the Cancel button to abort the operation.
Use the Code Templates tab in the Tools window to insert these templates into the SQL-Session
or Object Editor.
See Also
Tools window | Insert SQL-Object Template dialog box | Edit Template dialog box | Create Template
dialog box
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Create/Edit Template dialog box

Create/Edit Template dialog box
This dialog box enables you to edit and/or create a template.
It can be launched by selecting the Edit and/or New buttons in either the SQL-Objects tab or
the Code Templates tab and via the Template > New Template... option located on the menu
bar.
In addition, if you highlight code in an Object Editor prior to selecting the New Template option,
the highlighted code will be automatically pasted into the Body section of this dialog box.

The example above shows an empty Create Template dialog box. Fill in the necessary fields if
you are creating a new template, or edit the fields if you are editing an existing template.
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Create/Edit Template dialog box

Name

Displays the name of the Template that you are editing or
creating.

Comment

This is a single line description of the template and helps other
users to find out what the template is designed to do, without
them having to read the entire template body.
Will be displayed in the Templates Library in either the SQLObject Templates tab or the Code Templates tab.

Body

This is the template body code. Click here to enter your changes
or new code.

File

This section indicates the file location where the template is
saved. All templates are saved in independent files. The same
template file cannot be assigned to SQL-Object Templates and
Code Templates, but can be assigned to multiple SQL-Object
templates of a different type.

Save As

This button enables you to save the template and then close the
dialog box.

Copy from File

This button enables you to browse for another template and copy
and paste it into the current template.

Notes
●

This dialog box is identical to the Edit Template dialog box which is called from the SQLObject Templates tab and the Code Templates tab with the New button.
The only difference is that the Edit Template dialog box will contain the details of the
template you are editing.
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Insert SQL-Object Template dialog box

Insert SQL-Object Template dialog box
This dialog box is automatically displayed when you assign two or more SQL-Object Templates to
an object type. When creating new objects, this dialog box will be displayed enabling you to
choose the template you require.
It cannot be opened in any other way.

The dialog box is easy to use:
1. Highlight the Template you want to insert into the object or the SQL-Session.
2. Click the OK button to confirm your choice - the template will be pasted into the object or
the SQL-Session.
3. The Cancel button will abort the operation and close the dialog box.
If you want to configure a template, highlight the template in the list by left clicking once on it,
then click the Config button. This will launch the Template Configuration dialog box
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Execute Command

Execute Command
The Execute Command enables you to insert a Stored Procedure execution template (which you can
choose in the Execute Template dialog box explained below) into your Stored Procedure, Trigger,
Function or into an SQL-Session.
Launching the Execute Command dialog box
You can launch the Execute Template dialog box when a Stored Procedure, Trigger or Function are
open (click here for more information on how to open objects from the Object Manager) or when the SQLSession is running. Then you can:
1. Click the Template menu located on the toolbar and select the Execute command... option from the
drop down list
2. Click the

button located on the toolbar

3. or (when launching from the SQL-Session only) right click in the Query Editor to launch the contextual
menu and then select the Execute Command... option
Execute Command dialog box

In the dialog box you will find two combo boxes:
●

●

The first enables you to select the database in which the Stored Procedure you want to insert is
stored. Simply click the down arrow and select the appropriate database from the list.
The second combo box lists all the Stored Procedures that are stored on the database indicated in
the first combo box. Again, select the Stored Procedure you require by left clicking it once.

Then click the OK button and the Stored Procedure along with all the necessary code will be pasted to the
SQL-Session, Stored Procedure, Trigger or Function from which the dialog box was launched.
An example of the code in a Stored Procedure/Trigger or an SQL-Session is given below:
In a Stored Procedure)
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Execute Command

Exec <@res> = CASTpubs..GetTitleAuthors
@au_lname =
,
/* varchar ( 40 ) */
@au_fname =
/* varchar ( 20 ) */
/* With Recompile */
If <@res> != 0
/* checking returned status of stored procedure GetTitleAuthors */
Begin
End
In a SQL-Session:

Declare @res int
Exec @res = CASTpubs..GetTitleAuthors
@au_lname = '',
@au_fname = ''
/* With Recompile */
Select '@res'=@res

/*varchar ( 40 )*/
/*varchar ( 20 )*/

Notes
●

●

Stored procedure > The list of the Stored Procedures located in the selected database only displays
the Stored Procedures you own, the Stored Procedures which are owned by the Database Owner
(DBO) or the procedures owned by the groups you are members of. When you select a stored
procedure that has the same name as one of your procedures, this procedure will be used. If you don't
own a procedure with that name, the DBOs procedure will be used instead.
If you activate the Ask parameter value when executing procedures option in the General tab
(Options > General Configuration) a Parameter Input dialog box will be displayed allowing you to
enter any required procedure parameters.
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Parameter Input dialog box

Parameter Input dialog box
This dialog box will be displayed if you have activated the Ask parameter value when
executing procedures option in the General tab (Options > General Configuration). It
allows you to enter any required procedure parameters.
If the option is not activated, then this dialog will NOT be displayed.

In the above example, the parameters in the Stored Procedure can be altered. To do this,
follow the instructions below:
1. Select the parameter that you wish to alter by either left-clicking on it once with the
mouse to highlight it as shown above
2. Then click in the Value column and enter the new parameter value.
3. Click OK to paste the Stored Procedure plus the new parameter values into the SQLSession, Stored Procedure editor, Trigger editor, or Function editor. The Cancel
button will abort the operation.
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Test Parameters Command

Test Parameters Command
This command allows you to insert a test command on each parameter defined with a "null"
default value at the beginning of a Stored Procedure body, as displayed below:

"If @ParamName Is Null
Begin
End
"
Launching the command
This command is available ONLY when a Stored Procedure is open, when you can define or
modify it (i.e.: when the procedure is not opened in 'read only' mode), when you are connected
and when parameters with a "null" default value are defined.
To insert the test command into the Stored Procedure you can:
1. Click the Template menu located on the toolbar and then select the Test Parameters
option from the drop down menu
2. Alternatively click the

button located on the toolbar
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Tools Window

Tools Window
●

What is the Tools Window?

●

Code Templates tab

●

Local Messages tab

●

Code Checker tab
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What is the Tools Window?

What is the Tools Window?
The Tools Window contains a variety of tabs that each provide information or other facilities.
Clicking each tab will display the relevant information.
If you want to hide the Tools Window:
1. Click View > Panels > Tools
2. Repeat the process to re-display the window
3. You can also click the close icon in the top right-hand corner.
4. You can also use the

icon located on the toolbar to toggle the display mode.

By default, the window will be "docked" at the bottom of the screen. However, you can move the
window to a different location should you require:
1. Double-click anywhere in the title bar - this will "undock" the window and you will then be
able to move it as normal.
The window has other "docked" positions which can be used by moving the window until its
outline changes shape and then releasing the mouse button.
See Also
Code Templates tab | Local Messages tab
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Code Templates tab

Code Templates tab
The Code Templates tab is the display extension of the Code Templates tab located in the Template
Configuration dialog box. You can select specific code templates via the Templates dialog box to display in
the tab, making them easy to access whenever you are editing an object or using the SQL-Session:

What are Code Templates?
Code Templates are a set of supplied templates (that you can expand and define yourself) for specific
pieces of code. By choosing a code template, you can then insert it directly into your object editor or SQLSession to save time manually having to write standard pieces of code (for example an IF clause) that you
use regularly. To find out more, click here.
Adding Code Templates to this tab
To add a specific code template to this tab:
1. Right click anywhere in the window and select Configuration... from the shortcut menu. This will
launch the Templates Configuration dialog box.
2. In this dialog box, click the Code Templates tab to access the templates supplied by CAST and
those you may have created yourself.
3. Use the instructions here to add listed templates to the left hand Selected Templates section. Any
templates displayed here will then also be displayed in this Code Templates tab here in the Tools
window.
Notes
●

It is also possible to create a Code Template by highlighting a piece of code in any editor and
dragging and dropping it into the Code Templates tab. The Create/Edit Template dialog box will
launch enabling you to define a name and description for the template.

Working with the Code Templates tab
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Code Templates tab

Once you have selected the Code Templates you require and they are displayed in this tab, you can than
insert them into the editor your are working with (SQL-Session or Object Editor).
Inserting a Code Template
●

To insert the Code Template into the SQL-Session or the object editor, select the template and
then drag and drop it into the chosen editor. SQL-Builder will then automatically paste its
contents in text format.

Editing a Code Template
Although CAST supplies you with a basic set of Code Templates, you can also edit these to suit your own
needs if you require. To do so:
1. Select the Code Template in the Code Templates tab that you want to edit
2. Right click to launch the shortcut menu
3. Select Edit...
This will launch the Create/Edit Template dialog box in which you can edit the selected template and then
save it.
Notes
●

●

●

If you want to create a brand new Code Template, follow the instructions here.
You can remove a Code Template from this tab by selecting Suppress in the right click shortcut
menu.
You can rename a Code Template from this tab by selecting Rename in the right click shortcut
menu.

See Also
Template Configuration dialog box | Create/Edit Template dialog box | Local Messages tab
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Local Messages tab

Local Messages tab
This section is a read-only window in which syntax errors that occurred when compiling an object are
displayed.
Warning and error messages are also displayed when checking the syntax using the Code Checker.
The display is automatically refreshed. A right click shortcut menu is also available.

See Also
Code Checker | Code Templates tab
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Code Checker tab

Code Checker tab
Similar to the Local Messages Tab, this tab displays warning and error messages resulting from a
Code Checker search when the process is launched directly from the Object Manager. See Launching
the Code Checker for more in-depth information.

When the Code Checker detects that an object has a potential problem, it is displayed in the Code
Checker tab, together with the line and column number of the affected piece of code and the
associated warning or error message.
Double clicking an object will open it and display a bookmark on the affected line or lines (you can
change the color of Bookmarks in the Editor Options tab).
Right clicking an object in the Reference List tab will launch a shortcut menu that enables you to
carry out various operations, all explained in more detail below:
Open

This option will open the selected object. This is the same as doubleclicking an object in the list.

Remove

This will delete the selected object from the list - particularly useful
if you have an erroneous result that you do not want to include
when saving the results (see below).

Load

Select this option if you have previously saved your results (using
the Save As option explained below). A standard Windows Open
dialog box will be launched enabling you to select the file you
require.

Save As

Use this option to save the results of your Code Checker search as
an .XML file type. This means you can access the result at any time
after you have closed the Reference List. A standard Windows
Save dialog box will be launched enabling you to select a filename
and location.

Export to CSV

Export the results to a .CSV file that can be read in Microsoft Excel
for example.
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Code Checker tab

Order: by Server, by
Database, by Owner, by
Object Name, by Object
Type, by Message

Selecting an option in the sub menu will sort the results in
ascending or descending order accordingly. You can also sort the
results by clicking a column heading.

Auto resize columns

Reset the column display sizes to their defaults.

Clear All

Removes all results from Reference List tab.

Remove Panel

Removes the tab. To re-display it, you need to carry out another
search operation.

Edit in new User List

Opens a new User List containing the affected objects

See Also
Code Checker | Local Messages tab | Code Templates tab
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Source Manager Interface

Source Manager Interface
●

What is the Source Manager Interface?

●

Installing the Source Manager

●

Using archives with a Source Manager

●

SCC Interface Manager
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What is the Source Manager Interface?

What is the Source Manager Interface?
CAST provides a Source Manager Interface for use with SQL-Builder and Release Builder,
enabling you to interface with Source Managers that support Microsoft's Source Code Control
(SCC) interface.
The interface enables you to extract objects from your source manager (check out), modify
them (in SQL-Builder) and/or create them on a server (SQL-Builder and Release Builder). You
can also copy objects into your source manager (check in) from SQL-Builder or Release Builder.
In addition you can display histories, reports on archives, set options, etc. depending on the
Source manager you are using.
Microsoft's Source Code Control (SCC) interface is the Microsoft Common Source Code
Control API (also called SCC API or SCCI). Currently we only support the Microsoft SCC API, not
the specific API from the Source Manager system vendor. This is because when SQL-Builder,
Release Builder & source control systems are used together, the link or interface is SCC system
calls.
Generally one Source Manager product has at least two APIs: the proprietary API and the
Microsoft SCC API. Most Source Manager vendors have an SCC API that can be used to access
the functionality of their product. Vendors offer their own API and the Microsoft SCC API, which
in fact acts as a standard API.
CAST Tools connect to a specific vendor using the Microsoft SCC API to have access to the
product
See Microsoft SCC Interface Manager for more information about using this source control
interface.
See Also
SCC Interface Manager | Using archives with a Source Manager
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Installing the Source Manager Interface

Installing the Source Manager Interface
CAST provides an automatic Source Manager installation process as part of its setup program. If,
however, you choose not to install the Source Manager interface during the setup procedure, you
can run the process manually at a later date. Instructions are given below:
Manual Installation
The CAST Source Manager interface is implemented via a specific DLL in the CAST installation
folder:
●

SrcMg32.DLL

This DLL is shipped by CAST and in its default state, no source manager or version control is
available in either SQL-Builder or Release Builder. In order to activate the Source Manager, you
need to replace this default DLL with the source manager DLL (SccMg32.DLL) shipped by CAST
and stored in the "SrcMngr" folder.
1. Locate and copy the source manager DLL in the "SrcMngr" folder.
2. Paste it to the CAST installation folder.
3. Change the name of the default "SrcMg32.DLL" to "SrcMg32OLD.DLL".
4. Change the name of the copied source manager DLL to the generic name "SrcMg32.DLL".
5. Launch either SQL-Builder or Release Builder as appropriate.
Notes
●

●

CAST will not run if there is no SrcMg32.DLL file in the CAST installation folder.
Please note that SQL-Builder does NOT support the check in /check out of table. This is
only possible when using Release Builder. This is due to the complex nature of the script
in the tables.

See Also
What is the Source Manager Interface?
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Using archives with a Source Manager

Using archives with a Source Manager
To open an archive with CAST Products, this object must have already been checked-in by
CAST Products.
If archives that have not been checked-in by CAST Products already exist, check them out,
create them on your server and then check them in with Release Builder. Your archives are then
ready to be used by CAST products.
Moreover, some workfile/archives extensions are automatically associated with some types of
objects in SQL-Builder and Release Builder:
TABLE

.tab

PACKAGEBODY

.pkb

PROCEDURE

.pro

PACKAGE

.pka

TRIGGER

.tri

SEQUENCE

.seq

INDEX

.idx

CLUSTER

.clu

VIEW

.vew

DBLINK

.dbl

TABLE_DATA

.txt

SYNONYM

.syn

RULE

.rul

TYPEBODY

.otb

DEFAULT

.def

TYPEHEADER

.oth

UDT

.udt

REFRESHGRP

.rfg

FUNCTION

.fct

SNAPSHOTLOG

.snl

PRIVILEGE

.prv

SNAPSHOT

.snp

USERGROUP

.usr

-

-
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S.C.C Interface Manager

S.C.C Interface Manager
The S.C.C. Interface Manager (SccMg32.DLL) provides access to a source manager via S.C.C.
(Source Code Control). In this way, you can work with the Version Control or Configuration
Management tools supporting the Source Code Control (S.C.C.) Interface implemented by
Microsoft.
The following options are available:
●

SCC Check Out dialog box

●

SCC Check in dialog box in SQL- Builder

●

SCC Check in dialog box in Release Builder

●

SCC Check-Out dialog box - Special Cases

●

SCC Advanced Menu (SQL Builder only)
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SCC Check-Out dialog box

SCC Check-Out dialog box
This dialog box, which can be launched via the SCC Manager > Check Out... command allows
you to define a selection of objects to be extracted from your source manager (check-out).
Project Name

This field contains the name of the project in which your archives
are stored.
You may use the browse button [...] to change this project. Note
that this name is given back by the Source manager you are
interfaced with when you select the project.

Workfile Directory

This field contains the working directory.
You may use the browse button [...] to change this directory via
a directory browser if your source manager supports it.

Archive Selection

This shows the file mask used to filter archives (by default *.*).
Only the " * " wildcard can be used.

Selected objects

This list displays the archives found which correspond to the
"archive selection" filter. You can select one or multiple items to
perform commands on. You can update this list with the Update
button.

Options

Display advanced check out options if supported by your source
manager.

Properties

Display properties on the selected archive (if only one archive is
selected) if supported by your source manager.

History

Display the history on the selected archive (if only one archive is
selected) if supported by your source manager (see also SCC
Manager/History Report... Command).

Undo Check Out

Active if selected archives are checked out and if this command is
supported by your source manager.

Check Out

Click this button to start building the list of versions selected in
the list.

Notes
●

Please consult the SCC Check-Out Dialog Box - Special Cases page for more information
about checking out files when using certain SCC Managers, notably Object Cycle.
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SCC Check-In dialog box (SQL-Builder)

SCC Check-In dialog box (SQL-Builder)
This dialog box, which can be launched via the SCCManager > Check In... command, allows
you to copy your current object into your source manager via SCC, creating a new version of the
file.
Project Name

This field contains the name of the project in which your archive
is (will be) stored.
You may use the browse button [...] to change this project if the
current object is not already linked with an archive (if it has not
been opened from a checked-out archive). Note that this name is
given back by the Source manager you are interfaced with when
you select the project

Comment

You can specify a comment for all the archives if your source
manager supports it.

Options

Some options may be specified for the check in if it is supported
by your source manager.

Notes
●

The name, type and workfile path of the current object are also displayed. The project in
which you are going to check-in your archive is also displayed in the title of this dialog
box.
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SCC Check In dialog box (Release Builder)

SCC Check-In dialog box (Release Builder)
This dialog box, launched via the SCC Manager > Check In... command, allows you to copy
your currently selected objects into your source manager, creating a new version of the files.
An explanation of the options available in this dialog box follows:
Comment

You can specify a comment for all the archives if your source manager
supports it.

Workfile Path

You can define a workfile path for each archive, but take care of the possible
working directory specified in your source manager.

Options

Various options may be specified for the check in if it is supported by your
source manager.
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SCC Check-Out dialog box - Special Cases

SCC Check-Out dialog box - Special Cases
When using the Source Manager Object Cycle, you CANNOT check out files that you do not
already have stored on your PC.
You must first use the Get command to download the files that you want to check out AND then
use the Check Out command.
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SCC Advanced Menu (SQL-Builder only)

SCC Advanced Menu (SQL-Builder only)
When connected to your source configuration manager, a right click contextual menu is available
in the Object Manager, under the SCC node:

This menu option allows you to access the following SCC options:
●

Change SCC Project - this option is not available on a Type node or the root SCC node

●

Get Latest Version

●

Check Out

●

Check In

●

Unlock Archive

Tips
Shortcut Keys
Toolbars
Command Line
.INI File Options
Limitations
Regular Expressions
Appendix
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SCC Advanced Menu (SQL-Builder only)
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Tips

Configuring SQL-Builder when working with large applications
CAST recommends the following configuration for SQL-Builder when working with very large
servers/applications:
The time taken to execute requests within SQL-Builder is closely linked to the number of objects
stored on your server. In this case, even if your schema/database itself does not contain many
objects, some SQL-Builder configuration options can seriously affect the performance of the
product, so, if speed is a priority:
●

●

●

●

●

●

●

Do not activate line counting for tables and views (OM Options tab - Table size
calculation)
Do not activate the Dependencies in popup menu option (OM Options tab)
Limit the number of columns displayed in the Object Manager - use only the absolute
minimum (OM Options tab - Columns section).
Use the Object Manager in two panel mode instead of docked mode - see Object Manager
Interface for more information).
Using display filters can significantly reduce the amount of time taken to display objects in
the Object Manager - see OM Filter tab for more information.
Using contextual keyword completion can increase response time (Oracle users only General Configuration > General > Completion)
Reading permissions granted to users can take a significant amount of time. It is possible
to hide the Permissions tab in SQL-Builder's Object Editors - see .INI File Options.
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Shortcut Keys

Shortcut Keys
Moving the Cursor with the Keyboard
F6

In any window (except Object Manager) which has several views (SQLSession for example): moves the cursor into the next view without
changing windows.

SHIFT+F6

Same effect as the F6 combination but goes through the list in the
reverse direction

CTRL+F6

In any window: brings the current window to the foreground and moves
the cursor to the next window in the circular list of MDI application child
windows. Depends on the order in which sessions were opened.

CTRL+SHIFT+F6

Same effect as the CTRL+F6 combination but goes through the list in
the reverse direction

General Shortcuts
CTRL+L

Load an SQL-Script.

CTRL+O

Open an object file.

CTRL+P

Prints the current editor (same as the File/Print command).

CTRL+Q

Launches the Query Assistant dialog box (Click here for more details
on the Query Assistant).

F1

Activates the online Help (same as the Help/Index command).

SHIFT+F1

Activates context-sensitive online Help.

ALT+F4

Exits SQL-Builder (same as the File/Exit command).

SQL-Session Shortcuts
CTRL+G

In the SQL-Session Query Editor section: sends the currently
edited/selected query to the server for execution (same as T-Sql/Go
command).

CTRL+ALT+G

Same as CTRL+G (see above), but displays as many lines as possible
(up to 32,000). Click here for more information on this command)

ALT+N

In the SQL-Session Query Editor section: edits the next query (same
as the T-Sql/Next Query command).
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Shortcut Keys

ALT+RIGHT (right
cursor key)
CTRL+ALT+N
ALT+P
ALT+LEFT (left
cursor key)

Same as ALT+N/ALT+RIGHT, but displays as many lines as possible (up
to 32,000).
In the SQL-Session Query Editor section: edits the previous query
(same as the T-Sql/Prev. Query command).

CTRL+ALT+P

Same as ALT+P/ALT+LEFT, but displays as many lines as possible (up to
32,000).

ALT+SHIFT+P

Displays the History Log File (same as the T-Sql/Show History...
command). Click here for more information on the History Log File

CTRL+W

Opens a new SQL-Session (same as the File/New SQL-Session
command). Click here for more information on how to launch an SQLSession.

Object Editors Shortcuts
CTRL+"+"

Expands a block of code in the Object Editor. The Block collapse mode
option must be activated.

CTRL+"-"

Collapses a block of code in the Object Editor. The Block collapse mode
option must be activated.

CTRL+D

Debug current object.

CTRL+E

In a Stored Procedure Editor this command pastes the current object
code in an SQL-Session which you can then execute (same as the
Stored Pr./Execute Current Procedure... command).

CTRL+G

In any object editor, this command saves the current object on the
server

CTRL+N

Opens or removes a connection.

CTRL+R

Launches the Graphical Object Manager (same as OBJECT TYPE
(i.e.: Table or Stored Pr./Graphical View command). Click here for
more information on how to use the Graphical Object Manager.

CTRL+S

When using the SQL-Session for example, this command saves an
object script into a file (same as the File/Save As... command).

F4

Selects the first error or the next error (if any are selected) in the Local
Messages tab (same as the Edit/Next error command).
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Shortcut Keys

SHIFT+F4

Selects the first or previous error (if any are selected) in the Local
Messages tab (same as the Edit/Previous error command).

F5

Updates the lists displayed in the Object Manager window (same as the
View/Refresh menu)

Editing Shortcuts
ALT+!

Find Matching Begin/End.

ALT+BACKSPACE

Identical to the CTRL+Z function (same as the Edit/Undo command).

ALT+F5

Go To Line.

CTRL+A

Selects all editor contents (same as the Edit/Select All command).

CTRL+B

Open Selected Object command

CTRL+C

Copy function (same as the Edit/Copy command).

CTRL+DEL

Deletes the contents of the active editor and the internal data structure
(same as the Edit/Erase buffer command).

CTRL+F

Opens a dialog box used to search for a character string (same as the
Edit/Find... command).

CTRL+F2

Toggle bookmark (same as View/Toggle bookmark)

CTRL+H

Replace command. Highlight a piece of test before using the
command.

CTRL+INS

Identical to the CTRL+C function (see Edit/Copy command).

CTRL+K

Using the Help on Syntax dialog box

CTRL+NUMPAD5

Identical to CTRL+A (same as the Edit/Select All command).

CTRL+M

Launch the Code Checker.

CTRL+U

Make Upper - converts highlighted lower case letters into upper case
letters (same as Edit/Make Upper command).

CTRL+V

Paste function (same as the Edit/Paste command).

CTRL+X

Cut function (same as the Edit/Cut command).

CTRL+Y

Re-does all undone actions (same as the Edit/Redo command)

CTRL+Z

Cancels the actions of the previous command (same as the Edit/Undo
command).
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CTRL+SHIFT+B

Use Box Mode.

CTRL+SHIFT+U

Make Lower - converts highlighted lower case letters into upper case
letters (same as Edit/Make Lower command).

F2

Next Bookmark (same as View/Next Bookmark)

F3

Repeats the last find action in the text after the cursor position (same as
the Edit/Find Next command).

F9

Toggle breakpoint.

LEFT CTRL+SPACE
BAR

Language Keyword Completion, this command completes the current
word with a language keyword beginning with these letters or displays
next language keyword matching these letters; note that SHIFT+LEFT
CTRL+SPACE BAR displays the previous language keyword matching
these letters.

RIGHT CTRL+SPACE
BAR

Object Keyword Completion completes the current word with a name
of an object beginning with these letters or displays the next object
name matching these letters; note that SHIFT+ RIGHT CTRL+SPACE
BAR displays the previous object name matching these letters.

SHIFT+DEL

Identical to the CTRL+X function (see Edit/Cut command).

SHIFT+F3

Same as Edit/Find previous command

SHIFT+INS

Identical CTRL+V function (see Edit/Paste command).

Shortcuts for general windows
CTRL+I

About Server

CTRL+F4

Closes the active window.
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Toolbars
SQL-Builder is equipped with a variety of different toolbar buttons that carry out some of the
more commonly used options. Each specific function in SQL-Builder has its own set of toolbar
icons which will only be displayed when the associated window is active.
●

Standard Toolbar

●

Edition Toolbar

●

Object Toolbar

●

Debug Toolbar

●

Template Toolbar

●

SQL-Session Toolbar

●

Object Manager Toolbar

●

Data-Session Toolbar

●

Database Management Toolbar

●

Zoom Toolbar

Notes
●

You can show or hide each set of toolbar buttons should you require, by clicking the View
menu located on the toolbar, selecting the Toolbars option from the drop down list and
then selecting from the sub-menu the function that corresponds to the set of icons you
want to hide.
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Standard Toolbar
The Standard Toolbar consists of the buttons that are most frequently used, however, not all
of them are always visible (this depends on what functions are active).

Button

Equivalent Toolbar
Command
(Menu/Option)

Description of the action performed

File / Open Object
File

Launches a standard Windows Open
dialog box enabling you to open any
object saved as a file.

File / Save File (Save
File As)

Launches a standard Windows Save
dialog box enabling you to save any
object as a file.

File / New SQLSession

Opens the Connection dialog box, then
the SQL-Session.

Stored Pr. / Debug
current procedure

Opens the Connection dialog box, then
the Debugger

-

Only active when an object or the SQLSession is open. Enables you to change
the working database.

File / Print

Prints the active document.

View / Panels /
Object Manager

Shows or hides the Object Manager.

View / Panels /
Output

Shows or hides the Output Window.

View / Panels / Tools

Shows or hides the Tools Window.

About / SQL-Builder

Launches the About dialog box displaying
various information about the version of
SQL-Builder you are running.

-

Changes to Contextual Help mode (the
mouse pointer will also change shape)
enabling you to click on any item in SQLBuilder to launch the relevant help
page.
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Edition Toolbar

Edition Toolbar
The Edition Toolbar consists of the buttons that are used when entering text or code into a
document, such as in all the Object Editors or the SQL-Session.

Button

Equivalent Toolbar
Command
(Menu / Option)

Description of the action performed

Edit / Cut

Removes the currently selected data from the
document and places it in the clipboard. This
command is not available if no data has been
selected. Cutting new data replaces the contents of
the clipboard. This function is not available in a ReadOnly editor.

Edit / Copy

Copies the selection into the clipboard.

Edit / Paste

Use this command to insert a copy of the clipboard
contents at the insertion point. This command is not
available if the clipboard is empty or if the active
editor is Read-Only. Newly copied data replaces the
data selected.

Edit / Undo

This command lets you undo the most recent editing
or graphical actions that you carried out.

Edit / Redo

This command lets you redo any actions you have
undone (with the Undo command)
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Edit / Find...

Use this command to display the standard windows
Find dialog box. You can use this dialog box to
locate text in the current document.

Edit / Find Next

Use this command to find the next occurrence of the
pattern or string entered in the Find dialog box.
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Object Toolbar
The Object Toolbar consists of the buttons that are used to display or create a new object, and
are available when the Object Manager is open.

Equivalent Toolbar Command
Button

(Menu / Option)

Description of the action performed

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Stored Procedures stored in the current
Database.

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Triggers stored in the current Database.

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Tables stored in the current Database.

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Defaults stored in the current Database.

-

Brings the Object Manager to the front of all
other windows and automatically displays the
UDTs stored in the current Database.

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Views stored in the current Database.
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Object Toolbar

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Rules stored in the current Database.

-

Brings the Object Manager to the front of all
other windows and automatically displays the
Functions stored in the current Database.
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Debug Toolbar
The Debug Toolbar consists of the buttons that are used to carry out the most common
Debugger functions, and are available when the Debugger is open and active.

Equivalent Toolbar Command
Button

(Menu / Option)

Description of the action performed

Stored Pr. / Debug

Opens the Connection dialog box, then the
Debugger

Debug / Run

Executes the code from the current statement
until a debugger event occurs.

Debug / Animate

Automatically Steps Into every instruction
one after the other (approximately once
every second) until the end of the program is
reached.

Debug / Stop

Stops debugging the current object.

Debug / Reset

Resets the debugger and sends the cursor
back to the beginning of the code.

Debug / Step

Single-steps through the instructions in the
program. If this command is used when you
reach an SQL object (Stored Procedure or
Trigger) call, the object is executed without
stepping through the object instructions.

Debug / Step Into

Single-steps through the instructions in the
program, and enters each Stored Procedure
or Trigger call that is encountered.

Debug / Step to Cursor

Executes the program as far as the line that
contains the insertion point. This is equivalent
to setting a temporary breakpoint at the
insertion point location.
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Debug Toolbar

Debug / Skip Block

Skips the current object's code instruction.

Debug / Insert/Remove Breakpoint
(Toggle)

Toggles a breakpoint at the current line, i.e.
inserts or removes it.
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Template Toolbar
The Template Toolbar consists of the buttons that are used to carry out functions that can be
used in the SQL-Session, Object Editors, Query Assistant etc...
Equivalent Toolbar Command
Button

(Menu / Option)

Description of the action performed

Template / Test Parameters
Command

Inserts at the beginning of the current
procedure body a test on each parameter
defined with a "null" default value.

Template / Execute Command

Launches the Exec. dialog box enabling you
to choose a command to execute

Template / Comment

Enters a Comment on the selected text

Template / Uncomment

Removes the Comment from the selected
text

Template / Query Assistant...

Launches the Query Assistant enabling you to
create query's and insert them into an SQLSession or any of the Object Editors

Template / Syntax

Launches the Help on Syntax dialog box
which provides rapid help on various SQL
commands

Stored Pr. or Trigger / Code Checker

Launches the Code Checker to check for
possible errors in the object code.

Template / Open Selected Object

Opens an object that who's name has been
highlighted in an editor. The Existing
Connections dialog box will be displayed
enabling you to select the correct server
connection.
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SQL-Session Toolbar
The SQL-Session Toolbar contains the buttons that are used to carry out functions in the SQLSession and are available when the SQL-Session is active.

Button

Equivalent Toolbar
Command
(Menu / Option)

Description of the action performed

TSql / Go

Sends the code in the SQL-Session to the
server.

TSql / Pause

Suspends (pauses) the command you have
just sent to the server.

TSql / Stop

Aborts the command that you have just sent to
the server.

Options /
NoExec/ShowPlan

Sets the "No Exec" or "Show Plan" option On or
Off.

TSql / Show History...

Launches the History dialog box and enables
you to browse the log to re-edit one of your
previous queries successfully sent to the server.

TSql / Next Query

Moves forward through the history log file.

TSql / Prev. Query

Moves backward through the history log file.

-

Enables you to select the number of rows to be
displayed in the Results Section of the SQLSession
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Object Manager Toolbar
The Object Manager Toolbar contains the buttons that are used to carry out functions in the
Object Manager and are available when the Object Manager is active and in two pane mode.
Equivalent Toolbar Command
Button

(Menu / Option)

Description of the action performed

Object / New Object

Opens a new object of the type selected in
the Object Manager

Object / Open Object

Opens the object selected in the Object
Manager

Object / Drop Object

Drops (removes physically from the server)
objects selected in the right hand section of
the Object Manager.

View / View / Large Icon

Displays items in the right-hand section of the
Object Manager using large icons.

View / View / Small Icon

Displays items in the right-hand section of the
Object Manager using small icons.

View / View / List

Displays items in the right-hand section of the
Object Manager using a list form.

Options / General Configuration / OM
Filter tab

Activates or de-activates any filters defined
on the Object Manager.

Stored Pr. or Trigger / Code Checker

Launches the Code Checker to check for
possible errors in the object code.

Table or SQL-View / Data-Session

Launches the Data-Session to help you
manage data in your Tables or Views
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Data-Session Toolbar
The Data-Session Toolbar contains the buttons that are used to carry out functions in the DataSession and are available when the Data-Session is active.
Equivalent Toolbar Command
Button

(Menu / Option)

Description of the action
performed

-

Enables you to select the number of
rows to be displayed in the in the
Data-Session (this combo box is
also available in the SQL-Session
toolbar.)

Data-Session / Activate Filter

This button is a toggle button which
either activates or deactivates a
Filter defined on a Data-Session.

Data-Session / Rollback

Use this button to return your DataSession to the state it was in at the
last Commit. This option is not
available if the Auto Commit option
in the Data-Session tab is selected
(default position).
Not available for SQL-Server or
Sybase users.

Data-Session / Commit

Use this button to commit your
changes to the server. Rollback
cannot be used once Commit has
been selected. This option is not
available if the Auto Commit option
in the Data-Session tab is selected
(default position).
Not available for SQL-Server or
Sybase users.
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Database Management Toolbar

Database Management Toolbar

Button

Equivalent Toolbar
Command
(Menu/Option)
[OBJECT SPECIFIC MENU] /
Save [OBJECT NAME]

Description of the action performed

Sends the current object to the server and saves the
information.
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Zoom Toolbar
The Zoom Toolbar consists of the buttons that are used when handling objects in the Graphical
Object Manager.

Button

Equivalent Toolbar
Command
(Menu / Option)

Description of the action performed

-

Will set the zoom factor to 100%.

Graph / Zoom / Global View

Will set the zoom factor so that all the objects in
the Graphical View are visible.

-

Enables you to select (manually or from the list box)
a zoom factor for the Graphical View.

Graph / Zoom / Zoom In

Increases the zoom factor and zooms in on the
Graphical View.

Graph / Zoom / Zoom Out

Decreases the zoom factor and zooms out from the
Graphical View

All these options are explained in more detail here.
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Command Line
The following parameters can be used to run SQL-Builder from the command line. Some
examples are available here.
HELP
-?, -H, -HELP
Displays the list of commands available.
CONNECT
-CONNECT(<server>,<username>[,<password>])
Provides automatic SQL connection - can be used instead of the CONNECT_PROFILE option.
CONNECT_PROFILE
-CONNECT_PROFILE(<profilename>])
Use this option to connect to SQL-Builder. Specify the name of the profile that you want to use to
connect. Can be used instead of the CONNECT option.
LOG
-LOG(<filename>,[<arguments>],[<maxlines>])
Initializes the Log file.
●

●

●

<filename> specify the name and location of the output log file (use the .castlog
extension)
<arguments> is used to set the following log file parameters:
USELOGFILE

activates the use log file mode

IMMEDIATE

activates the immediate save mode (i.e. entries will be written
to the log file every time a message is sent by the server or by
SQL-Builder.)

-TRUNCATE

activates the truncate file mode (i.e. the log file will be emptied
each time SQL-Builder is executed.)

<maxlines> sets the log file's maximum length

Examples:
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Command Line

SQLBUILD.EXE -LOG(c:\log.castlog, -USELOGFILE)
Notes
●

●

●

If you need to specify more than one argument, please separate the arguments with a
space: SQLBUILD.EXE -LOG(c:\log.castlog, -IMMEDIATE -TRUNCATE).
If you are only specifying one argument, you can also use the argument without a dash
and without an initial space: SQLBUILD.EXE -LOG(c:\log.castlog,IMMEDIATE).
If you want to rapidly deactivate an option, you can use the "!" character after the dash:
SQLBUILD.EXE -LOG(c:\log.castlog, -!IMMEDIATE -!TRUNCATE).

KEEP
-KEEP=<lines_qty>
This sets the number of lines to be kept, at most, in the Errors & Messages window.
CODECHECKER
-CODECHECKER(<c:\filein.TXT>,<c:\fileout.TXT>)
●

The filein.TXT file will contain a set of lines, each referring to an object or several objects
to be included in or excluded from the code check process.
Each line will take the following form:
DATABASE.TYPE.NAME (for objects to be included)
-DATABASE.TYPE.NAME (for objects to be excluded: precede the line with "-")
Where DATABASE equals the name of the database containing the object. Where TYPE
refers to the object type in the following form:
FNC

Function

SPR

Stored
Procedure

TRG

Trigger

*

All object
types

Where NAME refers to the name of the object (or * to include all objects).
Examples:
To examine the entire database CASTPUBS, excluding all TRIGGERS and the Stored
procedure "TEST", the filein.txt file would be as follows:
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CASTPUBS.*.*
-CASTPUBS.TRG.*
-CASTPUBS.SPR.TEST
●

Fileout.TXT is the file that is produced by the Code Checker at the end of the verification
process containing the results.
For more information about the Code Checker, please click here.

Notes
●

Filein.TXT CAN be a folder if required, in which case all files in this folder are handled as
filein.TXT files.

SHOW

●

●

●

-SHOW(SQL) This code displays the SQL sent to the data server in the Log List.
-SHOW(SQL_DATA) This code displays the SQL sent to the data server and the data
returned by the data server in the Log List.
-SHOW(SQL_TIME<,time>) SQL_TIME displays the time required for each query sent to
the server to be executed and "time" is an optional parameter that expresses in
milliseconds when the SQL_TIME option should be displayed.
For example, if the parameter -SHOW(SQL_TIME,100) were passed in the command line,
only those SQL queries that had taken longer than 100 milliseconds to execute would be
displayed.
Please note that you can still use -SHOW(SQL_TIME) on its own.

Notes
●

Please do NOT append this code to your command line unless you have contacted
CAST for further instructions.

EXIT
Quits the application automatically when the command line is terminated.
Notes
●

LOG and KEEP settings can also be modified using the Messages & Errors tab

Examples
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Command Line

"c:\program files\CAST\SQL Server\sqlbuild.exe"
-CONNECT(TEST,sa,PASSWORD)
-LOG(d:\cast\log.castlog, -USELOGFILE)
-CODECHECKER(c:\filein.TXT,c:\fileout.TXT)
-EXIT

Notes
●

Please make sure you use uppercase letters to input the command line parameters (as
in -LOG, -EXIT). The procedure will fail otherwise.
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.INI File Options

.INI File Options
●

Application Specific INI file Options

●

GloballySharedSettings.ini file Options
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Application Specific INI File Options

Application Specific INI File
Options
This page describes how to add various parameters to the SQLBUILD.INI file (located in your
\Documents and Settings\<user_name>[.<domain_name>]\Application
Data\CAST\CAST\<Version_Number> directory after installing CAST Products). These
parameters add supplementary features to SQL-Builder.
Auto Disconnect Option
Add the following parameters to prompt SQL-Builder to automatically close any open server
connections after a certain period of time. This option is used in conjunction with the SQLSession.

[Preference Setting]
AutoKillConnect=1
AutoKillConnect_Timeout=30
Where AutoKillConnect defines whether this option is activated (1=Active, 0=Deactivated) and
where AutoKillConnect_Timeout defines the number of minutes of inactivity before the server
connection is closed.
Hide Permissions tab in Object Editors
If you want to hide the Permissions tab in SQL-Builder's Object Editors, add the following
information to the SQLBUILD.INI file.

[Preference Setting]
DisplayRights=0
Removing this parameter from the .INI file will re-display the tab.
Allow custom drop statements
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SQL-Builder enables you to insert a modified custom Drop Statement when you save an object
as an ASCII file (normally a generic drop statement is automatically added). To force SQL Builder to include your modified drop statement instead of the generic statement, you need to
add the following to the SQLBUILD.INI file:

[OptionInAFile]
UseCustomDropOrder=1
CustomDropOrder_PROCEDURE=Drive name:\PATH\scriptdropprocedure.txt
CustomDropOrder_FUNCTION=Drive name:\PATH\scriptdropfunction.txt
CustomDropOrder_VIEW=Drive name:\PATH\scriptdropview.txt
CustomDropOrder_TRIGGER=Drive name:\PATH\scriptdroptrigger.txt
Alter the Drive name:\PATH\ to reflect the location of the .TXT files (the .TXT files are stored
alongside your other CAST files and are named as above), then save the .INI file. Insert 0 next
to UseCustomDropOrder if you want to deactivate the option.
For more information about this option, see Custom drop statement.
No Repository
You can specify an option to force SQL-Builder to ignore the Knowledge Base even if the current
database is defined in it:

[CAST Repository]
CAST Repository = No Repository
No CAST Knowledge Base will be used, even if the current database is actually defined in it.
This means that:
●

●

●

The CAST Knowledge Base will not be updated when you create or modify an object
when you modify an object, it will not be locked, therefore, multiple developers may
modify the same object at the same time
the rights defined in the CAST Knowledge Base cannot be used to access objects
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GloballySharedSettings.ini File

GloballySharedSettings.ini File
This page describes how to add various parameters to the GloballySharedSettings.ini file
(located in your \Documents and Settings\All Users\Application
Data\CAST\CAST\<Version_Number> directory after installing CAST Products). These
parameters add supplementary features to all CAST applications.
Microsoft SQL-Server/Sybase ASE
Set Quoted Identifier
Add the following parameters to force the Set Quoted Identifier option to ON during the
connection process:

[Global]
UseQuotedIdentifiers=1
Avoiding problems with the default database
In some circumstances, CAST Products will not allow certain databases (such as tempdb) to be
the default database. To avoid this problem add the following to the
GloballySharedSettings.ini file:

[Global]
DBNameForTransaction=Default Value
The use will then be carried out on the database containing the Knowledge Base. Removing the
line will invoke the default behaviour, i.e.: no use.
Sybase ASE Database Connection
The following options can be added to the GloballySharedSettings.ini file to alter the process
of connecting to a database:

[CT-Locale]
charset=
Enter the required character set here. The default setting is iso-1.

[CT-Locale]
lang=
Enter the required language here. The default setting is default.
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[CT-Locale]
sortorder=
Enter the required sort order here. The default setting is default.
Oracle Server
Generating Trace Message
Use this option to generate trace messages that can be helpful in some cases when facing issues
with Oracle Connectivity in our products.

[Global]
TraceConnectivity=1
Disabling the TNS_ADMIN Search Variable
Use this option to disable the TNS_ADMIN variable search during the connection process.

[Global]
UseTnsAdmin=0
Setting the Optimizer Mode to Rule for Oracle servers
Add the following script to the GloballySharedSettings.ini file to force your Oracle server to
generate a trace file that contains information on query execution, IO statistics etc. It is the
equivalent of sending the ALTER SESSION SET SQL_TRACE = TRUE query to the server:

[global]
ForceOracleTrace=1
Displaying the OracleHome Selector dialog box
If your Oracle server has more than one OracleHome and you have not defined an OracleHome,
you can force the CAST application you are accessing to display the OracleHome Selector dialog
box enabling you to establish a connection to the correct OracleHome.
Add the following to your GloballySharedSettings.ini file:

[Global]
OracleHome=<path>

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/INIFile/cw.htm (2 of 17) [10/07/2008 10:53:51]

GloballySharedSettings.ini File

- or -

[Global]
OracleHome=default
In normal circumstances, the OracleHome Selector dialog box will automatically be displayed if
you have more than one OracleHome on your Oracle server.
Notes
●

When using any of the CAST Products' modules via the Command Line (in batch
mode), the Oracle Home Selector dialog box will be displayed if you have more than one
Oracle Home on your client machine and you have not defined a default Oracle Home.
This can be problematic as the Command Line process will be stopped in order that an
Oracle Home is selected.
To stop the Oracle Home Selector dialog box from being displayed during a Command Line
process, it is necessary to specify the ORACLEHOME value in the Command Line as
follows:
Either by defining the Oracle folder's path:
-ORAHOME=<path>
or by using the default value:
-ORAHOME=default

General
CAST Diagnostics Report
If you do not want the CAST Diagnostic Report (Help > About) to be displayed in an HTML
format, please add this script to your GloballySharedSettings.ini file:

[Report]
Report in Dialog Format = 1
Detecting Network Logins
Add this option to display an additional dialog box during connection, which will prompt the user
to enter their network login (domain\login).

[User]
RegisterLogin=1
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Activating deactivating the Inference Engine
Certain analyzers provide an Inference Engine to compute run time type information in order to
simulate program behaviour during execution of the analyzer and thus identify additional links
that would not otherwise be "discovered" using standard analysis techniques. This technology
detects a reference to an object wherever its name is mentioned, regardless of the context in
which this reference occurs.
The following analyzers incorporate an Inference Engine:
●

VB

●

PB

●

J2EE (which includes the Java Analyzer (now deprecated))

●

Mainframe (Cobol)

●

T-SQL

Activation
To activate the Inference Engine for all analyzers, use the following option (to deactivate it, use
the "No" value, or remove the option entirely). By default this option is not present in the
GloballySharedSettings.ini file.

[Inference Engine]
Use Inference Engine=Yes
Trace Mode
To activate the trace mode, add the following parameter. By default this option is not present in
the GloballySharedSettings.ini file. Use the "No" value to deactivate, if the option is present.

[Inference Engine]
Use Inference Engine=Yes
ACTIVATE_TRACE_INFENG=Yes
Limit Strings
To limit the number of strings that will be found during the search of each object value, add the
following parameter. Note that limiting the number of strings can lead to incomplete results,
however, performance of the Inference Engine is improved. By default this option is not present
in the GloballySharedSettings.ini file.

[Inference Engine]
Use Inference Engine=Yes
LimitString=5000
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Note that when the Inference Engine is activated, but this option is not present in the
GloballySharedSettings.ini file, the following default values are used:
●

PB, J2EE, Mainframe (Cobol) and T-SQL = 10000

●

VB = 100000

Limit Sub Target
To limit the number of intermediate values that the Inference Engine must resolve in order to
obtain the value of the object that is being searched for, add the following parameter. Note that
limiting the number of intermediate values can lead to incomplete results, however, performance
of the Inference Engine is improved. By default this option is not present in the
GloballySharedSettings.ini file. The lowest value you can enter is 1.

[Inference Engine]
Use Inference Engine=Yes
LimitSubTarget=200000
Note that when the Inference Engine is activated, but this option is not present in the
GloballySharedSettings.ini file, the following default values are used:
●

PB, J2EE, Mainframe (Cobol) and T-SQL = 300000

●

VB = 500000

Search for values through procedure calls
To deactivate the search of values through procedure calls, add the following parameter and
"Yes" value. If the value is set to "Yes", then the search for values will be local to the procedure.
By default this option is not present in the GloballySharedSettings.ini file. Adding the "No" vlaue
or removing the option will force the Inference Engine to search for values through procedure
calls (the default setting):

[Inference Engine]
Use Inference Engine=Yes
versionV1=yes
Notes
●

●

Please note that the J2EE/Java Analyzer and the Mainframe Analyzer (Cobol) have their
own options to activate their own inference engines. These options override the global
option described above. See the analyzer specific options below for more information.
More information about the Inference Engine can be found in the online Help for Analysis
Manager: in the "Reference Guide" page for each analyzer, except the T-SQL Analyzer,
where a specific page called "Inference Engine and the T-SQL Analyzer" exists.

CAST Analysis Manager - Analyzers
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ASP Analyzer
You can set various ASP Analyzer options via the GloballySharedSettings.ini file. For example:
●

Skip Analysis Saving

●

Save Only File Structure

●

Display Symbol Positions

●

Display Saved Objects

●

Display Saved Links

●

Do Not Search For ActiveX

●

Display Valid Searched URL

●

Display Error Messages Only Once

●

Display Analysis Time For Each File

●

Display Analysis Time For Each Step

●

Save Dynamic Parent Relationships

●

Internet Connection Timeout = x (use this option to optimize the Internet Connection
Timeout for when ASP Analyzer tries to resolve external URL references in source code. By
default, this is set to 4 seconds).

Add the options you want to activate or deactivate to the GloballySharedSettings.ini file as
follows:

[WebAnalyzerOptions]
Skip Analysis Saving
Do Not Search For ActiveX = FALSE
Display Valid Searched URL = 0
Display Error Messages Only Once
By default, adding = FALSE or = 0 will deactivate the option.
C++ Analyzer
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●

[C++ Analyzer]
OutputUnexpectedSyntax=yes
- YES > When unexpected code syntax is found by the analyzer during an analysis a
warning message AND the unexpected syntax will be displayed in the Log Window.
- NO > When unexpected code syntax is found by the analyzer during an analysis a
warning message will be displayed.

●

[C++ Analyzer]
KeepLastParsedFileTrace=filename
- where <filename> is equivalent to the full path (directory and file name) of the file
containing the expanded (preprocessed) version of the last analyzed file. For example:
KeepLastParsedFileTrace=c:\Temp\CastPreprocessedFile.cpp
This is usually the last file of the analysis, the file currently being analyzed or the file
causing errors (where a fatal error occurs). This trace file can be particularly useful when
there is some doubt about the way a macro has been expanded. By default, this option is
not present in the GloballySharedSettings.ini file. As a result, you must specifically add
the option to activate it, and then remove it to deactivate it.

●

[C++ Analyzer]
LastIncludePathSelected=YES

Saves the last Include Path selected in the wizard so that it can be re-used again.
not necessary to modify this option.

●

It is

[C++ Analyzer]
ShowCommandLine=YES
- NO > (Default setting) Hides the command line in the Log window.
- YES > Displays the command line in the Log window.

●

C++ Analyzer]
SimulateSaving=YES
- NO > (Default setting) Normal analysis process is carried out.
- YES > The save process (when generated objects are saved to the Knowledge Base) is
skipped.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/INIFile/cw.htm (7 of 17) [10/07/2008 10:53:51]

GloballySharedSettings.ini File

Delphi Analyzer

●

[Delphi-Analyzer3]
Convert=<path_to_convert.exe>
Defines the location of your Delphi convert.exe file. This file can also be defined in the
Options page in the Delphi Analyzer. Change the number to reflect the Delphi version
you are using i.e.:
[Delphi-Analyzer3]
[Delphi-Analyzer4]
[Delphi-Analyzer5]
[Delphi-Analyzer6]
[Delphi-Analyzer7]

●

Add the following options to define the DEFINE parts of your Delphi code.

[Delphi Define]
Define1=TEST
Define2=TEST1
Define3=TEST2
By default Delphi Analyzer does NOT analyze the $fdef part of the Delphi code. However it
may be necessary to analyze this code, thus adding the names of the DEFINE in the
GloballySharedSettings.ini file enables analysis.
You can add as many DEFINE as necessary - just continue the number sequence: Define1,
Define2, Define3, Define4 etc.
In addition, the option must always begin with 1 and NOT 0. For example:

[Delphi Define]
Define0=CR_3UP => define not taken into account

[Delphi Define]
Define2=CR_3UP => define not taken into account

[Delphi Define]
Define0=CR_3UP => define not taken into account
Define1=CR_3UP => define taken into account
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EJB Assistant
Add the following option to the GloballySharedSettings.ini file if you want to retain proprietary
XML files generated during the transformation process carried by the EJB Assistant.

[EjbAssistant]
KeepGeneratedFiles=yes
The transformation process is a necessary part of an EJB Assistant analysis. It converts files that
contain beans persistence information from server specific format to EJB Assistant format in
order that they can be analyzed correctly.
Java Analyzer/J2EE Analyzer
Please note that the Java Analyzer is now deprecated - please use the J2EE Analyzer for all Java
based analyses. Although the options listed below are specifically for the Java Analyzer, they will
also function for the J2EE Analyzer.
To activate the Inference Engine for the Java/J2EE Analyzer please use the following option in
the GloballySharedSettings.ini file:

[JavaAnalyzer]
activate_ie=1
To deactivate it, use the "0" value.
To activate a specific log file to register all Inference Engine processes, please add the following
option:

[JavaAnalyzer]
LogFilePath=1

●

Please note that there is also a global option that activates/deactivates the Inference
Engine for all analyzers that have it as an option. See the Activating/deactivating the
Inference Engine section above.

File extraction from archive can be time consuming. By default, the Java/J2EE Analyzer will
extract in memory files that have been required from archives, in order to speed up the
extraction process. This mode can be changed with the option UnpackArchivesInMemory:

[JavaAnalyzer]
UnpackArchivesInMemory=yes
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●

Yes = extraction of archive files to memory

●

No = extraction of archive files to disk

If UnpackArchivesInMemory=no, the analyzer will keep an extracted copy of files that have
been required from archives. It then reuses them in consecutive jobs. Deleting these files has no
effect on the analyzer. The next analysis will simply recreate them. However, they must not be
modified in the meantime.
By default these extracted files are kept under the "Cast Generated Files" folder created under
the default temp directory as specified by an environment variable. This location can be changed
by setting the DeployDir option under the JavaAnalyzer section of the
GloballySharedSettings.ini file to the desired directory. The specified directory must exist prior to
analysis:

[JavaAnalyzer]
DeployDir=<path>
Please see the Class Path Selection page for the Java, J2EE and TIBCO wizards, which
provides more information about this.
The Java Analyzer can now perform the following "Enforce" checks during the analysis:
●

In a Try and Catch statement, catch clause should not be empty ("empty catch clause")

●

In a Try and Catch statement, Finally clause should not be empty ("empty finally clause")

●

●

In a Try and Catch statement, the Finally clause should not contain a Return statement
("return in finally clause")
Missing default in switch statement ("missing default in switch statement")

For example:

void f()
{
try
{}
catch (Exception e)
{
;
}
finally
{
//TODO
}

<-- empty catch

<-- empty finally

}
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int g()
{
int i;
switch (i)
<-- missing default
{
case 1: return 2;
}
try
{}
finally
{
return 1;
}
return 0;

<-- return in finally

}
To activate the checks, add the following entry to the GloballySharedSettings.ini:

[JavaAnalyzer]
ProcessAnomalies=1

JDO Assistant
Support for different implementation (equivalent to target application servers in the EJB
Assistant) is provided via entries in the GloballySharedSettings.ini file. The following
information can be added:

[JDOVendors]
Vendor<i>=<vendor_name>
[JDOKeys]
<vendor_name>-TblKey=<table_key_name>
<vendor_name>-ColKey=<column_key_name>
Where:
●

<i> corresponds to a unique number chosen at random

●

<vendor_name> corresponds to the vendor's name, e.g.: Triactive

●

<table_key_name> and <column_key_name> correspond respectively to key names
(attributes of the <extension></extension> tags) containing the table names mapped to
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the JDO (in the <class></class> tag) and the column mapped to a field in the underlying
Java class in the JDO (in the field></field> tag).
Example

[JDOVendors]
Vendor1=Triactive
Vendor2=JCredo
[JDOKeys]
Triactive-TblKey=table
Triactive-ColKey=column
JCredo-TblKey=tbl
JCredo-ColKey=col
In other words: for the vendor Triactive, the attribute in the <extension> tag that contains the
name of the table is table and the attribute containing the column name is column.
The .jdo file should look like this (dtd of the metadata file, jdo.dtd):

<class name="Employee" persistence-capable-superclass="Person">
<field name="employees">
<extension vendor-name="Triactive" key="column" value="fname"/>
</field>
<field name="childCount" persistence-modifier="transient"/>
…
<extension vendor-name="Triactive" key="table" value="EMP"/>
</class>

Mainframe Analyzer
The following options govern the procedure used by Analysis Manager to save objects in the
Knowledge Base when an analysis has successfully completed.
1.

[Mainframe Analyzer]
FreePhysicalMemoryLimit=50
This option defines the maximum free physical memory prior to the start of the link cache
flushing process (corresponding to the message Flushing links and information... displayed in
the Log Window) and the memory freeing process (when the contents of the analyzed symbol
files is destroyed).
If this value is never reached, the memory will NOT be freed. The value must be expressed in
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Megabytes. Default value = 50MB.
2.

[Mainframe Analyzer]
LimitOfFilesInMemory=500
This option defines the minimum number of files that are analyzed prior to the start of the link
cache flushing process and the memory freeing process. The default value is "500".
If the limit of the size of the physical memory is reached, then the memory will not be freed as
long as the limit of the number of files is not reached.
3.

[Mainframe Analyzer]
InferenceEngine=false
This value deactivates the Cobol Inference Engine. The default value is "true".
Please note that there is also a global option that activates/deactivates the Inference Engine for
all analyzers that have it as an option. See the Activating/deactivating the Inference
Engine section above.
4.

[Mainframe Analyzer]
ReadTerminalFormat=false
This option activates or deactivates the detection of Terminal Format. See Options page
(Analyzer & Reference Finder for Mainframe) for more information.
The default value is "true".
.NET Analyzer
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In version 2.0 of ASP.NET, an embedded web server is used to compile ASP.NET pages, without
the need to use an IIS web server. As a result, the .NET Analyzer now has its own built in web
sever that is automatically started during the analysis process when analyzing ASP.NET 2.0 code
that requires compilation. The web server is stopped when all ASP.NET pages that require
compilation have been fully compiled.
By default, the web server runs on local port 2222, however, if you have existing services that
conflict with this port number, you can override it by changing the port number via an option in
the GloballySharedSettings.INI file. For example:

[DotNetWebServer]
port_number=2223
If an existing service runs on local port 2222 an error message will be displayed in the Log
Window:
"AspNet compilation failure, could not start Cast web server on tcp port number 2222. If the port
is already used by another process please consult the on-line help to change this port number."
PB Analyzer

●

[PowerBuilder4Parse]
path_orca_dll=<path_to_pborca.dll_file>
Path_Pb_Ini=<path_to_pb.ini_file>
Defines the location of your PowerBuilder pborca.dll and pb.ini files. The pborca.dll file
can also be defined in the Options page in the PB Analyzer. Change the number to reflect
the PowerBuilder version you are using i.e.:
[PowerBuilder4Parse]
[PowerBuilder5Parse]
[PowerBuilder6Parse]
[PowerBuilder7Parse]
[PowerBuilder8Parse]
[PowerBuilder9Parse]

PL/SQL Analyzer
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Add the following option to activate the verification of Oracle resolution depth:

[PLSQL Parse]
ResDepth=1
To deactivate it, use the "0" value. If you deactivate it, the message "Warning: Resolution Depth
checks have been deactivated." will be displayed.
By default this option is set to 1.
T-SQL Analyzer
Please see the Enlighten > Column level Impact Analysis (CLIA) section below. The options
described for the CLIA are also valid for the T-SQL Analyzer - make sure, however, that you use
the same [CLIA SQL Server] heading.
Analyzer Wizards
In the following Analyzer Wizard pages:
●

Target Objects page

●

Called Objects by Analysis Results page (Ref. Finder)

●

Select Objects from Analysis Results page (Metrics Asst.)

The column heading "Path" located in the right hand section (when client objects are displayed)
is NOT shown by default. If you want to see this column, add the following to the
GloballySharedSettings.ini file (you will need to restart Analysis Manager):

[OMC]
LoadPath=1

Please note that if you do activate this option, performance when opening this wizard page
may be affected.
CAST Enlighten
Column Level Impact Analysis (CLIA)
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The following options can be added to the GloballySharedSettings.ini file to improve
performance:
1.

[CLIA SQL Server]
BypassAwXRefs=[on|yes|1|true|off|no|0|false]
Where on=yes=true=1 and off=no=false=0
This option tells the CLIA to ignore X-Refs (links) it otherwise retrieves from the Knowledge Base
for establishing the list of databases and objects to be analyzed for potential impacts. Setting
this option to "on" will always lead to relatively poor performance levels. The only case where it
should be set to "on" is when the Knowledge Base is known to be out-of-date in terms of T-SQL
Analyzer parsing results compared with the scripts of the T-SQL objects to be analyzed for
potential impacts.
If this option is set, i.e. the value for this option is "on", "yes", "1" or "true":
●

●

all databases existing both in the system catalog and in the Knowledge Base will be
analyzed instead of only the databases identified via Knowledge Base links
all objects contained in each of these databases will be analyzed by the CLIA process (i.e.
the same behaviour as in previous CAST versions).

The default value for this option is "off" (same as "no", "0", "false").
Notes
●

If this option is entered as "BypassAwXRefs=", it is considered as being absent and
consequently its value is considered to be "off".

2.

[CLIA SQL Server]
KeptDatabases=[database_name1[,database_name2[,...,database_nameN]]]
Where database_name1 = the required database name.
This option tells the CLIA to perform an "inclusive" filtering on databases whose names are listed
as values.
Regardless of the list of databases to be analyzed, they will be retrieved from the SQL Server's
system-catalog (when the BypassAwXRefs option is turned "on"), or else from the Knowledge
Base (when the BypassAwXRefs option is absent or turned "off"). The only databases that will be
examined will be those specified in the option (provided at least one database is specified).
This option neither affects the list of objects retrieved by possible PK/FK links nor filters
databases to which the T-SQL objects belong and which are then added to the impact result
graph.
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Notes
●

If this option is entered as "KeptDatabases=", it is considered as being absent.

3.

[CLIA SQL Server]
SkippedDatabases=[database_name1[,database_name2[,...,database_nameN]]]
This option tells the CLIA to perform an "exclusive" filtering on databases whose names are listed
as values.
Whatever the list of databases to be analyzed, they will be retrieved from the SQL Server's
system-catalog (when the BypassAwXRefs option is turned "on"), or else from the Knowledge
Base (when the BypassAwXRefs option is absent or turned "off"). After successful application of
the filtering specified using the KeptDatabases option (if one is provided), none of the objects
belonging to a database in this list will be examined for any potential impacts.
This option neither affects the list of objects retrieved by possible PK/FK links, nor filters
databases to which the T-SQL objects belong and which are then added to the impact result
graph.
Notes
●

If this option is entered as " SkippedDatabases =", it is considered as being absent.

Examples
Two examples of filtering using the KeptDatabases or/and SkippedDatabases options, assuming
that the SQL Server hosting objects to be analyzed for impacts contains the following databases:
b1, b2, b3, b4 and b5 and that each database contains objects in which there are impacts:
●

●

To receive impact results only for objects in b1 and b3: either set "KeptDatabases=b1,b3"
or else "SkippedDatabases=b2,b4,b5".
To receive impact results for objects in any database except b4: set
"SkippedDatabases=b4".

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/SQLBLD/INIFile/cw.htm (17 of 17) [10/07/2008 10:53:51]

Limitations

Limitations
This application has some limitations. Please consult this non-exhaustive before contacting CAST
for error related problems.
●

Limitations (General)

●

Limitations (Server)

●

Limitations (SQL-Builder)
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Limitations (General)
●

Application crashes
After a crash, if you cannot restart a CAST application, you need to quit all CAST modules
and then explicitly kill the processes of all CAST modules that are still alive. Choose the
"Processes" tab in Windows Task Manager, check for the EXE names of CAST modules and
choose "End Process".

●

Version Consistency
The client and server components must be from the same release:

●

❍

Upgrade all client machines with CAST modules at the same time.

❍

Upgrade all Servers with CAST server side components at the same time.

❍

Do not install modules from different versions in the same directory.

❍

Do not install server side components from different versions on the same server.

Non detected network logins
If you have problems with detection of your network login, e.g. on a Novell Network, you
need to add an entry to your GloballySharedSettings.ini file:

[User]
RegisterLogin=1
You should alter this file before running Server Side Install. This option prompts an
additional connection dialog box when you launch a CAST Product. In this dialog box, you
will be prompted to enter your network login (domain\login). It will be used to distinguish
users in the Knowledge Base. When running a CAST Product via the command line
interface and this option is active, the most recently used login will be used.
●

Knowledge Base Performance
For performance reasons, you should regularly perform the command:
update statistics
in the Knowledge Base database. This will recreate all statistics information for the
Knowledge Base, which is vital for good performance of all CAST applications.

●

System Views
CAST System Views do not show COM objects created by IIS Analyzer. Workaround: As
COM objects are shared among all analyses, you can find the COM objects used by a
specific application through the Calling/Called Objects views.
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●

Sybase Servers with UTF-8 (Unicode) Character Set
CAST does not support such servers. This is because CAST products are a single-byte
character set application and Sybase's BCP functions do not provide conversion between
single-byte and multi-byte character sets such as UTF-8 as stated in the following Sybase
message:
SQL Warning: BCP insert operation is disabled when LONGCHAR capability is turned on and
data size is changing between client and server character sets since BCP does not support
LONGCHAR yet. (severity 16, msg# 4847, line# 1).
Workaround: Configure the server with a single-byte character set such as iso_1 or cp850.

●

Sybase temporary databases
CAST Products for Sybase ASE cannot use a user-created temporary database such as
tempdb_1 as their temporary database. Only the system temporary database tempdb can
be used. Sybase has introduced the multiple temporary database feature in Adaptive
Server Enterprise version 12.5.0.3. To use CAST Products on this version, you must make
sure that all sessions opened by CAST products are bound to tempdb rather than any usercreated temporary database.

●

Compatibility Levels on Microsoft SQL-Server
The parameter compatibility level of Microsoft SQL-Server is not taken into account by
CAST. You will get various errors when you set the "compatibility level" of Microsoft SQLServer to another version than your Microsoft SQL-Server version. For instance, for
Microsoft SQL-Server 2000, the compatibility level must be set to 80. The compatibility
level is set separately for each database within a SQL-Server instance. The restriction
applies only to databases used with CAST products. See Microsoft SQL-Server 2000
documentation on system stored procedure 'sp_dbcmptlevel' for more information on
setting the database compatibility level.
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Limitations (SQL-Builder)
SQL-Builder has some limitations. Please consult this non-exhaustive before contacting CAST for
error related problems. The list is organized by SQL-Builder feature - so for example, all
limitations relating to the Debugger can be found in the Debugger section below.
Debugger

●

On Microsoft SQL-Server 2000, functions cannot be debugged.
On Microsoft SQL Server 2000, stored procedures that manipulate OLE Automation objects
through calls to sp_OAxxx system procedures (such as sp_OACreate, sp_OAGetProperty…)
cannot be debugged. (CAST reference O6942).
On Microsoft SQL Server 2000, the debugger will perform a step command instead of stepinto:
❍

❍

●

●

●

●

●

if multiple triggers of the same type are declared on a table.
if a procedure has an output parameter of type CURSOR.

Stored procedures that manipulate OLE Automation objects through calls to sp_OAxxx
system procedures (such as sp_OACreate, sp_OAGetProperty…) cannot be debugged.
When there are tables in a database belonging to different owners and procedures
accessing these tables without qualifying the owner of the table in the procedure script,
when debugging such procedures, the debugger might use a different table than the
database engine does when executing the procedure outside the debugger.
In some rare and non-deterministic cases, the debugger displays a modified text of the
debugged procedure. The text might appear in all upper-case or all lower-case.
It is not possible to use the Capture Parameter feature of the Debugger if the connected
user does not have the CREATE PROCEDURE permission in the procedures database. To
capture parameter values, SQL-Builder instruments the procedure and therefore needs to
drop and recreate it.
Some T-SQL statements are not supported either in the T-SQL Debugger:
Statement

Debugger

Example

Backup

NOT
SUPPORTED

backup database 'pubs' to
DISK='c:\temps\toto.dat'

Restore

NOT
SUPPORTED

restore database 'pubs' from
DISK='c:\temps\toto.dat'

Create
Statistics

NOT
SUPPORTED

create statistics my_statistics on
dbo.my_table(col1) With Norecompute
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Limitations (SQL-Builder)

Data-Session

●

1024 is the maximum number of permitted columns that can be displayed

●

4096 is the maximum number of characters that can be displayed in each cell

●

Only columns that can be displayed in text format are collected from the server. Internal
type columns are not displayed.

Graphical Object Manager

●

The Graphical Object Manager cannot handle objects that have multi owners. In some
cases, links and objects may not be displayed in the view following an Add Linked Objects
operation.

Object Editors

●

●

Permissions for Tables can be consulted in SQL-Builder, but CANNOT be modified. In
addition, column level permissions are not handled (and are thus NOT displayed in the
Permissions tab).
On Sybase servers, opening a table that has an index with a FILLFACTOR, the fillfactor on
the index is lost when the table is modified (CAST reference O7391).

SQL-Session

●

The SQL-Session cannot distinguish all numeric types and all character types. For example
a numeric will be displayed as a float on MS SQL-Server.

Code Checker

●

A where-clause of format <column><operator><column> (where operator is one of
=,>,<,>=,<=) is not detected as a SARG by Code Checker although it is a SARG (Search
ARGument). A SARG is a condition evaluated using at least one index and therefore a
means to improve database performance.

Miscellaneous
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Limitations (SQL-Builder)

●

●

When using Quoted Identifiers on any version of Sybase, SQL-Builder does not support
objects whose name contains the period ( . ) or the double quote ( " ). For example, the
procedure "foo.bar" or "foo""bar" cannot be edited or debugged in SQL-Builder. Other
special characters are not included in this limitation. E.g. the procedures "foo bar" or
"foo!bar" can be used in SQL-Builder on these servers.
Double-clicking an *.SQL file in Windows Explorer will launch SQL-Builder with an error
message. Sometimes the file cannot be loaded into an SQL-Session.

Table Editor

●

●

On Sybase servers, opening a table that has an index with a FILLFACTOR, the fillfactor on
the index is lost when the table is modified (CAST reference O7391).
On a Sybase 12.5 server, the Data Preservation Assistant in the Table Editor does not
restore the fill factor of a table index after a table change implying the drop and recreation
of the table.

Sybase ASE > 12.0 syntax
On Sybase ASE 12.0 and later, columns and parameters of type "extended type" are not taken
into account by CAST products. Analyzing or editing objects with such columns/parameters can
yield syntax errors.
Source Manager Interface
It is not possible to check-in or check-out Tables with CAST's Source Manager interface.
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Appendix

Appendix
●

Changes to CAST .INI files

●

User privileges in Microsoft SQL-Server 2005 environments
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Changes to CAST .INI files

Changes to CAST .INI files
In version 5.1.1, CAST changed the way in which it manages its .INI configuration files. These
changes are transparent and you do not need to manually make any changes, however,
this help page summarizes the changes that have been made:
In versions 5.1.0 and below, CAST used a general .INI configuration file (cw.ini) located in the
WINDOWS/WINNT folder. In version 5.1.1 and above, this file has now been replaced with a
new .INI file called GloballySharedSettings.ini. This file is now located in a user specific
Application Data folder.
To summarize:
v. 5.1.0 and below
File name

Location

cw.ini

WINDOWS
or WINNT
folder

v. 5.1.1 and above
File name

Location

\Documents and Settings\All
GloballySharedSettings.ini Users\Application
Data\CAST\CAST\<Version_Number>

In addition, there are other application specific .INI configuration files whose storage location has
also been changed. Among these are the following .INI configuration files which are referenced
elsewhere in the on-line Help:
●

anaman.ini

●

adgadmin.ini

●

enlighten.ini

●

enlightenS.ini

●

enlightenU.ini

●

rbo.ini

●

relbuild.ini

●

rcenter.ini

●

servman.ini

●

sqlbuild.ini

●

sqlbldo.ini

The location of these files has changed as follows:
v. 5.1.0 and below

v. 5.1.1 and above

Location

Location
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Changes to CAST .INI files

WINDOWS or WINNT folder

\Documents and
Settings\<User_Name>[.<Domain_Name>]\Application
Data\CAST\CAST\<Version_Number>

You can find out more about the options contained in these .INI configuration files here.
See Also
.INI File Options
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User privileges in Microsoft SQL-Server 2005 environments
In a properly configured CAST environment, the CAST administrator will create RDBMS logins for
use with CAST products (CAST Analysis Manager, CAST Enlighten, CAST Report Center etc.) that
do not have the same access privileges as the powerful "sa" or "sysadmin" logins. This is to avoid
a situation where a standard user could gain access to sensitive material or configuration settings
on the RDBMS.
In Microsoft SQL-Server 2005 environments, i.e. where the CAST Knowledge Base or CAST
Central Site are installed on a Microsoft SQL-Server 2005, the limited logins created specifically
for use with CAST products MUST be granted the VIEW SERVER STATE privilege.
This privilege grants access to the server’s current process list via master..sysprocesses or via
sys.dm_exec_requests. This information is required by CAST products for internal management
of database locking and the analyzer save process.
To avoid product usage errors, users will be prevented from accessing the database if their login
does not have access to the current process list.
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